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INTRODUCTION

This document is for Consultant and State Employees responsible for the production or review of
digital contract plans, specifications, supplemental contract documents, and contractor submittals.
This document covers the development, review and commenting, and submission of digitally
signed contract plans in PDF format including revisions, the delivery of specifications in
Microsoft Word format, the delivery of supplemental contract documentation in PDF format, and
the delievery of contractor submittals in PDF format. This manual also includes sections on the
usability of these PDF documents.

Questions or inquiries regarding the subject matter can be forwarded to the following contacts:

William Pratt P.E.

Transportation Principal Engineer
AEC Applications
william.pratt@ct.gov
860.594.3320

Bruce Bourgoin P.E.

Transportation Supervising Engineer
AEC Applications
bruce.bourgoin@ct.gov
860.594.2760

Mathew Calkins P.E.
Transportation Engineer
AEC Applications
mathew.calkins@ct.gov
860.594.2988

Revision History

Digital Project Development Manual Revision History — Includes Revision for Versions 3.06 thru
1.01
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DEFINITIONS

ACD — The attribute applied to a revision requested by the Processing unit to an ADP discipline
subset.

ACD2 — The attribute applied to a revision requested by the Processing unit to an ACD discipline
subset.

ADP — The attribute applied to an Addendum discipline subset.

Bluebeam — PDF software similar to Adobe Acrobat. Bluebeam software will be required to
package and markup all Shop Drawing Submittals.

DCD - The attribute applied to a revision requested by the Processing unit to an FDP discipline
subset.

DCD2 — The attribute applied to a revision requested by the Processing unit to a DCD discipline
subset.

Discipline Subset — A multi-page PDF document that includes all the contract plan sheets for a
discipline. Example would be all the structures sheets would be packaged in (1) multi-page PDF
document.

DCO - The attribute applied to a design initiated change order discipline subset.

DPD - Digital Project Development Manual.

Engineer of Record — The engineer’s digital signature that is applied to the discipline subsets.
For CTDOT staff this would be the Principal Engineer.

FDP —The attribute applied to a final design plans discipline subset.
FIO — The attribute applied to a “for information only” discipline subset.

FPL — The attribute applied to an advertised FDP discipline subset
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Project Manager — Lead designer on the project. For CTDOT staff this would be the TE 3 or
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.

Projectwise - CTDOT is currently using Bentley’s ProjectWise as a data management software
for digital projects. Projectwise allows the CTDOT, and authorized business partners to access its
data anywhere internet access is available. Projectwise shall be used by all consultant engineers
delivering digital contract documents.

STD - The attribute applied to the “CTDOT Standard Drawings” discipline subsets.

WDP — The attribute applied to working drawing for permanent structures submittals. This
includes the plans, calculations, or any supplemental documents in the submittal.

Section 1 Digital Document Requirements

1.1 Final Document Deliverable

The following contract documents shall be submitted into Projectwise when delivering a digital
project, see Section 3 of this document for submittal procedures for the above documents: For
CTDOT designed projects each discipline is responsible for uploading their documents into
Projectwise.

e Contract Plans
o Contract Specifications
o Supplemental Contract Documents - Include but not limited to the following:
o Proposal Estimate, with signed checklist
Federal Estimate
Calendar Day Estimate
Final Design Report
Categorical Exclusion
Design Approval Letter
Environmental Permits
DBE/SBE Approval with percentage
Commitment list
Agreements
Proprietary Item Approval
Standalone Transportation Management Plan Document, taken from the final
design report
e Engineering Reports
o Hydraulic Report
Hydraulic Report Data
Scour Report
Scour Report Data
Floodway Report
o Floodway Report Data
e GIS Project Location Documents
o Project Polygon Files (.dgn and KML)
e ROW Documents
o Property Map (.dgn)
o Property Map (pdf)
o ROW Parcel Files(.dgn and KML)
e Working Drawings for Permanent Structures
e Working Drawings for Temporary Structures
e Shop Drawings

OO0 OO OO OO O0OO0OOo

o O OO
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1.2 Requesting a Digital Project

The following fill able PDF form must be completed and returned to AEC applications by State
Design or CTDOT Consultant Liaison personnel to request a digital project: Project\Wise Project

Request Form

10.

11.

12.

13.

1.3 Prerequisites and Policies

All contract plans, working drawings, and engineering reports submitted to the
Department shall be digitally signed by a CT licensed Engineer or CT licensed Architect
in accordance with this manual. All contract plans, specifications, and supplemental
contracts documents will only be accepted by the CTDOT if they meet all the
requirements of this manual. Approval for additional development and testing of digital
documents and procedures shall come from the CTDOT Office of Quality Assurance.
Digital contract plans, in the following stages: Final Design Plans (FDP), Design
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be
digitally signed in conformance with this manual.
a. Digital signatures must meet the requirements of Adobe’s Certified Document
Services (CDS).
b. CDS, and CDS vendor information is provided at the following
website: http://www.adobe.com/security/partners_cds.html
c. Trial CDS Signatures will not be accepted by the Department, a signature must
be purchased from one of the CDS Vendors.
d. Digital contract plans shall be digitally signed using Bluebeam Revu.
After contract plans have been advertised, the digital signature is not allowed to be
removed.
Standard Computer Aided Design (CAD) Applications shall conform to those listed
here http://www.ct.gov/dot/digitaldesign.
Use of digital signatures not conforming to the requirements of this manual must be
approved by both the Office of Quality Assurance, and the Office of Legal Services.
This manual is designed to be used with the latest CTDOT Digital Design Environment.
Digital Contract Specifications shall be prepared in accordance with the Departments
policies and procedures for Contract Development.
Supplemental contracts documents shall be submitted digitally in PDF format. See
Section 3.2.8 for supplemental contract document list and submission procedures.
The Consulting Engineer acknowledges and agrees that Contract Plans submitted using
the [Digital Submission Procedure set forth in this Manual] has the same force and effect
for the purposes of the Consulting Engineer’s agreement with the State as a signature and
seal of a Connecticut Licensed Professional Engineer or Architect as set forth in § 20-
300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the Connecticut
General Statutes, as applicable. Nothing in this DPD serves as an authorization for, or
endorsement of, the use of this [Digital Submission Procedure] generally by the
Consulting Engineer, its subcontractor(s), or any Connecticut Licensed Professional
Engineer or Architect with respect to other work it performs for the State or work it
performs for other clients.
Bluebeam Revu was used in the production of all figures and procedures in this manual.
A license of Bluebeam Revu must be purchased to perform all the procedures in this
manual.
Bluebeam shall be the only PDF software supported by the Connecticut Department of
Transportation for the processes set forth in this manual. Import the Bluebeam profile as
shown in Appendix A. This will place all the tools and tool bars in the correct location.
When on call consultants are used for CTDOT projects, the title sheet shall be digitally
signed by CTDOT following the procedure in Section 2.6.1 of this manual.
All documents detailed in the processes in the following manual are uploaded to
CTDOT’s Projectwise site. To gain access to CTDOT’s projectwise site fill out the
following form: CTDOT Projectwise New User Form
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1.4 Format

Contract Plans

1.

©

Digital contract plans (preliminary, semifinal, FDP, etc.), working drawing plans and
shop drawing plans shall be in PDF format; PDF Plans must be sized either 36” x 24” for
projects created before 6/2007 or sized 34” x 22 for projects created after 6/ 2007; PDF
plans shall be measurable to scale in the PDF; PDF plans shall be able to be printed to
paper and scaled appropriately; text must be searchable; and all levels must have the
ability to be displayed on or off, unless approved otherwise. All information on the
digital contract PDF plans shall have been created from MicroStation or an approved
alternate. The only information that shall be added to the plans using a PDF editing
software are as follows:

Page labels (see Section 1.7)

Sheet numbers (see Section 1.6.2)

Watermarks and flatten comments(see Section 2.4)

Any digital signature fields (see Section 2.5)

Digital Signature (see Section 2.6)

Attach the PW Submittal Checklist (see Section 3.1)

Contract plans shall be grouped, by discipline into individual multiple page PDF files
called discipline subsets. Discipline subsets are not to be combined in a PDF
Package/Portfolio. Examples of discipline subsets are: 01_General, 02_Revisions,
03_Highway, 04 _Bridge, etc. See Section 1.11 & 1.12 for more examples of discipline
subsets.

Plans For Information Only (FIO) shall be submitted digitally, in individual subsets
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.
These subsets do not require a digital signature, but each sheet in the subset shall be
labeled; “For Information Only”. The subset numbers shall be selected by the lead
designer so that the FIO subsets are last. Each sheet shall be numbered correctly, see
Section 1.6.2.  Upload and attribute in accordance with Section 3.2.

Utility drawings shall be submitted in accordance with the following:

a. Utility plans For Information Only (FIO) shall be submitted in a utility subset
based on the utility company, AT&T subset, CL&P subset, etc. These subsets do
not require a digital signature, but each sheet shall be labeled; “For Information
Only”. FIO utility subsets shall be numbered so that they are the last subsets.
Example Labels; 10 CL&P_FIO, 11 AT&T _FIO

b. Utility company designed plans that include work being done by the States
Contractor shall be submitted in a utility subset based on the utility company,
AT&T subset, CL&P subset, etc. These subsets do not require a digital
signature. Example Labels; 10 CL&P, 11 AT&T

c. Utility plans that are designed by Utility or State Consultant firms that include
work being done by the States Contractor shall be submitted in a utility subset
based on the utility company, AT&T subset, CL&P subset, etc., and shall be
digitally signed in accordance with this manual. Example Labels; 10_CL&P,
11_AT&T

See Section 3.2 for uploading and attributing Utility Plans. See Section 1.11 & 1.12 for
more examples of discipline subsets.

CTDOT Standard sheets shall also be delivered digitally. See section 1.8 for how to
prepare and submit CTDOT Standard Sheets.

The first and second subsets in the project must always be the 01_General and
02_Revisions respectively. The Project Manager is responsible for determining the order
of all other discipline subsets, Sections 1.11 and 1.12 show examples.

Discipline subsets shall contain a maximum of 150 sheets.

Discipline subsets shall be published directly from a CAD application. Scanned images
or raster image formats will not be accepted with the exception of For Information Only
sheets, these can be scanned.

P o0 o
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10.

11.

12.

13.

14.
15.

16.

17.

18.

Footers, displaying the sheet number, shall be placed on each page of each PDF subset.
See Section 1.6.2. “Sheet Numbering”
Each subset shall contain bookmarks; one for each page. Figure 1 displays an example of
bookmarks. See Publishing_MicroStation_Content_to PDF_Format.pdf for more
instructions.
a. Figure 1 also displays examples of subgroup folders. While publishing,
subgroups may be created to contain similar sheets. See
Publishing_MicroStation_Content_to PDF_Format.pdf for more instructions.
Levels with the appropriate CTDOT names shall have the ability to be displayed on or off
within the PDF document.
The first page of the subset 01_General shall be the CTDOT digital project title sheet
which includes an index of the subsets contained within the project, sheet count totals for
all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for
applying the digital signature(s).

Link to digital title sheet: Digital Title Sheet
CTDOT engineers can find the digital title sheet in the seed files on our W: drive.
The 01-General subset shall include all detailed estimate sheets.
The 02_Revisions subset must be included in each digital project and there shall only be
(1) revisions subset.
Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See
Section 4.3. These revision sheets are used for tracking all sheet changes due to addenda
and design initiated change order (DCQO) with respect to the entire project. These sheets
are originally blank and unsigned, and shall be managed and updated as needed by the
Project Manager. The CTDOT Revision Contract Sheets can be obtained here:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE_Subset
The first page of each subset shall be a subset cover sheet, this includes FIO subsets.
This cover sheet shall contain both; an index of drawings contained within the subset that
includes both drawing numbers and drawing titles and the form field place holder(s)
which receives the digital signatures. The following cell has a table for the index of
drawings and the digital signature cell place holder BDR_Discipline_Cover Sheet cell.
This table must include the subset name and number displayed as a heading in the table.
See Figure 1 for an example.
As-built information shall be digitally applied to the contract subsets by District
Personnel after the job is complete using Bluebeam. See section 4.5.

Contract Specifications

19.

Digital Contract Specifications shall be submitted in MS Word format and in accordance
with the Departments policies and procedures for Contract Development. CSI special
provisions shall be submitted in pdf format.
a. For projects where a consultant is the Project Manager on the project, the
Specification and CSI special provisions submittals shall be submitted in (1)
zipped folder, see section 3.2.6.
b. For projects where a CTDOT design unit is the Project Manager on the project,
the Specification and CSI special provisions shall be submitted in individual
zipped folders per discipline, see section 3.2.6.
C. Design Initiated Change Orders shall be place in (1) pdf document, with “C#”
and the date in the header. An example would be “Rev. C1 - mm/dd/yy”.

Supplemental Documents

20.

Supplemental documents shall be 8.5” x 117 pdf documents, except the proposal estimate
which shall be in “.est” format. Documents that require signatures may be scanned with
a minimum resolution of 200 dpi, and size = 8.5”x11”. These documents do not need to
be digitally signed.
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Contractor Submittals — Under Development
21. In the 240_Contract_Development Folder of every project in Projectwise there is a file
with the label “CNS Item List”. The designer is required to fill out columns A through F
for each item that requires a shop or working drawing submittal. The first two rows in
the spreadsheet are filled out as an example and should be deleted when the designer fills
out this spreadsheet. This file is required to be filled out completely by the FDP date.
Once it is filled out notify Mathew.calkins@ct.gov and Henok.Abdissa@ct.gov.
22. See Section 6 for format requirements of Contractor Submittals: Working Drawings and
Shop Drawings.
23. Include this document, that modifies section 1.05 of the 816 Specifications, to use this
Contractor Submittal Procedure: Revised Section 1.05
Engineering Reports
24. The Hydraulic, Scour, and Floodway reports shall be formatted in accordance with the
following:
a. Shall be native PDF whenever possible.
b. Scanned sheets in the reports must have a maximum resolution of 200 dpi and a
minimum of 125 dpi.
c. All sheets except plans sheets shall be sized 8.5” x 11”. Plan sheets can be sized
up to 34” x 227,
d. Shall be digitally signed in accordance with Section 2 of this manual.
e. Any data files that must accompany the PDF report shall be uploaded into
Projectwise in a zipped folder.
f.  The reports and zipped folder for any data files shall be submitted into the
130_Engineering Reports folder in accordance with Section 3 of this manual.
GIS Project Location Documents
25. Project location for all projects shall be submitted to CTDOT. See Section 8 for the
format and submission requirements.
ROW (Rights of Way) Documents
26. Property Maps and Parcel Polygon files for acquired property shall be submitted to
CTDOT. See Section 9 for the format and submission requirements.

Using a discipline subset format streamlines both the development of contract plans and the
administration of the plans during preliminary design, FDP, DCD, Addenda, DCO and As-Built
submissions. Moreover, it also leverages the ability to digitally sign the individual discipline
based contract plan subsets per designer.

(((((

Index of Drawings

- ~

05 - TRAFFIC
INDEX OF DRAWINGS

Digital Signature form
field place holder
jwith digital signature

Watermark of

Engineer of Record

Figure 1 Discipline Subset Bookmarks, Index of Drawings, & Signature fields
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See Section 2.5 for digital signature form field place holder cells.
1.5 File Naming

1.5.1 Contract Plans (discipline subsets)

The file name shall match the discipline subset name. For example, the 02-Revisions subset shall
have the file name 02-Revisions.pdf. However, this name will change during the uploading and
attributing of the file into Projectwise. See section 3.2 Project DataTransmission.

1.5.2 Specifications

FDP and Addendum

These specifications shall be individual word documents placed in a zipped folder. CTDOT
processing shall combine all specifications into (1) PDF document and upload this into
Projectwise. See section 3.2.5.

Design Initiated Change Orders

These specification(s) shall be packaged in (1) pdf document and uploaded into projectwise. See
section 3.2.5.

1.6 Contract Plan Drawing and Sheet Numbering

1.6.1 Drawing Number

The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall
consist of the discipline designator followed by a hyphen and the sheet number. The discipline
designator shall remain constant across each discipline subset. For example; a highway subsets
discipline designator shall be “HWY?”, therefore any sheets in the highway discipline subset
would contain the following drawing numbers; HWY-01, HWY-02, etc.

Discipline subsets can be as broad or specific as the Project Manager would like. An example
would be the highway sheets can be split out into multiple subsets. They can place all the profiles
in one discipline subset where the drawing number would be PRO - ## and they can place all
cross sections in another discipline subset, where the drawing numbers would be XSC - ##.

The CTDOT efficiently maintains the drawing numbers in MicroStation using the model
properties and project explorer, See the following workflow Project Explorer to Manage Drawing
Numbers

The first sheet in a discipline subset shall have “01” in the drawing number as shown below:

TOWN: PROJECT NO.

STONINGTON/GROTON | 137-153

DRAWING NO. “'>

DRAWING TITLE: < HWY-01
[SHEET NO. |

PLAN SHEET

Figure 2 Contract Drawing Numbering
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1.6.2 Final Plan Page Labels and Sheet Numbers

Page labels and sheet numbers are applied to the discipline subset after the contract plans are
published to PDF.

Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the
number pages and header and footer tools within Bluebeam. Page labels and sheet numbers shall
be applied to all submissions of contract plans.

The first sheet in every subset shall start out at 01. For example the first sheet in the 05-Traffic
subset shall be 05.01.

Created in Microstation

a~

TOWN: PROJECT NO.
CITY OF NEW HAVEN\IAJ_ 92-640
T [P™™e e Created in Bluebeam qﬂ TRA-01

SHEET MO,

05.01

DRAWING INDEX (

Figure 3 - Drawing and Sheet Numbering

The page label and sheet number place holder shall be determined by the total estimated sheet
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100
sheets three place holders are necessary. For subsets less than 10 sheets, two placeholders shall
be used i.e. 01.01 thru 01.04 for a four sheet subset.

The page labels and sheet numbers must be placed correctly because it is used to correctly
assemble the contract plans into a properly ordered consolidated set that District Construction
takes advantage of during construction of the project.

Single Volume Projects:

The page labels and sheet numbers, for single volume projects shall be a concatenation of the
discipline subset number, a decimal point, and the sheet number. For example; the page labels
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03,
etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.

The Project Manager should determine the total number of subsets and give each discipline their
corresponding subset number, see section 1.11.

Multi Volume Projects:

For a multi volume project the page labels and sheet numbers shall be a concatenation of the
volume number, a decimal point, the discipline subset number, a decimal point, and finally the
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.01.

Volume numbers shall be used on large projects. They are effective because the Project Manager
only has to deliver to the other engineers their perspective volume numbers, allowing them to
manage their subset numbers independently of the other discipline volumes and subset counts, see
section 1.12.

Subset numbers shall start at 01 for all volumes.
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BLUEBEAM - Applying Page Labels and Sheet Numbers

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to the discipline subset. Go to the thumbnail pane as
shown below, right click on a thumbnail and select Number Pages:

@ @uu Fle Edt  View Document  Fomm  Makup  Measure  Window

(2) Right Click
on a thumbnail

(N EEERETEN]

Cirl4Shift-+H4

[ENRENRRNAAREANEN DY |

— (3) Select Number
Pages

Ctrl+Shift+M

Figure 4 - Adding Page Labels

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at once.
In the case where there are 10 or more sheets in the subset the following will have to be done
twice in order to get the correct number of place holders.

2. Select the correct style, insert correct prefix for the sheets being numbered, and apply to
the correct pages. For example, if the 04 subset has 99 sheets the prefix shall be “04.0”
for sheets 1-9 and “04.” For sheet 10 through 99.

1 — (1) Select this style
(2) Insert correct prefix

(3) Start at 1 for sheets 1-9
Page Rlange and 10 for sheets 10-99

Gages [All Pages (1-6) V|D{G) "
~ (4) A
el (4) Apply to correct pages
(5) Click OK

Figure 5- Page Labeling
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3. Now the pages will be labeled:

Edit View Document Form Markup Measure Win

Q T
o

Security  Signatures

| : -

CT_CON_FPL_0120_0086_04-

Pages are
e now labeled

Figure 6 - Labeled Pages

4. Next we will apply the sheet numbers. From Bluebeam select the Document tab and then
“Header & Footer”

@ ou Fe gt View Document Fom  Makup  Measure  Window  Help

O v B e -

B ‘ Headers & Footers...

o ¥

: B itk Crsn (3) Select header
¢ (1) Select CT_CON_FPL_0120_0086_04- [l tnse Chrl4shift+1 & footers
Document

TRAFFIC - LEGENDS &
Ctrl45hift+X LIST OF DRAWINGS

¥
Ctrl ift 40D

Cirl+5hift4R.

Ctrl+5hift+C

LIST OF DRAWINGS
e

Figure 7 - Header Footer Tool
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5.

(3)
Sa

Place the sheet numbers, as shown below: Note the margins may have to be adjusted as
necessary. After you select the font, set the margins, and type in <<PageLabel>> as
shown below. Then click save for save settings. The next time you are going to apply
sheet numbers to a subset, you can simply select the saved settings. Then click OK.
Header and Footer
Save Settings |[FE==8 NUME:EHS‘ I Save... ' [ Fit content inside margins
Fort
|\-’eraana v||18 j Top: Bottom:
Click A\ Lef: Right:
Ve Header and Footer \ \
Header Left Cents Right
| H ~— T (1) Select these
o | | options
‘ ‘ ‘ ﬂ::Page Label:> ‘\
~ 2) Type
Insert: [ Page Number ] [ Date ][ Bates Number ] [ File Data ] (<<)PaygpeLabe|>>
Preview
"o oF brawmGs.
':':[:l
EE== I~ -
P ='-:_‘E._;“ . .._—,;.:9 [pp— "‘3."'.‘5.‘.'.'“:&."._'... a2 .
S = : (4) Click OK
CT_CON_FPL_0120_0086_04T P Pl Pages Range (16) —
()

Figure 8 - Insert Sheet Numbers
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1.6.3 Addendum and Design Initiated Change
Order Page Labeling and Sheet Numbers

Page labels and sheet numbers for an Addendum need to have “.A#” at the end and Change
Orders need to have “.C#” at the end (see section 4 for addendum and change order sheet
numbering requirements).

To apply page labels and sheet numbers in Bluebeam follow the figures below:
1. First page labels must be applied to each sheet in the addendum or change order. This
can only be done one sheet at a time.
2. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number
Pages:

(2) Right Click
on a thumbnail

(I EEEEEEN]

apshot  Ctrl+Alt+C

[NNRENRRNANNEARENDY |

(3) Select Number
Pages

Ctrl+Shift+M

Figure 9 - Adding Page Labels
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3. Select None for a style, type in the sheet number of the addendum or change order sheet
in the prefix line. Then select which sheet you are labeling. This has to be done for each
sheet in the addendum or change order separately. See below:

Page Numbering and Labeling

Nubng 1 (1) Choose None

Style: MNone w t”’l‘ 2 T =

«___,_.( ) Type in the sheet
— — number of this sheet
Page Range " (3) Select the

CPages [seectea ) v[49 | correct sheet
L V) (1) Select OK

Figure 10 - Applying Addendum Page Labels

4. After all page labels have been applied, the sheet numbers can be applied. From
Bluebeam select the Document tab and then “Header & Footer”

Document Form Markup Measure Window Help

(2) Select Pages

5 L TS . — (3) Select header

Ctrl+5hift+

8 (1) Select Crlssttst & footers
Document

TRAFFIC - LEGENDS &
Cirl +5hift+% LIST OF DRAWINGS

LIST OF DRAWINGS

Figure 11 - Header Footer Tool
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5. Select your sheet numbers saved settings from before and click OK. Note the margins
and size may have to be adjusted as necessary.

Header and Footer |Z||E|E|

Save Setting{ | SIS ~ ||)Sawey. | | Delste L] Fit cortent inside margins

Fort Marginz (Inches)

Verdana v||1E v|@ BT U

(1) Select
Header and Foater yo u r Save
Header Left Center Right -

settings
Footer Left

«<Pagelabel:>

Insert: | Page Mumber l ’ Diate ] [ Bates Number ] ’ File Data

Preview
.

______

TRAFFIC - LEGENDS &
LIST OF DRAWINGS

" (2) Click OK

CT_COMN_FPL_0120_0086_04-T

Add Files | [ Delete Al |

Figure 12 - Applying Addendum or DCO Sheet Numbers
1.7 CTDOT For Information Only Sheets

Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc. These
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For
Information Only”. The first sheet of each FIO subset shall be a subset cover sheet. These sheets
shall be placed on a border and numbered in accordance with section 1.6.2.

The subset numbers shall be selected by the Project Manager so that the FIO subsets are last. See
Section 3.2 for uploading and attributing FIO Plans. See Section 1.11 & 1.12 for more examples
of discipline subsets. Information only sheets may be scanned, but must conform to the following
specifications; Minimum Size 22”°x34”, Minimum dpi = 300.

This link shows a procedure that can be used to create a For Information Only subset using
Bluebeam: Preparing a For Information Only Subset
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1.8 CTDOT Standard Sheets

Standard sheets shall also be delivered digitally into Projectwise. The following shows how to

obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital

project.
1.

Drawings Website

ctdot_highway_std.pdf

PDF Package

Fi

Hiw-07INDEX pdf

Upload the standard subset into Projectwise in accordance with section 3.2.

Next open up the standards from Projectwise by double clicking on it. Once it opens

click on the index sheet.
N &

Double click on
the index sheet

Download the latest standards from the following link for the project: CTDOT Standard

TB201311:18 A

Hw-0ZINDEX pdf

Hw-0506_01.pdf

TB201311:19 Ak

TE1 KB

Figure 13 - Preparing the Standard Subsets

Enter Project Number

17872013 11:19 Ak

Then enter the project number and check the standards to be included in the project.

B e T and check drawings
ST - e to be included in Project &
| w6 o1 | enowals, sioe paven mieTs AnD oUTLETS 12612 o Gasan |
V] ooz | Tve 05 5 e enowails e R e
| vwshe 03| EnowaLs For PIPE ARCH 5-18-09 MISCELLANEOUS DETAILS FOR BARRIER TRANSITIONS 7-12-12
| ok o1 | et oo & oror ITETET TEMPORARY PRECKST CONCRETE BARRIER CUR —
| vk 02| Tvee & D 11-10-11 | || fw-005 01 | FENCES aND BaRwavs
B2 w03 | Te BOUGLE GRATE THE - IT ot TW310.01 | - SEAM WETAL BEAM RAIL TARGUARE
| ek » ROUND PRECAST CONGRETE cB 111011 Vi-310 02 | WETAL BEAM RAIL (TYPE A-B 350} GUIDERAIL
[ b CAST CONCRETE CB DOUBLE GRATE TYPE - I 11-10-11 [ || J#-910-03 | METAL BEAM RAIL {TYPE MD-B 350}
| wrsk o6 | TvRE "' "L PRECAST CONGRETE CB COUBLE GRATE TvE - 11 Ty Wi-510 0+ | METAL BEAM RAIL (TYPE .8 350) SYSTENS 5, 54, 8 6
| ww-shr 07 | TvPe “C' & Gl CATCH BASIN TOPS AND CURBS 11-10-11 Wi-910-05 | METAL BEAM RALL R-B 350 SPAN TYPE I, I, Il SECTIONS
| vwisfr 08 | catcr Basin rmamEs aND GRaTeS S1800 Vi-510 06 | Fo8 350 SRIDGE ATTACHMENT SAFETY SHAPE PARAFET
vow-l7.09 | HEAYY DUTY LOCK DOWN TOPS Pazaz V57007 | R8 150 BRIDGE ATTACHMENT VERTICAL SHAPE PARAPET
| -k 10 [ manole - srame n cover 60911 W-910 06 | R-B 350 BRIDGE ATTACHMENT TRAILING END
| 1w-ch1.01 | FIGURES FOR DATES ON BRIDGE PARAPETS 8:09-11 Wi-910_0%a] MISCELLAMEOUS GUIDERAIL TRANSITIONS SHEET 1
| nw-efi 01 | cou pE mSTALATIONS IN FILL B ADCK SLOPES & CULVERT TRENGH DETAL| 71212 vi-910_09t] MISCELLANEOUS GUIDERAIL TRANSITIONS SWEET 2
| tw-cf1.0z | sloTED DRAIN PIE 12'- 15°-1824"30° (305-361-457-610-762) 7-12-12 fiw-o10 10| METAL BEAM RAIL 8" (203) X 6" (152) BOX BEAM
vw-f2 o1 |_cuLvert enos 71212 b0 11| curven cuiera TResTHeRT DETAL
| kw71 o1 | UNDERDRAINS AND UNDERDRAIN CUTLETS 7-12-12 W-910_ 120 MERRITT PARKWAY GUIDERAIL ATTACHMENT - SYSTEM 2 & 3
| twafson | paveD DITCH AND PAVED APRON 7-12-12 W-810.120) MERRITT PARKWAY GUIDERAIL
| vw-ali o] cursime 7-12-12 w-o10 12c| MERRITT PARKWAY GUIDERAIL TRAILING END ATTACHMENTS
| bl o1 | GRAWITE STONE TRAWSITION CURBING 10-18-10 w910 12d]  MERRITT PARKWAY MEGIAN GUIDERAIL AND END ANCHOR
HW-E1 012 TRANSITION 45" (1145) F-SHAPE TO 45" (1145] VERTICAL SHAPE SHEET 1 2512 || [ 510 13 THRIE-BEAM METAL BEAM RAIL RARDWARE
| e aio]  TRANSITION #5° (115) F-SHAPE 10 45" (1145) VERTICAL SHAPE SHEET 2 10-16-10 W-910 136 THRIE-BEAM TRANSITIONS
Hw-8§1 01| TRANSITION 45" (1145) F-SHAPE TO 457 [1145) VERTICAL SHAPE SHEET 3 1-26-12 w310 14; THRIE-BEAM 350 BRIDGE ATTACHMENT
/| vwafs 02| 45 (1145) F-SHAPE PRECAST CONCRETE BARRIER CUR SHEET 1 T Vi-510 1] THRIE-BEAM 350 GUICERAIL TRANSITION TO R-B 350 GUIGERAI
V] 45" (1145] F-SHAPE PAECAST COMCRETE BARRIER CURB SHEET 2 1212 FW-910_15] MD-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TVPE I
g TRANSITION - 32" (13) JERSEY SHAPE TO 45~ (1145) VERTICAL SHAPE SHEET 1| 12612 570 16 MO-B 350 MEDIAN BARRIER SAFETY SHAPE ATTACHMENT TVPE If
FW-Ej1 035 TRANSITION - 32° (813) JERSEY SHAFE T 45" (1145) VERTICAL SHAPE SAEET 2| 10-18-10 FW-910_17] _ReB TERMINAL SECTION
HW-Ef1 O3c| TRANSITION 32 (313) JERSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEST 3| 101810 W-510_16 | METAL BEAM RALL (TYPE MO-1}
| Hw-f 03] TRANSTTION - 33° (B13) JFRSEY SHAPE TO 45" (1145) VERTICAL SHAPE SHEET 4| 10-18:10 W-510 19a] METAL BEAM RAIL (MODIFIED TYPE A-I) AND END ANCHORAGE TYPE I
HW-8f1_030] MERRITT PARKWAY NARROW MEDIAN BARRIER 5-09-11 W-910196] METAL BEAM RAIL (MODIFIED TYPE A1) AND END ANCHORAGE TWPE II 751
| Hw-eli 04b] MERRITT pamiway - ' (610) WIDE MEDIAN BARRIER AWD ROADSIDE BARRIER 6-09-11 HW-911 D1 R-B END ANCHORAGE TYPE 1AND I £-09-11
\ HW-5)1 053] TRANSITION - 45' (1145) F-SHAPE TO 54" (1372) VERTICAL SHAPE SHEET 1 1262 FW-511 02| WO-B END ANCHORAGE TYPE 1 101510
E @ CTDOT HIGHWAY
b e St— | orrace or enGinEERNG

Issued 9-2014

Figure 14 - Enter Project Number and Check Boxes

19

Version 3.07


http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884

Connecticut Department of Transportation Digital Project Development Manual

5. Delete the standards that are not included in the project as shown below:

ctdot_highway_std.pdf* & Hw-

1. Click on the 1
PDF Packzge standards file

412 KB 1182013 11:18 A
207 KB 1182013 11:18 A
761 KB 1182013 11:18 A

445 KB 1782013 11:19 AM

Ef_‘;__, Hiw-0508_03.pdf 2. Right Click 11820131119 &M
- and select delete

£ey y .

msﬂ HW-0507_01 par on drawings not 12013 1119 Al

included in project

HWw-0507_02 pdf 17802013 11:19 AM
: e HWw-0507_03 pdf 434 KB 17802013 11:19 AM

. ~ HWw-0507_04 pdf 596 KB 17802013 11:19 AM

Hyw-0507_05 pdf B8 KE 1182013 11:18 AM

Figure 15 - Deleting Drawings from Standard Set
6. Next digitally sign all index sheets in accordance with section 2.6

1.9 Contract Plan Sheet Publishing

CTDOT currently uses MicroStation V8i Print Organizer to publish contract plans to a PDF
format.

The workflow Publishing MicroStation Content to PDF Format.pdf shows the fundamentals
of publishing contract plans to PDF from MicroStation.
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1.10 Example: Typ. Single Volume Digital Contract

Single volume digital contracts are used when each discipline or consulting firm designing the
project is responsible for 3 subsets or less. The following is an example of a single volume
project. Note: The first and second subsets shall always be 01-General and 02-Revisions. The
03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc. The FIO subsets shall be placed at the end of a project right before the STD
subsets.

Label File contents
(Discipline Subset) (but not limited to)
Title Sheet
01-General Detail Estimate Sheet

Etc
Index of Revisions Sheets

02-Revisions
Index of Plans Boring Logs
Survey Data Highway Plans
Alignments Breakout Drainage

. ROW High Profil

03-Highways** © . ghway Frote
Typ Sections Highway X-
Misc Details Sections
Intersect Grading Landscape Plan

Wetland Mitigation

Index of Drawings

All Structure Sheets

04-Structure Note: Multiple subsets may required for multiple
Sites

Ex: 04_Structure_Br.No0.1266

Index of Drawings

Signing

Pavement Markings

MPT

Traffic Signal Plans

Etc.

Index of Drawings

All Environmental Compliance Sheets required

05-Traffic

06-Environmental

IR Utility Design plans. For example 07_AT & T,
07-"Utiltiy 07 CL & P, 07 MDC, etc.
08-CL&P FIO*** CL & P For Information Only plans
09-AT&T FIO*** AT & T For Information Only plans

* CTDOT Highway Design Standard Index and
Sheets required

CTDOT Traffic STD *CTDOT Trgﬁic Engineering Standard Index and
Sheets required

CTDOT Highway STD

Figure 16 Typical Highway Project Discipline Subset Contents

* For using CTDOT Standard Sheets see 1.5 CTDOT Standard Sheet Assembly

** |f a discipline has to be broken up into more than one subset See Section 1.11 for splitting up
the discipline subsets.

*** For Information only discipline subset shall be submitted as individual pdf files based on the
entity providing the information only.
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1.11 Example: Multiple Volume Digital Contract

Multiple volumes are used if the project has 1 or more of the following characteristics:
1. The majority of the discipline/firm designers are responsible for more than 3 subsets
each. This allows the individual designers to number their subsets independently of the

other disciplines.
2. There are multiple sites on the project. Splitting these sites up into volumes
better organization of the project.

will provide

The larger the project is, typically the more subsets will be required and their labels will be more
specific.  The Project Manager will need to organize the discipline volumes. The subsets shall
be split up by volume and each volume shall be controlled by its assigned designer. For example,
all the subsets designed by the highway designer shall be in the same volume (02) and each
subset shall have a unique subset number. For example, see subset 02.02_Alignments and

02.03_Plans as shown below.

Label File contents Designer/

(Discipline Subset) (but not limited to) Firm
01.01-General Title Sheet, Detail Estimate Sheet Etc Lead
01.02-Revisions Index of Revision Sheets Lead
01.03-Wiind Re-establish Wetland Reestablishment plans Designer 1
01.04-Stg Acc. Staging and Access Plans Designer 1
02.01-Typ Sections Typical Sections Designer 2
02.02-Alignments Alignment Geometry Designer 2
02.03-Plan Plans Designer 2
02.04-Profiles Profiles Designer 2
02.05-ROW Brk Right of Way Breakout Designer 2
02.06-Drain Drainage Plans Designer 2
03.01-Retaining Wall 1 Retaining wall details Designer 3
03.02-Retaining Wall 2 Retaining wall details Designer 3
03.03-Bridge 00456 Bridge_456 Designer 3
03.04-Bridge 01983 Bridge_1983 Designer 3
03.05-Bridge 01984 Bridge_1984 Designer 3
04.01-Stage 1 Stage Construction Details 1 Designer 4
04.02-Stage 2 Stage Construction Details 2 Designer 4
04.03-Stage 3 Stage Construction Details 3 Designer 4
05.01-SPM Signing and Pavement Marking Site 1 Designer 5
05.02-SPM Signing and Pavement Marking Site 2 Designer 5
05.03-SPM Signing and Pavement Marking Site 3 Designer 5
06.01-IMS IMS Plans and Details Site1,2,3 Designer 6
07.01-Env 1 Environmental Details Site 1 Designer 7
07.02-Env 2 Environmental Details Site 2 Designer 7
07.03-Env 3 Environmental Details Site 3 Designer 7
08.01-"Utiltiy” gt;:l:t%?_e'\s/llgrépgzs For example 07_AT & T, 07_CL Designer 8
09.01-CL&P FIO CL & P For Information Only plans Designer 8
09.02-AT&T FIO AT & T For Information Only plans Designer 8
CTDOT Highway STD * CTDOT Highway Design Standard Index and Designer 1

Sheets required
CTDOT Traffic STD * CTDOT Traffic Engineering Standard Index and Designer 5
Sheets required
Figure 17 — Multiple Design Firms CTDOT Project Subsets
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1.12 Set Files

This section is still in development, not required at this time.

Bluebeam version 11 has a feature called Sets that allows all the discipline subsets to be viewed
as if they are a single document, without actually combining all the files. The set file places all
the discipline subsets plan sheets in the correct order by using the page label that is assigned
during the sheet numbering process when the discipline subsets are prepared.

The lead designer shall create a Set file for the project at FDP that contains all the discipline
subsets, with the exception of the highway and traffic standard subsets. When an Addendum or
Change Order is required for the project, the set file shall be updated by the lead designer to
include the Addendum or Change Order subsets.

The following shows when and how a set file will be created and updated throughout the life of a
project.

See Appendix C for general use of a set file.

1.12.1  When a Set File is Created and Updated
Set File Creation
1. The lead designer shall create a set file of all the discipline subsets at FDP, see section
1.12.2

Set File Updates
2. If any FDP subsets need to be revised during the DCD process, the set file shall be

updated to remove the FDP subsets that were changed and add the DCD subsets.

3. If any Addendum subsets are required for the project, these Addendum subsets shall be
added to the set file.

4. If any Design Imitated Change Order subsets are required for the project, these Design
Imitated Change Order subsets shall be added to the set file.

See section 1.12.3 for updating the set file.
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1.12.2 Creating a Set File

After all the discipline subsets have been submitted into Projectwise for FDP the lead designer
shall create the project’s set file in accordance with the following:
1. Launch Bluebeam from the desktop icon on your computer.

2. Next Click on the Set Icon and select New Set as shown below:

Q fs a;—u File: Edit Wi Dacument Farm Markup Measure Window Help

8 .
,h,_-,H,q ,..‘g
.l =3 b .
Lot e

Mew Open Save Frint E-mail Studio abs Toolbars Frofiles Ro

hmwES EeE-BE &» < 5

a 7 Ewm» "
-1 R -1 I (1) Click on the

& tiewSet I Set icon
_-u.

E:',- Close Set

(2) Click on the arrow
and select new Set

Figure 18 - Creating a Set File
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3. Then click Add and then Projectwise and OK as shown below:

X]

Set : New Set.bex

File Marne

(1) Click Add

U pe 0

Type |ocation Statuz
[y CampLier [EE

Add Open Filez Add... elete

Optionz - - -

Son 4 [ oge Labe O .| Click Projectwise
Sort Type: | Alphanumeric Ascending w | a n d th e n C I Ic k 0 K
|a= G D=

=1 (=]

Figure 19 - Adding Files to the Set File

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except
the standard subsets. Then click Open: After you click Open it may take a minute for
Bluebeam to load all the files into the set, please be patient.

Q Open Document:

Select

Folder

[ 100_Contract_ptans (POF)

# (8

Dicument
Label (User Defined) Description Main Category  Sub Gafégory | Sub Category Des m

(1) Browse out to your
project’'s 100 Contract
Plan folder

Plans_04 - Final P
Plans_04 - Final P

T_CON_FPL_01135-0270_CTDOT_HIGHuAY_STD. pdf Standard Details
T_CON_FPL_0135-0270_CTDOT_TRAFFIC_STD. pdf CTDOT_TRAFFIC_STD 0T _TRAFFIC_STD

(2) Select all the files
— ' N except the standard
Address: |stctest. projectmiseonline.com: CTOOT|Dacuments\D1.0 - Projects - Activeld135-D2704100_Contract_Fans (FOFIT_con_FeL_o7 S1LI bsets and click OK Zl

| ™ "REYISIONS" "HWWY Details 8 Misc" "HIGHWAY PLANS & SUPERELEVATION DIAGRAMS" "XSC STA, 5+00 TO 125+00" "XIRITA. 125400 1U <2400 AJL 314, £4a-HUU 1 JoU+0U  Laar<ru rnal der

Description:
N
File Hame: [ c7_con_Fet 01350270 0101 - General.pdf” "CT_CON_FL_0135-0270_01.02 - Revisons.pd” 'CT_COM_FPL_0135-0270_ONGS - HWY Detal & Misc.pdf” 'CT_CON_FPL_D135-0270_01.04 - Plans & |
N\
Application: [crobet poF N ~|

[#] Open dacument as read-anly

oo openimomon

Figure 20 - Adding Files to the Set File
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5. Next Click on Relative Paths and make sure the options are selected as shown below:

Set : New Set. bex

File Mame

P ctdot. projectwiseonline. com: CTDO TSI .0 - Projects
P/ ctdot. projectwiseonline. com: CTDOTAIN.0 - Projects
P ctdot. projectwiseonline. com: CTDO TS0 - Projects
P’ ctdot. projectwizeonling. com: CTOO T .0 - Projects
P ctdot. projectwiseonline. com: CTDOTAIN.0 - Projects
P ctdot. projectwiseonline. com: CTDO TSI .0 - Projects
P/ ctdot. projectwiseonline. com: CTDOTAIN.0 - Projects
P ctdot. projectwiseonline. com: CTDOTAIN.0 - Projects
P’ ctdot. projectwizeonling. com: CTOO T .0 - Projects
P ctdot. projectwiseonline. com: CTDOTAIN.0 - Projects
P ctdot. projectwiseonline. com: CTDO TS0 - Projects
<

|2

- Active0135-0270%100_Caontract_Pl
- Active’0135-02704100_Contract_Pl:
- Active0135-0270%100_Cantract_Pl
- Active 01 35-02705100_Contract_Pl:
- Active’0135-02708100_Contract Pl
- Active0135-0270%100_Cantract_Pl
- Active’0135-02708100_Contract_Pl:
- Active0735-02704100_Contract_Pl
- Active 01 35-02705100_Contract_Pl:
- Active0135-02708100_Contract_Pl
- Active 01 35-02704100_Contract_Pl

Add Open Files
Optiohg
Sart By: | Page Label Orily

ot Type: | Alpharumeric Ascending s

Open... ][ Save ][ Save As... ]

Add... Delete

]

* select
these

LK. Lancel

)
( ! UUse Relative Paths )

Figure 21 - Set File Options

6. Next click on Advanced, type in ?# and select the options as shown below:

Sets: Advanced Options

Advanced Options

File: Marme

E Fhf:ctdat. projectwizeonline. com: CTDOTS01.0 - Projects - Activeh Addendum Field: | Fage Label

_u P ctdot projectwizecnling com: CTDOTSOT .0 - Projects - Activeh( addendum Fiter ‘73"* |
P ctdot projectwizecnling com: CTDOTSOT .0 - Projects - Activeh( U
P ctdot projectwizecnling com: CTDOTSOT .0 - Projects - Activeh( . . o
P/ ctdot projectwizeonling com: CTDOTS0T.0 - Projects - Activeh( oo ‘ Hide o |
P/ ctdot projectwizeonling com: CTDOTS0T.0 - Projects - Activeh( Addendum Action: ‘ Highlight » |
P/ ctdot projectwizeonling com: CTDOTS0T.0 - Projects - Activeh(

Lcom:CTDOTYSO.0 - Projects -
Lcom:CTDOTYSO.0 - Projects -

(1) Click

Activeh
Btiveh ﬁldcard Syntax:
+com:CTDOTADLD - Projects - Activel *  Represents zeto of more characters
Achiv #
RV Ax |

(2) Type ?# and
select these

Ad d Lcom:CTDOTAM.0 - Projects - Represents a series of characters that form a number -
vance S ?  Represents a series of alphabetic letters (o] ptl ons.
5 Separator for specifying multiple filkers
} Add Open Files E d el % Escape character to beat above characters as literal T h en CI ICk oK
-‘5) Options Al other characters are literal
o Sort By: | Page Lapel Only / V| e.0. “4# [Represents any characters followed by 'A' and then a number]
= 7
5 Sort Tupe: |Alphanu eric Ascer% v |
Advanced
(L—J)
- —
Open... ] [ Save ] [ Save bs... ] =0 THETCET I
e ——1 T

Figure 22 - Configuring the Set File
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7. Next click Save, this may take a minute for Bluebeam to respond, please be patient.
When the box pops up choose Projectwise and click OK:

Set : New Set.bex @

File Mame

P ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects - Actived 01 35-02708 00_Contract_Plans [PDFACT_COMN_FPL_0135-0270_01.01 - General. pdf B7E10,63

P ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Actived0135-0270800_Contract_Plans [PDFACT_COM_FPL_0135-0270_01.02 - Revisions.pdf. 67610,28

P ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Actived0135-02700 00_Contract_Plans [PDFMNCT_COWN_FPL_0135-0270_01.03 - Hw?' Detail & Misc.pdf B7E10,32
P ctdot. projectwizeoniine. com: CTDIOTA01.0 - Projects - Actived1135-02704100_Contract_Plans [PDFMNCT_COM_FPL_0135-0270_01.04 - Plans & Super Dia.pdf. 67610,29
P ctdot. projectwizeoniine. com: CTDOTA01.0 - Projects - Actived0135-02700 00_Contract_Plans (FDFMNCT_COMN_FPL_0135-0270_01.05 - Cross-Sections. pdf B7E10.25
P ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Actived0135-02704100_Contract_Plans (POFNCT_COW_FPL_0135-0270_01.06 - Cross-Sections. pdf B7E10,26
P ctdot. projectwizeoniine. com:CTDIOTA01.0 - Projects - Activeh0135-02704100_Contract_Plans [PDFNCT_COM_FPL_0135-0270_01.07 - Cross-Sections.pdf. 67E10.27
P ctdot. projectwizeoniine. com:CTDIOTA01.0 - Projects - Activeh1135-02704100_Contract_Plans [PDFMNCT_COM_FPL_0135-0270_02.01 - Stuctures. pdf 67610.80

P ctdot. projectwizeoniine. com: CTOOTA01.0 - Projects - Actived0135-02700 00_Contract_Plans [FDFMCT_COMN_FPL_0135-0270_02.02 - Structures. pdf. 67610,64

P ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Actived0135-027041 00_Contract_Plans [PDFNCT_COWN_FPL_0135-0270_02.03 - Structures. pdf. 67610,65

P ctdot. projectwizeoniine. com:CTDIOTA01.0 - Projects - Activeh1135-02704100_Contract_Plans [PDFMNCT_COM_FPL_0135-0270_02.04 - Stuctures pdf 6761086

P ctdot. projectwizeoniine. com:CTDIOTA01.0 - Projects - Activeh1135-02704100_Contract_Plans [PDFMNCT_COM_FPL_0135-0270_02.05 - Stuctures. pdf 6761087

s ctdat projectwizeoniine. corm: CTOOTA01.0 - Projects - Actived0135-02700 00_Contract_Plans [FDFNCT_COWN_FPL_01358-0270_02.06 - Structures. pdf. 6761057

P ctdot. projectwiseoniine, com CTDOTY01.0 - Projects - Actived0135-02700 00_Contract_Plans (PDFNCT_COWN_FPL_0135-0270_03.01 - Traffic.pdf 67610,68

P ctdot. projectwizeoniing. com: CTDIOTA1.0 - Projects - Actived0135-02704100_Contract_Flans [PDFMNCT_COM_FPL_0135-0270_04.01 - Landzcape.pdf E7E10,81

P ctdot. projectwizeoniine. com: CTDIOTA0.0 - Projects - Actived0135-02704100_Contract_Plans [PDFMNCT_COM_FPL_0135-0270_04.02 - Invasive Removal pdf. 67610,49
Fi:ctdot. projectwigeoniine, com: CTOOTAY01.0 - Projects - Actived0135-02700 00_Contract_Plans [FDFMNCT_CON_FPL_0135-0270_05.01 - General.pdf B7E10,71
Fi:ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Actived0135-0270800_Contract_Plans [FDFMCT_COMN_FPL_0135-0270_05.02 - Revisions.pdf. 67610,75

P ctdat. projectwiseonline. com: CTDOTYI1.0 - Projects - Activet01 3502705100 Conteant Plans (PRECT COM FPI_0135.0270 05 (13 - Civil ndf R7R10 72

F:ctdot. projectwizeoniine. com: CTDOTAO1.0 - Projects - Activeb013! A 3
P ctdot. projectwiseoniine, com: CTDOTY01.0 - Projects - Activeb013! 10,76
P ctdot. projectwiseoniine. com: CTDOTY01.0 - Projects - Activeb013! 10,77
Tupe Location Status
— — S—
Project#/ise V8 ctdot. projectwizeonline. com: CTDOT LoggedIin )
COTTpLer IO CITer

(2) Choose Projectwise

(1) Click and click OK

—— Save |
|0k [) Cancel |

Optiong
SotBy [PagelabelOny /v

4
Sort Type: | Alphanumeric As%ding w |

H
Open... Save ave bs...

Figure 23 - Saving the Set File
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8. Select the Advanced Wizard, and then on the Select target folder browse out to your
project’s 100_Contract_Plans folder. Then click next until you get to the attributes page.
Attribute the Set File as shown below:

Advanced Document Creation Wizard

Define Document Attributes

~
‘r'ou should define environment specific document attibutes. /_, (
Val
Discipline

= s | < (1) Select these
attributes

Main Category Main Category Description

CoM E¥3 | Contract Plans & Specs | |

Sub Category Sub Category Description
u [Plans_08 - Consolidated _ (2) Type the label as
|Pmiect Humber(s) "00-Consolidated Set"
0135-0270

and make the description
Label (User Defined)

T include what the set is
Description UpdatEd tO.

Set ypdated for FDP Flang

T OEE BT I

CT_CON_CMS_0135-0270_00-Conzolidated Set

CTDOT Asset Tags

Bridges Signal Intersections

(3) Click Next until
« the document uploads

< Back ‘l Mext > i' Cancel |

Figure 24 - Attributing the Set File

|l

9. Click OK after the set file has been saved into Projectwise:
Set : New Set. bex E

File: Mame

P :ctdot. projectwiseonline. com: CTDOTY0N.0 - Projects - Activel0001-00014%100_Contract_Plans [PDFISCT_COM_FPL_0001-0001_01-General pdf. 8237611
P/ zctdot. projectwiseonline. com: CTDOTY1.0 - Projects - Activet0001-00014%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_02-Revisions.pdf. 8237613
P cctdot. projectwiseonline. com: CTDOTS01.0 - Projects - Active0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_03-Supporting Docs. pdf.....
Pw:ctdot. projectwiseonling. com: CTDOTY01.0 - Projects - Activet0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0007_04-Civil pdf. 82376.1
Pwctdot. projectwiseonling. com: CTDOTY01.0 - Projects - Activet0001-0001%100_Contract_Plans [PDFSCT_COM_FPL_0001-0001_05-Architectural. pdf. 823, .
P ctdot.projectwiseonling. cam: CTDOTAN .0 - Praojects - Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001 _06-Stuctural pdf 823763
P ctdot.projectwizeonline. com: CTDOTAN .0 - Projects - Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001 _0F-Plumbing, pdf. 823764
P :ctdot. projectiizeonline. com: CTDOTYM .0 - Projects - Activet0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_02-Mechanical. pdf. 8237...
P :ctdot.projectiwizeonling. com: CTDOTAIN .0 - Projects - Activeh0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_039-Electrical pdf. 823766
P :ctdot.projectwizeonling. com: CTDOTHIN .0 - Projects - Activeh0001-00014100_Contract_Plans [PDFNCT_COM_FPL_0001-0001_10-Environmental pdf.82...
NCT_CON_| _

P :ctdot.projectwizeonling. com: CTDOTHIN .0 - Projects - Activeh0001-00014100_Contract_Plans (PDFNCT_COM_FPL_0001-0001_11-Traffic. pdf. B2376.8

Add Open Filex Add.. Delete
Options
Sort By, |Page Label Orly v|

Sort Type: |A\phanumanc Ascending b | C I i {4 k o K
4
Yoo

Figure 25 - Creating a Set File
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10. Now the set file has been created for use of the Set File see Appendix C:

All the files will be
shown here in the
correct order

Figure 26 - Set File
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1.12.3 Updating a Set File

The following will show how to update a set file.

1.12.3.1 Adding a File to the Set File

1. Double click on the set file from Projectwise and open as shown below: This may take a
while please be patient.

w
N o S @ © @4 - search| il ~ | > : Interface| CTDOT_Doc_Code v | View| Document | : Spatial View: Default View ~ | i Backgr
Address| | pw:\ctdot.projectwiseanline.com:CTDOT\Dacuments\01.0 - Prajects - Active\0135-0270\100_Contract_Plans (f ¥ | B> Go
€ 9 B
%% nosg-n0s3 & List | @ Geospatial
. :: gszggis; Description Main Category | Sub Category | Sub Categary Description Application
[ oose-0103 /| 00-Plan Set Updated to FDP Plans con fa] Plans_08 - Consolidated 443
w % 0102 0zre con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 445
[ 01020317 /Bl o102 - Revisians REVISIONS con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3
@ 7% n102-0325 o/ [B) 01.03 - HiY Detail & HWY Detalls & Misc con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3/27
{7 010z-0328 o/ [B) 01,103 - Hwiv Detail_AO1 Pages from CT_CON_FPL_D135-0270_01,03-HW... CON ADP Plans_05 - Addenda Acrobat PDF 443
& [F 01040164 o/ [B) 01.14 - Plans & Super Dia HIGHWAY PLANS 8 SUPERELEVATION DIAGRAMS  CON FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3
® % nio4-0167 /Bl 01.05 - Crass-sectians ¥5C STA. 5+00 TO 125+00 con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3
@ [ 01050208 /Bl 01.05 - Crass-sectians con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3
= % owo7-0158 # [B) 01.07 - Cross-sections XSNGTA, 245-+00 TO 350400 COoN FPL Plans_04 - Final Plans {Adw) Acrobat PDF 3
& [ 01080178 /Bl 0z.01 - Structures 135-2% Final design Plans_Structures CoN FRL Plans_04 - Final Plans {Adv) Acrobat PDF 32
'+ l——: 0108-0162 (& B 0z.02 - Structures con FRL Plans_004 - Final Plans (Adv) #crobat PDF 3
A gﬁgg:i; /Bl 0z.03 - Structures mn o~ - 4 - Final Plans {Adv) Acrobat PDF 3
% 01150114 / Bl 02.04 - Struchures D bl lick 4 - Final Plans (Adv) Acrobat PDF 4
el 7 Blcz.os - struct NN - ouple clic bat POF #
o gﬂ:g:; P TR - Open document wit th t fil bat PDF 3
E :,g 1160133 / Blos. - Traff [eojoqt on e setTlle bat PDF 3i11
(% o013 / Blo4.01 - Lands and click OK bat PDF 3z
w 7% 01170150 Z Blosnz-twas | program bat PDF 3z
%% 01180163 /Bl 0s.01 - Gener| bat PDF iz
0 [%% 0120-0081 /Bl 05.02 - Revisi Name Application Enz bat PDF 3
# % 0120-0085 / Blos.os- civi (¥ Bluebeam Revy Set "Ci\Program Files|Bluebeam Software!Bluebeam RevulRevuiRevu.exe’ ... Mo bat PDF 31z
w [ n1z4-0162 # B 05.04 - Strucy bat FDF 3z
® [ n1e4-0185 /B 05.05 - Existi bat PDF 3z
@ [F ni2s-01s2 /Bl 0s.06 - Envir bat FOF 3z
& % o127-o088 /Bl cTooT_HiGH bat PDF =
& (2% 0130073 # Bl cTooT_TRAF| bat FDF 11
@ % 0130-0178
w1 01310191 <
B o anaoisos T
% 0131-0198 Real (Docume: ¥
,_,: 0131-0202 e
& L 0133-0094
@ [ 0133-0095
= [F mas-0z70 € ADMINISTRA
[ 100_Conkract_Plans (FDF) € bRo-Adnin
[ 110_Caontract_Specifications (PC € co3-idmin < >
[ 120_Contractor_Subrmittals (FOF € qu5-admin
I ;?g_iui\_Tr:h;aeu\ugical_M\sc_Rw €2 ComDOT In
5 onstruction -
& 220 Friwa %_g?gsnud';acﬂ;; [0 s e Yo
| 230_Contract_Administration = Click here For  list of sungested document viswers
[ 240_Cantract_Development €ECTOT_Cont
|= 241_Contract_Development_Col € cTooT Eng | a
L7 310_Preliminary_Design_Docume gCLDOTfmf-
320_Permit_Applications & chdat-servic —
& : 33D:D,55@n:|3u:ta € Dave.Brumbs... Dave Brumbaugh BENTLEY B F F F F F F F F F [C
|2 340_administration € Extraction Service Account Ext... B FFFEFEFRFEFEFEFEE
LA - &0 e [ S = = = = =~ = = = = @—=

Figure 27 - Opening a Set File
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2. Next click on the Set icon and click Add as shown below:

(1) Click on the
Set lcon

File Name

Ft-ctdo. projectwiseonline com: CTDOTSO1.0 - Frojects -
Fwi-ctdo. projectwiseoniine com: CTDOTAO1.0 - Frojects -
Phufctdot. projectuiseoniine com:CTDOTAD.0 - Projects -
Pa/ctdot, projectwiseoniing. com: CTDOTNON.0 - Projects -
F-ctdo. projectwiseonline com: CTDOTS01.0 - Frojects -
Fwi-ctdo. projectwiseoniine com: CTDOTAO1.0 - Frojects -
Phufctdot. projectuiseoniine com:CTDOTAD.0 - Projects -
Pafsctdot, projectwiseoniing. com: CTDOTNIN.0 - Prajects -
P/ ctdol, projectwizeoniine. com CTDOTNI1.0 - Projects -

cidot projectwiseonling. com CTD
dot projectwiseoniine. comCTD
<
: u =
Oplions

SartBy: | Page Label Orly =3
Soit Type: | Alphanumeric Ascending v

m.m.oz2

0.m.03

Figure 28 - Modifying a Set File

0T401.0 - Projects -
1.0- P - hchivel

ActiveA135-0270% 00_Contact_Ple
ActiveA0135-0270% 00_Contact_Ple
ActiveA 0135027041 00_Cantract_Ple
Active
Activel
Ativel

Activel

Activel
HActive]

(2) Click Add
then Projectwise
then OK

Canheel

Next browse out to your project and select the files to add to the set and click Open. This

may take a minute to add the additional file to the set so please be patient. After it

finishes click OK.

Q Open Document

Select |

Folder

‘ [ 100_Contract_Plans (PDF)

# 8

Document

Descriptian Main Cateqe

7B

[B) c_con_FrL_n135-027 Zrer (
# Bl CT_con_FPL_0135-0270_01,02 - Revisians.pdf 01,02 - Revisions REWISIONS con
7 B CT_Com_FPL_0135-0270_01,03 - HWY Detail & Misc. pef 01.03 - HWY Detall & Misc HwY Detalls & Misc con
# B CT_CON_FPL_0135-0270_01.04 - Plans & Super Dia.pdf 01,04 - Plans & Super Dia HIGHWWAY PLANS 8 SUPEREL...  CON
7 Bl CT_con_FRL_n135-0270_01.05 - Cross-Sections pdf 01.05 - Crass-Sections %SC STA, 5+00 TO 125+00 con
# B CT_con_FPL_0135-0270_D1,06 - Cross-Sections, pdf 01.06 - Cross-Sections SCSTA, 125450 TO 245450 CON
/a CT_CON_FPL_0135-0270_01.07 - Cross-Sections,pdf 01.07 - Crass-Sections #5C STA, 245+00 TO 350+00 CON
# B CT_con_FRL_0135-0270_02.01 - Structures.pf 02.01 - Sructures 135-270 Final design Plans_3t...  COK
& Bl c7_con FrL_n13s-0270_02.02 - Structurss.pdf 02.02 - Structures 9-125 FDP_Structures oM
B CT_con_FRL_0135-0270_D2,03 - Structures.pdf 02,03 - Structures 126 FOP_Structures con
# Bl CT_con_FpL_n135-0270_02.04 - Structurss.pdf 02.04 - Struckures oM
# B CT_con_FRL_0135-0270_D2,05 - Structures.pdf 02,05 - Structures con
# Bl T _con_FRL_D135-0270_02.06 - Structures. pdf 02.06 - Structures CoN
# Bl cT_con_FrL_0135-0270_03.01 - Traffic pof 03.01 - Traffic con
# Bl T _con_FRL_0135-0270_04.01 - Landscape.pdf 04.01 - Landscape CoN
/B cT_con_FRL_0135-0270_04.02 - Invasive Remaval pef 04.02 - Inwasive Remaval con
# B)CT_con_FRL_D135-0270_05.01 - General pdf 05.01 - General Con
/B cT_con_FRL_0135-0270_05.02 - Revisions pdf 05.02 - Revisians Index of Revisio
# Bl CT_con_FRL_0135-0270_05.03 - Civil.pdf 05.03 - Civil

/7 BICT_con_FeL_0135-0270_05.04 -
# B CT_con_FPL_D135-0270_05.05 - Existing Plans.pdf
7 Bl CT_con_FeL_0135-0270_05.06 - Enwirenmental. pdf
# Bl CT_con_FPL_0135-0270_CTDOT_HIGHWAY_STD.pdf
7 Bl c1_con_FeL_0135-0270_CTDOT_TRAFFIC_STD.pdf

05.04 - Skruckural
05.05 - Existing Plans
05,06 - Environmental
CTDOT_HIGHWAY_STD
CTDOT_TRAFFIC_STD

Structural.pef

Standard Details
CTDOT_TRAFFIC_STD

@ Ope

your project

« (2) Select the file
& to be added to
“ the set and click

1) Browse out to

P Flans_Us - rinal
FPL Plans_04 - Final
FPL Flans_04 - Final
FPL Plans_04 - Final
FPL Flans_04 - Final
FPL Plans_04 - Final
FPL Flans_04 - Final
FPL Plans_04 - Final
FPL Plans_04 - Final
FPL Plans_04 - Final
FPL Plans_04 - Final
FRL Flans_04 - Final
FPL Plans 04 - Final

n

{ |
Address: pwitictdat projectwiseanline. com:CTDOT|Documents\01 0 - Projects - Activel135-02701100_Contract_Plans (PDFYICT_COM_ADP_0NNg-0270_01,03 - HWY Detail_A01 pdf v/
\
Description: ‘ \ ‘
\
File Marne: ‘ CT_CON_ADP_0135-0270_01,03 - HWY Detal_a01,pdf \ ‘
\
Application: [acrobat POF \ v
[¥]open dacument as read-only
7~ ~~
([ oren | Jomen from pisk | [ cancel

Figure 29 - Adding Files to the Set File

Issued 9-2014 31

Version 3.07




Connecticut Department of Transportation Digital Project Development Manual

4. Now the file will be added to the set, scroll down and you will see it.

.0z

CT_CON_ADP_0135-0270_01 03 - Y Detail ...

01.03.01.41

CT_COM_FPL_0135-0270_01.03 - H¥WY Detail & ...

Issued 9-2014

- = 23 " BT
D DP_O 0270_01.0 D 0
Addendum No. 1
plan sheet 03 - HIGng&YOE
Original Plan
sheets
~ a : N0

Figure 30 - Set File

32 Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

1.12.3.2

Deleting a File from the Set

1. Double click on the set file from Projectwise and open as shown below: This may take a
while please be patient.

120_Contractor_Submittals (POF
130_Soi_Archaeological_Misc_R:
210_Construction

220_FHWA
230_Contract_Administration
240_Contract_Pevelopment
241_Contract_Development_Coi
310_Preliminary_Design_Docume
320_Permit_Applications
330_Design_Data
340_Administration

\SAsAsASASATARATARARARARAS

Issued 9-2014

€ co-admin
H

€= ConnDaT_In.
€= Consultant £
€ cTcodechan
€ cTDOT _Cont|
€ cTooT_Eng |
€ cToOT Proc)

€ crdot-servic

Open document as read-orly
Click here For a st of suggested document viewers

Browse

€ Dave.Brumba. .

€ Extraction

Dave Brumbaugh BENTLEY
Service Account Ext., ..

1<1=
1=1=

B
2

Figure 31 - Opening a Set File
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)
R e @ © @4 - search|[3 v | Interface| CTDOT Doc_Code v | View| Document | : Spatial View: Default View v | :Backgr
Address| | pw:\ctdot. projectwiseonline.com:CTDOT\Documents\01.0 - Projects - Active\0135-0270\100_Contract_Plans (f % | B> Go
-0 B
= [*F onos-0003 E List | @ Geaspatial
[ nosg-0101
& (7 ngs.m02 Description Main Category | Sub Category | Sub Categary Description Application
i :x 0093-0103 /| 00-Plan Set Updated to FDP Plans con fa] Plans_08 - Consolidated 43
(%% n10z-0278 " con FPL Plans_04 - Final Plans (Adv) Acrobat PDF 45
& (%% 01020517 /Bl o102 - Revisians REVISIONS con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3
%% n102-0325 /7 [B) 01,03 - Hiy Detail & HWY Detalls & Misc con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3j27
[ 01020328 /7 Bl 01103 - Hwiv Detail_An1 Pages from CT_CON_FPL_D135-0270_01,03-HW... CON ADP Plans_05 - Addenda Acrobat PDF 443
L 01040164 7 Bl 01.14 - Plans & Super Dia HIGHWAY PLANS 8 SUPERELEVATION DIAGRAMS  CON FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3f
& [ 01040167 /Bl 01.05 - Crass-sectians ¥5C STA. 5+00 TO 125+00 con FrL Plans_04 - Final Plans (Adv) Acrobat PDF 3f
L% 0105-0206 o/ [B) 0106 - Cross-sections con FrL Plans_004 - Final Plans (Adw) #crobat PDF 3
E n_.: 0107-0158 /B 01.07 - Cross-sections XSWGTA, 245400 TO 350400 CON FPL Plans_04 - Final Plans (adv) Acrobat PDF 3
n.n 0108-0178 /Bl 0z.01 - Structures 135-29 Final design Plans_structures COoN FPL Plans_04 - Final Plans (Adw) Acrobat PDF 32
& e 0108-0162 (& B 0z.02 - Structures con FRL Plans_004 - Final Plans (Adw) #crobat PDF 3
iy A gﬁgg:z /B 02.03 - structures mn o~ = 4 - Final Plans {Adv) Acrobat PDF 3
il 0115'0114 /Bl 0z.04 - Structures D bl I . k 4 - Final Plans (Adv) #crobat PDF 4
& g
& ) ouble clic e 4
® [F 01150117 =< Open document with bt POF 3
® % 01160128 i
& ¥ onie 013 Z Bz -t e on the set file bat PDF 31
L
o1 /Bl 0401 - Lands| : bat PDF 3z
& L 01160134
[ nuirnise / Blosnz-twasll | program and click OK hat PDF 3j2
& (%% 01160163 / Bl 0s.01 - Gener| bat PDF 3z
%% n120-0081 / Bl 0502 - Revisi Name Application Enz bat PDF 3
@[ 0120-0085 / Blos.o3- il (% Bluebeam Revu Set Eluebeam Rev "C:\Program Files\Bluebeam Software!Blusbeam RevulRevUiRevaexe" ... Mo bat PDF 3j12
% n124-0182 /Bl 05.04 - Strucy bat PDF 3j12
@ [ 0124-0165 /Bl 05.05 - Existir} bat PDF 3j2
[* ize-mez / [B) 0506 - Envir bat PDF 32
E n_.: 0127-0088 / Bl cTooT_HigH bat PDF 2l
L% 01300173 /Bl cTooT_TRad bat PDF 11
@ % 0130-0178
w1 01310191 <
01314 r
@ | T% 0131-0194 & 0131-0195 5
% 1% 01310157 Document Fraperties
@ % 0131-0198 Real (Documen ¥
* 01314
=0 01310202 pre—
1 0133-0094
[ 0133-0095
= [2F mas-nzzo € ADMINISTRA
100_Contract_Plans (FOF) € re-ndnin
110_Contract_Specifications (PC < >
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2. Next click on the Set Icon. Then select the file to remove from the set and click delete:

PeTa e me Ak et Note: You can make
the width of the file —+O
General pdl.67510,63

P ctdot. projectwizeoniine. com CTDOTY01.0 - 270_m.07 -

e ncin 0 NAMe column wider 700105 L et . W ok 751032
sctdot. projectwizeonline. com; . . 270.M.03 - etai isc.pdf. .

P ctdot. projectwizeoniine. com: CTDOTY01.0 270_01.04 - Plans & Super Dia pdf. 67E10,23

P ctdat. projectwizeonline. corm: CTDOTY01.0 by d ra g g I n g th e CO I u m n 270_01.05 - Cross-Sections. pdf. 67610.25

P ctdot. projectwizeoniine. com CTDOTY01.0 270_01.06 - Cross-5ections. pdf. 67610,26

P ctdot. projectwizeoniine. com CTDOTY01.0 - Cross-Sections. pdf.67610,27

e e e e
P ctdot. projectwizeoniine. com: CTDOTY01.0 - Projects - Active’01 35-0270%100_Contract_Mans [PDFNCT_COM_FPL_O135-0270_02.04 - Structures. pdl.67610,86
P ctdot. projectwizeonine. com CTDOTY01.0 - Projects - Activet0135-02704100_Contragf| _ | FPL_I 2 | 02.08 - Structures. pdl. 6761087
P ctdot. projectwizeonine. com CTDOTSOT.0 - Projects - - Stuctures. pdf. 67610.57
P ctdot. projectwizeoniine. com CTDOTS01.0 - Projects - 2 - Traffic.pdf. 6FE10,68
P ctdot. projectwizeoniing. corm CTDOTSO1.0 - Projects - 2 01 - Landscape. pdf. 6761081
P ctdot. projectwizeoniine. com CTDOTAO.0 - Projects - - Invasive Removal pdf. 67610.43
P ctdot. projectwizeoniine. corm: CTDOTY01.0 - Projects - Acti | | | | _ | FPL_I g | 05.01 - General pdt.67610.71
P ctdot. projectwizeoniine. com CTDOTYO1.0 - Projects - - Revisions.pdf. 6761075
P ctdot. projectwizeoniine. com CTDOTS01.0 - Projects - - Civil pdf EFE10,72
P ctdot. projectwizeonine. com CTDOTSOT.0 - Projects - - Structural pdf. 67610,73
P ctdot. projectwizeoniine. com: CTDOTYO1.0 - Projects - Acti -0270%100_Contract_Plans [PDFNCT_COM_FPL_0135-0270_05.05 - Exizting Planz. pdf 67610,76
P ctdot. projectwizeoniine. corm: CTDOTY01.0 - Projects - Acti 35-02704100_Contract_Plans (POFNCT_COM_FPL_01235-0270_05.06 - Environmental. pdf 67610,77

Select file to delete

and select delete, then
_ click OK

Sort By: | Page Label Only

Sort Type: | Alphanuernic Ascending

o

Figure 32 - Deleting a File from the Set File
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Section 2 Digital Signatures for Contract
Documents and Other Engineering
Documents

The follow contract documents must be digitally signed when submitted to the Department in
accordance with the following section:
e Contract Plans — FDP, Addendum, Change Orders
e Engineering Reports
o Hydraulic Report
o Scour Report
o Floodway Report
e Working Drawings for Permanent and Temporary Structures — Plans and Calculations

This manual refers to digital signhatures in two ways: certifying signatures, and signing signatures.
The Engineer of Record will always digitally sign using a visible certifying signature. If multiple
signatures are required per document, the sub-engineers shall always digitally sign using a visible
signing signature after the primary engineer has applied his certifying signature. Certifying
signatures allow controlled changes, to the now certified document. These controlled changes
include; allowing PDF digital comments, and the application of additional signatures. Signing
signatures should always be accompanied by a note listing the sheets the signer is responsible for
within a subset.

In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the
first sheet of each discipline subset(s), engineering report, or contractor submittal, regardless of
the number of pages the document contains. This single digital signature secures the entire
document.

A graphic image of the signer’s PE stamp and signature must be created, and shall be used for the
following purposes.
o It shall be attached to the digital signature and displayed when the digital signature is
applied.
e It shall be placed as a watermark on all contract plan sheets a particular engineer of
record is responsible for (digitally signing for).
o It shall be placed on the first sheet by the checker of an engineering report.
e The watermark shall be placed on all contract plan sheets and all plan sheets contained in
a working drawing submittal.

A digital ID must be purchased in order to apply a digital signature. Digital ID’s must meet the
specifications of Adobe’s Certified Document Services (CDS). The necessary hardware and
software needed to apply the required digital signatures may be purchased from the vendor list
provided at the following website: http://www.adobe.com/security/partners_cds.html, additional
information on Adobe’s CDS is also available at this website.
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2.1 Graphic Image of Signhature

Contract Plans
The following figures display an example of both a state designer and a consultant designer’s
digital signatures, and their accompanying graphic image(s) of their signature(s).

The consultant engineer’s graphic image must contain his companies name and address; his
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state
employee’s graphic image must contain only his signature. See Below.

- State Design
Digital Signature

= | 1" page of Subset

L Consultant
az:'.u%mﬂézw, Digital Signature

011.0624
14540500

Scanned Signature "Graphic Appearance"

Figure 33 - Graphic Image of Signature

In addition to a digital signature being placed on the first sheet of any contract plan, working
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages
be watermarked with a copy of the engineer of records graphic signature before they are digitally
signed. Watermarks containing these signatures are applied using Bluebeam and are always
placed in the border of contract plans and working drawings for permanent structures. This is to
prove validation of a digital document if printed.

Watermark of State Design Graphic
Signature

- = - - ]
SCALE: 33" = 1'-0"'Kj SCA

W PROJECT T
T Fﬂ OFFICE OF ENGINEERI
AFPROVED BY! DATE: N

Hallar - Gbin )/
\/

Watermark of Consultant Designers
Graphic Signature

Figure 34 — Watermarks

Issued 9-2014 36 Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

Engineering Reports
The following shows the watermarks that need to be placed on the first sheet of an Engineering
Report by the Preparer and the Checker and the digital signature of the Approved Hydraulic

Engineer.

FINAL HYDRAULIC REPORT

FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER

(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectonic Engineering & Surveying Consultants PC
March 8, 2010

___  Watemark of

b.z/ (AR ;',3 & Checker
Pasdl Magyar, P 1 "'/'(:_"'-':_vr'_ PRy l
William Pratt Digital
2014.03.12 Signature

13:49:10-04'00'

REVISIONS

Figure 35 - Engineering Reports
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Working Drawings for Permanent and Temporary Structures

The following shows the digital signature and PE watermark requirements for the engineer who
prepares the working drawing submittal. Note: Working Drawing for Temporary Structures
only require that the first sheet in the submittal be digitally signed, watermarks are not necessary.

Working Drawing Plans

The first plan sheet in the submittal shall have a digital signature and a watermark placed on it as
shown below. All others sheets will only have the watermark. A place in the border of the plan
sheets shall have a spot for this watermark.

BEAM END PAINTING AND BEARING REPLACEMENT IN DISTRICT 2.

CONNECTICUT DEPARTMENT OF TRANSPORTATION
STATE PROJECT NO. 172-405

BRIDGE #3415 & #3416 - WORK PLAN

DRAWING INDEX
DRAWING Ne. | DRAWING TITLE

130020101 | cOVER SHEET
13002-01-02 | GeneRmL NOTES
130020103 | IACKING PROCEDURE
130020110 _|PLATFORM PLAN

- . 130020111 [pontronat puan
~| Digital Signature Lownzn1z|mckmapuan
130020113 | ACKING PLAN
13002010 [rathoa secrion
T00z0121_[natrom secrion
13002-01-22 [ PLATFORM SECTION
0020123 [ ruarea wakney
1300201 24 [s7un case
50020130 | ARG ocTal

A William Pratt
)y 20140312
S0 13:49:10-0400°

13002-01-31 [ IncianG peran
130020140 | CONTAINMENT SECTION

13002-01-41 | CONTAINMENT SECTION
130020156 | CONTAINMENT DETAIL
1130020160 | CONTAINMENT NOTES
13002.0161 | CONTAINMENT KOTES

Watermark /R —————

IN BISTRICT 2, CONNECTICUT
o e
BRIDGE #3415 & #3416
)
5

“COVER SHEET

Figure 36 - Working Drawing for Permanent Structures

Working Drawing Calculations
The first sheet of the calculations shall have a digital signature as shown below:

ABHE
SvosopA
INC.

ML

BRIDGE BEAM END AND BEARING REPAIR
IN DISTRICT 2
CONNECTICUT DEPARTMENT OF
TRANSPORTATION

PROJECT NO.172-405, ASI JOB NO.13002
(BRIDGE #3415 & #3416)
Calculations

William Pratt

Digital =% . .
/i3 2014.03.12
Signature L2 13:49:10-0400

Abhe & Svoboda, Inc.

17066 Revere Way, Prior Lake, MN 5537

June 24, 2013

Abihe: & Sucboda, Inc. i an Equal Oppartunity Employer

Figure 37 - Working Drawing for Permanent Structures
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2.2 Creating Graphic Image of Signature:

2.2.1 In House CTDOT Signature:

The graphic signature will be used by CTDOT employees and the preparer and Checker of an
Engineering Report. P.E. stamps are not required.

The following CTDOT employees need to create graphic images of their signatures: Principal
Engineer (required to digitally sign plans), Manager of State Design, and the Engineering
Administrator. CTDOT graphic signatures shall be created as follows:

Signer must sign a blank piece of paper.
Scan this signature.

Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.
Save the images, in PDF to an area on your PC.

12 30—

Figure 38 (Example of CTDOT Graphic Image of Signature — Used with Digital Signature and as a Watermark)

Eall A

2.2.2 For Consultant Staff PE Stamp:

Consultant Engineers shall create two different graphic signature images: one that shall
accompany their digital signatures and a different one that shall be placed as a watermark on all
the sheets the designer is signing for.

This section shows an example of a Professional Engineer preparing their graphic image of their
signature; Architect’s shall follow this section when they are preparing their digital signature.

Graphic Appearance Attached to Digital Signature
The graphic signature that accompanies the digital signature only needs to include the designer’s
signature and P.E. Stamp. , and shall be created as follows:

Stamp and Sign a blank piece of paper.

Scan this signature.

Crop the image to approximately 250 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the signature set-up procedure.

Vi,
W /,
\\ QS ,O.QA.HY$O){/

roNPE

Figure 39 ((Example of Consultant Engineer Graphic image of Signature — Applied to 1% page only with digital signature)
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Graphic Appearance used as a Watermark

In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a
watermark shall also include the designer’s company name and address, and shall be created as
follows:

On blank paper — Print company name and address.

Place P.E. stamp next to company name and address.

Sign P.E. Stamp.

Scan the image created in steps 1 thru 3 above.

Crop the image to approximately 500 pixels wide by 250 pixels high.

Save the image, in PDF to an area on your PC or server, where you can easily access it
for later use in the watermarking procedure.

ocouaprwNE

S
N ?29’!{“80{{/, Consultant Co. A
%%
> Q% Address

=

Figure 40 (Example of Consultant Engineer Graphic image of Signature — applied to all pages as a watermark)

Once the graphic images have been properly created and saved, the digital signature appearance
preferences must be set as follows:

2.3 Setting Digital Signature Appearance Preferences:

Once the graphic signatures are created the digital signature appearance settings must be defined
as follows:
Bluebeam Digital Appearance

1. Make sure your CDS USB token is inserted into the computer then in Bluebeam go to the
Document tab and select Signatures>Digital ID’s:

Document Form Markup Measure Window Help

= - o s v H- % R

Securty 1 =W Process Flatten

£&  Sign Document
i ¥ - ]
AR -1 B PEyvr——"

| : -

Certify Document. ..

Documentl* = Validate Signatures

Digital IDs...

Trusted Identities. ..

Figure 41 - Digital Appearance
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2.

(1) Select ID

Location

Mame

Next click on your ID and click Manage Appearances:

Nad A

d:\Documents and Settingscalkinemhapp
“Windows Certificate Store

f. b athew Calking )

|dentity

Mathew Calking lzzued By:
Starts:

Expires:

ame:

Organizationaglnit:
Organization M&mwe:  AEC Applicati

E-mail Addrégs:  mathew. calfinsiEct. gov
g U5

(3) Double Click

Dijafftal Signatures and Drata Encryption

Appearance

[ Export... (’[-_Manage Appearances... ] R
(2) Click Manage

Figure 42 - Manage Appearances

3. Next follow the figure below:

£3
"

Signature Appearance

Title: |I'v'|aﬁ'5 Signature

Graphic
() None
é File |X:W'E_.ﬁ.dmin\Dig'rtal_Signatures_For_Waterrnar| @
Position: (#) Left ) Right ) Background
Teat

——

>

— Type in name

Browse to graphic
Appearance

Make sure these

J—

= Mame )
[ | Distinguished Name W"

[] Labels
Font Size: © Auto \ [ Logo
Preview
<Name>
Mé:_- <Reason>
<Date>

S =23

settings are like
shown

_— Click

Figure 43 - Setting the Digital Appearance

4. Now the digital appearance will be saved and can be used to digitally sign.
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2.4 Watermarking Plans with Graphic Image of
Signature

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a
copy of their graphic signature as a watermark on each sheet of each discipline subset, or working
drawing submittal(Plans and Calculations) that they are responsible for. For Engineering Reports
the checker of the report shall place a copy of their graphic signature as a watermark only on the
cover of the report

Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and
Consultant Designed)

There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2. The
following shows an example of a CTDOT signature, but the procedure is the same for a
consultant when they are placing their PE stamp in the border or on the first sheet of an
engineering report.

Watermarking Workflow:
Option 1
1. The watermark in Bluebeam is placed using the stamp function. First go to the Markup
tab and select Stamp and then choose your stamp. If your stamp is not in the list follow
Appendix A. If your stamp is in the list go to step 2.
2. Next Place the stamp in the border on the first sheet.

l pr—

Place stamp in this
area in the border ——

SIOHMATURES PEOIECT TITLE:
BLOCK

F CONMNECTICUT OFFICE OF DNGINEERING
)JF TRANSPORTATION [

L = L
145 Cuck Man.dan M@f‘

Figure 44 - Placing Watermark
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3. Next right click on the stamp and select “Apply to all pages”. If you are watermarking an

engineering report you do not need to apply to all pages.

Paste
Delete

Open Pop-Up Note

Change Colors

Order
Alignment
Edit Action
Flatten

Lock Ctrl+5hift-+H

Figure 45 - Placing Watermark on All Pages

If more than one group has to watermark this subset, browse to the pages the other group is
responsible for and delete the watermark. Then they can come in a place their watermark on

these sheets.

Flatten Markups

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF
document. Go to Document>Flatten Markups. Use the default settings and click OK.

Option 2
Issued 9-2014
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1. Go to the Document tab and Pages>Apply Stamp.

Document Form Markup Measure Window Help

-1 8 K

E Ctrl+5hift+N

Documentl® = ™

o act Pag Ctrl+5hift+X
] ges... Ctrl+shi
s

™ ate Pages... C 4R
Cirl+Shift+C
B -

Figure 46 - Applying Stamps

2. Select stamp, input scale and coordinates as necessary, and page range as shown below.

Select stamp

Stamp Selection
FAVE_Admin'Bluebeam Stamps* Traffic ‘
@uck Harlow brx v |
Name:
Author: \ A

Size: 3.77inx0.58in
Date: 10/18/2011 7:23 AM

Degrees Choose scale and

T 4 position

Blend Mode: |N0rrna| {none)
Opacity: [100 = = G_cale: 100

<
il
=3
a
o
=1
(=]
] £

Pag;
k Choose page

'« Fie[Tof 11: State Design Structursl Supset o - Anchor: [ ][ ][]
-0 range Sptions T 555 ..
Edit Stamp_| [ Add Fies |

Figure 47 - Applying Stamps

Flatten Markups
3. After the watermarks have been placed on the subset, the watermarks must be “flattened”

to the PDF document. Go to Document>Flatten Markups. Use the default settings and
click OK.
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2.5 Digital Signature Fields

Contract Plans

Digital signature fields are form fields created using Bluebeam, and are used to house the digital
signatures. Digital Signature form fields shall be placed within the form field place holders. The
form field place holders are cells that are placed in the MicroStation file on the title sheet and the
subset cover sheets and on any Addendum or Change Order Subset. The figure below shows a
CTDOT designed project with the form field place holders (circled) on the title sheet and the
discipline subset cover sheet.

E}g&{:’; CONNECTICUT DEPARTMENT OF TRANSPORTATION (=

EDIT FOR
PROJECT
TITLE
## = SUBSET NAME

Ferenin /ity of
EDIT FOR
TOWNS_AND/OR INDEX OF DRAWINGS

CITIES

0000000 |- =| =

Figure 48 - Digital Signature Fields

The figure below shows a consultant designed project’s title sheet and discipline subset cover
sheet with their form field place holders.

@c‘ CONNECTICUT DEPARTMENT OF TRANSPORTATION (@)

EDIT FOR
PROJECT
i TITLE ## - SUBSET NAME

Townis)city INDEX OF DRAWINGS
EDIT FOR
TOWNS AND/OR =
CITIES

il

|- - ] — e | — i

0000-0000 =5

Figure 49 - Consultant Watermarks

Place holders determine the location and size of the digital signature form field.

Form field place holding cell library: CT_Digital_Sigs.zip

The digital signature place holder and form fields shall be created on the first page of each
discipline subset for each required digital signature.

Note: All signature form fields need to be created for both certifying and signing signatures
before any digital signatures is applied to the document.

Contractor Submittals
Contractor submittals will not be required to have a digital signature place holder.

Engineering Reports
Engineering reports will not be required to have a digital signature place holder.
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2.5.1 Bluebeam - Creating Digital Sighature Form
Fields

The following example shows how to place the (3) digital signature form fields on the 01-General
title sheet of a CTDOT designed project. For a discipline subset or a consultant designed 01-
General title sheet, only one digital signature form field needs to be placed.

1. Go to the Document tab and select Signatures>Add Signature Field.

Edit View Documert Com Markup Measure Window Help

d v

Security

f s
a ' | X Add Signature Field X

F s R

Fiatten

—

Certify Document...
Documentl®
Digital IDs...

Trusted Identities...

Figure 50 - Adding Signature Fields
2. Next place three signature fields in the appropriate location and hit save as shown below:

THE DESIGN APPEARS TO CONFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEN PERSONALLY CHECKED BY THE UNDERSIGNED.

=

SUBMITTED BY TRANSPORTATION PRINCIPAL ENGINEER P.E.
[

WPPROVAL RECOMMENDED BY MANAGER OF STATE DESIGN - SCOTT A.HILL P.E.
[

APPROVED TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 51 - Placing Signature Fields
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2.6 Applying Digital Signatures
This section describes how to apply digital signatures for contract plans, engineering reports,
working drawing plans, and working drawing calculations.

Contract Plans
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic
Standard drawing subsets have unique requirements as described in the following sections.

CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded
into projectwise because the Principal Engineer will be looking in projectwise to digitally sign
documents.

Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of
record, using a single visible certifying signature, applied to the signature form field located on
the first page of each subset.

Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of
Record who is responsible for the most sheets in the subsets. This engineer will apply a visible
certifying signature in the top most form field. The next Engineer of Record shall apply their
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when
applying their digital signatures, listing the pages they are responsible for.

Digital signatures must be applied to digital form fields, previously created. See Section 2.5

Engineering Reports

Engineering Reports shall be digitally signed, by the CTDOT Approved Hydraulic Engineer
using a certifying. See section 2.7. for instructions on how to apply a certifying signature to an
engineering report.

2.6.1 Applying Digital Signatures to 01_General
Subset (FDP and Addendum Subsets)

CTDOT DESIGNED PROJECTS:
The following procedure applies to both the 01_General subset at FDP and any 01_General _A#
subset.

The project title sheet of the 01_General subset shall first be digitally signed by the lead
discipline’s Principal Engineer, using a certifying signature. The Principal Engineer should
make sure that all three digital signature form fields (blue boxes in the signature block) are placed
before signing, as these forms cannot be added after the document is digitally certified. After
processing has approved the 01_general subset for Advertising, the Manager, and the
Transportation Engineering Administrator shall digitally sign the same sheet directly below the
principal’s signature, using a signing signature while the plans are in the Manager and
Engineer Admin. Sign state.

Processing shall notify the lead designer when the 01-General subset is placed in the Manager
and Engineer Admin. Sign state. The lead designer shall then coordinate the digital signing by
the Manager and Engineering Administrator of the 01_General subset. When both signatures are
applied to the plans, the lead designer shall then notify processing that the 01-General subset has
been signed.

See Section 2.7 Applying Digital Signature Workflows

Note: When digitally signing the 01_General subset all signers shall leave the reason code blank.
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The following image shows a typical project title sheet from the 01_General subset that is
digitally signed:

C CT_CON_DCD_0092-0655_01_General =
T B B O ) A Y L T N Y T T N T T T A T T T TN T

CONNECTICUT DEPARTMENT OF TRANSPORTATION ;_‘
o U;E"ESBE =

(o]
SIDEWALK RAMPS

Town(s)/City of

NEW HAVEN

0092-0655 |+

Figure 52 - Title Sheet Digital Signatures

THE DESIGN APPEARS TO CONFORM TO APPLICABLE CRITERIA. APPROVAL IS
NOT TO BE CONSTRUED TO MEAN THAT ALL ASPECTS OF THE DESIGN HAVE
BEEN PERSOMALLY CHECKED BY THE UNDERSIGNED.

k /Z\%ﬁé\ Leo L. Fontaine Visible Certifying Signature
72 2012.04.03 11:59:18-04'00'

@

SUBMITTED BY: TRANSPORTATION PRINCIPAL ENGINEER - LEO L. FOUNTAINE P.E.

7 A
Vo sl James A. Fallon L . .
\5 s 1o \Qa..gvv» 2012.04.04 08:54:35-04'00" Visible Signing Signature

APPROVAL RECOMMENDED BY: MANAGER OF - JAMES A. FALLON P.E.

# i James H. Norman ST

2012.04.04 09:58:05-04'00' Visible Signing Signature

APPROVED BY: TRANSPORTATION ENGINEERING ADMINISTRATOR - JAMES H. NORMAN P.E.

Figure 53 Example: CTDOT 01_General.pdf, Project Title Sheet Digital Signatures

CONSULTANT DESIGNED PROJECTS:
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant,
using a certifying signature.

See Section 2.7 Applying Digital Signature Workflows

When more than one consultant works on a CTDOT digital project the project manager (prime
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.
By applying this signature the prime consultant is accepting responsibility for the entire set of
digital contract plans. However the individual subsets shall be signed by the corresponding firms.

Note: When applying certifying or signing signatures leave the reason code blank.
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Subset

2.6.2 Applying a Digital Signatures to 02_Revisions

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature, but the workflows are the same.

This subset does not need to be signed at FDP. This subset must be signed when the sheet is
filled out for an Addendum or design initiated change order, whichever comes first.

The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally
signed by the lead designer, using a certifying signature.

1. The lead designer shall apply a certifying signature as described in section 2.7 Applying
Digital Signature Workflows with the following EXCEPTION; the option “No

Changes Allowed” must be selected to eliminate unauthorized changes after certifying
the document. See the figure below:

Issued 9-2014

Drigital (D

Paszword:

Signature Type
) Digital Signature

%) Document Certification
Fermitbed changes atker certibving:

Mo changes allowed "
O ptions
Reazon: | y|
Location: | |
Contact Info: | |
Appearance
|5tandar|:| Test VH Edi... H Mew... ]
<Name>
Hatar f 29 < ocation>
<Date>
[ ] ” Cancel ]

bsien __ Ix]

||'-.-'|att|:a|kir‘|g v“ Wi, ][ Mew. .. ]

Figure 54 Certifying Dialog Box for 02_Revisions.pdf
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2.6.3 All Other Discipline Subsets - Single
Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the
responsible design engineer. As shown below.

See section 2.7 Applying Digital Signature Workflows

DESIGNED BY: \\“"'"/I/ S
CONSULTANT COMPANY NAME \\\2’\03 %9:_‘3;(;0;;,,’ William Pratt
~' . S (-
55'{’&% €2 2009.01.27
=’ B
'5,%\ vojsess s~ 10:46:19
7R CENS

e X "N
. ,///,}”ONA\.-‘a > -05'00

Figure 55 CTDOT Certified Plan Subset

2.6.4 Standard Drawing Subsets - Single Signature

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same.

Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need to
be digitally signed with a visible certifying signature, by the responsible design engineer that
submits the subset to Projectwise. For example, in the case where the Traffic unit is submitting a
Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the
index sheets, not the Highway Principal Engineer.

See section 2.7 Applying Digital Signature Workflows

2.6.5 All Other Discipline Subsets — Multi-
Signatures

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a consultant signature, but the workflow is the same for
CTDOT designed projects.

Multiple signatures per a single subset are required where two or more disciplines/firms are
responsible for one subset.

The lead designer that is responsible for most of the pages within a discipline subset shall
digitally sign the subset using a certifying signature, and leave the reason code blank. See
Section 2.7 Applying Digital Signature Workflows
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Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset
using a signing signature, and complete the reason code with a note stating which pages,
contained in this subset, that they are responsible for. See table 2-1 below:

See Section 2.7 Applying Digital Signature Workflows

Table 2-1 Reason Codes for Prime and Sub Consultants

Designer Certify Responsible Reason Code
or Sign Sheet
Numbers

Lead Designer Certify
Sub-Designer 1 Sign 03.78 Thru I am Signing for Sheet Nos. 03.78 thru

03.88 03.88
Sub-Designer 2 — | Sign 03.88 Thru I am Signing for Sheet Nos. 03.88 thru
etc. 03.98 03.98

2.6.6 Working Drawings

Working drawing submittals shall be digitally certified in accordance with section 2.7 Visible
Digital Signature using a Certifying signature, of this manual.

2.6.7 Engineering Reports

Engineering Reports shall be digitally signed, by the CTDOT Approved Hydraulic Engineer
using a certifying. See section 2.7. for instructions on how to apply a certifying signature to an

engineering report.
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2.7 Applying Digital Signature Workflows

This section applies to both CTDOT designed projects and Consultant designed projects. The
figures contained in this section show a CTDOT signature, but the workflows are the same.

Certifying Signature:
1. Leftclick on the signature field and then update the settings as shown below. Examples
below are for a CTDOT designed project’s title sheet and the first sheet of an
Engineering Report:

Discipline Subsets

Select your ID and
select as shown

Click on the signature - 7
to certify :

THE OLSIGN APPCARS TO Agﬁn TO APPLICADLE CRITERIA. APPROVAL IS

BEEN PERSONALLY CHECKED OY THE UNOERSIGNED. ]

Locasion
Contact info.
[pritnac MDD Br mawalEh O STATE GESHN - SCOTT a Wl P A )
==
Mathew Calkin
e TN DUCETANG PO TRATIR - JWEs 1o w71 s
7/ 2011.10.18 10:
38:10-04'00
=)

Figure 56 - Certifying Discipline Subsets

Engineering Reports

FINAL HYDRAULIC REPORT
FOR SOUTH MAPLE STREET BRIDGE
OVER SCANTIC RIVER
(Bridge No. 03972)

Enfield, Connecticut

PREPARED BY: Tectenic Engineering & Surveying Consultants PC

March 8, 2010

Prepared By: Pl §- laHom Date: 1/21/14

Mathew Calkins' C"Ck on the
H M—.zér: : . -
e mE oaesvaifg signature field
an -
to certify

Figure 57 - Certifying Engineering Reports
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2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list
below:

ocation

QL.d =| W
il| ProjectWise Vai ctdot projectwiseonline.com:CTDOT Logged In

Login [ oK ][Cancel]

Figure 58 - Certifying Signature

3. Then select yes to overwrite existing file as shown below for projectwise or if the
document is located on your computer overwrite the existing file or save to a new
location:

ProjectWise Overwrite File

Thefile TT_DOC_PUE__Intro to Bluebeam pdf” already exists
A in ProjectWise.

Do you want to overwrite. Select 'No’ to save as a new
filename.

Yes Mo ] [ Cancel ]

Figure 59 - Certifying Signature

4. If using Projectwise check the document back into Projectwise.
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Digital Signing Signature:
Once the prime engineer applies his certifying signature the additional signing signatures can be
applied by the sub-consultants as follows:

1. Leftclick on the signature field and then update the settings as shown below:

T
Select your ID, a reason

Ovpal 1D .
Click on the Mahow Cabors 3 - if necessary and select
: o as shown
signature
™ D?'v!.'-n APPTARS "O-‘(‘ON'C.N. TO APPLICAIRE, ITERIA, 'JNO".\‘M 1
SeEn FOSORALLY OREXED B e ARSI
' Mas Calkins
‘w ,zk 20)4.10.18 10:40:43-04'00"
T.uru BT TNATTONATION PR DL -
Mathew Calkin
s
o TR T L 1%2&:’2011.10.1310:
40:46-04'00"

Figure 60 - Signing Signaure Bluebeam

2. Next for document in located in Projectwise click Projectwise V8i as shown below and
then click OK. If the document is located on your computer click My Computer list

below:

Save To

oCaton

ctdot projectwiseonline com:CTDOT

Logged In

il| ProjectWise Vi

(o] (oo

Figure 61 - Open from Projectwise
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3. Then select yes to overwrite existing file as shown below for projectwise or if the
document is located on your computer overwrite the existing file or save to a new

location:

ProjectWise Overwrite File

A

The file TT_DOC_PUB__Intro to Bluebeam.pdf® already exists
in ProjectWise.

Dio you want to overwrte. Select "Mo’ to save as a new
filename.

fes Mo J [ Cancel ]

Figure 62 - Overwriting a File

4. If using Projectwise check the document back into Projectwise.
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Section 3 Submitting Documents to CTDOT
Projectwise

The following documents must be submitted into CTDOT’s Projectwise database and attributed
in accordance with this manual.

If two or more projects are being combined into (1) project, all contract documents for these
projects will be submitted into the lowest numbered project in Projectwise.

CONTRACT PLANS (Discipline Subsets):

The CTDOT will consider all digital contract plans submitted to CTDOT as “official” contract
documents; the engineer of record shall not alter these documents unless explicitly asked to by
the CTDOT, and shall only alter what was requested. Consultant engineers submitting changes
that were not requested or submitting requested changes outside the processes in this manual may
be held liable for damages.

Check the following for completeness prior to submitting digital contract plans to the CTDOT.
When submitting preliminary plans only step 1 is required to be performed. All steps shall be
completed in accordance with this manual.

1. Project Manager should obtain the number of discipline subsets and notify each
discipline of their subset number for sheet numbering. FIO subsets shall be last.

2. All pages of the discipline subsets are given a page label and contain a footer
displaying the sheet numbers.

3. All pages of the discipline subsets display a graphic signature of the engineer of
record (watermark) and this watermark is flattened to the PDF document.

4. The first sheet of each discipline subset shall be digitally signed by the engineer(s) of
record, and shall contain a list of drawings contained in that subset. In addition, the
first page of the 01-General subset must contain a list of subsets contained in the
project.

5. All sheets contained in any FIO subsets must be labeled, “For Information Only”

A discipline subset submittal checklist shall be completed and attached to each discipline subset,
see section 3.1.
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CONTRACT SPECIFICATIONS:

The Designer shall submit individual word documents for each specification into Projectwise, see
section 3.2.7. Specifications shall be prepared in accordance with the Departments policies and
procedures for Contract Development. CTDOT Processing shall combine all specifications into
(1) PDF document for the contract.

SUPPLEMENTAL CONTRACT DOCUMENTS:

Supplemental contract documents shall include but not limited to the list below:
e Proposal Estimate, with signed checklist.

Federal Estimate

Calendar Day Estimate

Final Design Report

Categorical Exclusion

Design Approval Letter

Environmental Permits

DBE/SBE Approval with percentage

Commitment list

Agreements

Proprietary Item Approval

Stand alone Transportation Management Plan Document, taken from the final design

report

These documents shall be submitted to CTDOT in PDF format, except the proposal estimate, this
shall be in an “.est” format. If these documents do not need to be digitally signed, they may be
signed and scanned into PDF, however the minimum page size shall be 8.5” x 11” and the
minimum resolution shall be 200 dpi.

ENGINEERING REPORTS
The following final Engineering Reports with their associated data files shall be uploaded into
Projectwise in accordance with section 3.2.

e Hydraulic Report and Hydraulic Report Data

e Scour Report and Scour Report Data

o Floodway Report and Floodway Report Data
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3.1 Discipline Subset Submittal Checklist

The discipline subset submittal checklist shall be used by the engineer as a guide and verification
that all the PDF post processing steps have been completed correctly.

The following link is to the Discipline Subset Submittal Checklist: Discipline Subset Submittal
Checkilist

This checklist shall be completed and attached to all discipline subsets when they are submitted
into Projectwise. This includes FDP, DCD, ADP, ACD, or DCO submittals. Note: The 01-
General is considered a discipline subset.

The following shows how to complete and attach the submittal checklist to each discipline subset,
both normal subsets and standards subsets. A checklist does not need to be completed or
attached to the 02-Revisions Subset:

An instructional video is also available here:
Discipline Subset Submittal Checklist Procedure Video

Normal Discipline Subsets
1. Click on the link above and save the checklist to your computer.
2. Next attach the checklist to the subset as shown below:

E#nE: /| BN D LA B BL | LT RSB oy EECEEE 4~ 4

t AVl LN

f 1. Click on the
Lookin: [ @ Deskiop v ° [ attach document
3 Mame Type 2 i c O n .

A 994 KB @oogle Earth KMZ file
- MpRecent ( 164 KE  PDF Document Tile: |ET_DBR_CPS_ 0118 01636101 |
R Documents _ i " 26 KB Microsaft Word Doc... ) |ca|k|nsm ‘
x 7= E‘_]Cnntractnr Submittals. docs: 22 KB  Microsoft Word Doc... Autiz !
] [ B cT_con_booz_o118-0165_10-Erwiranm. . 1,906 KE  PDF Document Subject | ‘
— Deskion & | Creating a PW Account 1 kKB Internet Shorbcut
_ [B) 13 Copy of 118-240 CO.pdf 132KE  POF Document Project: | |
| @Pro]ecthse Web and \Web view Servers V... Pawerarchiver ZIP File

//' ﬁ FRA TRACK CHART 01-15-13[1].pdf PDF Docurment Revizar: | ‘
ol ﬁ’PrniectWise Web and Web View Servers Y., L ‘Windows Installer P... i
—| My Documents | Frojectwise Error. G 283 KN, IPEG Image -
1 EHRound Table. xlsx icrosoft Excel Wor. . H
= 51’)9 ELRound Tablez013.csv KB rosoft Excel Com... 2' SeIeCt the CheCkIISt
— ¥ |z_’a]dot,roundtable,vatingjorm clinty_data.csyv 1 KB Michgsoft Excel Com,.. 1
— by Computer E_]AEC_DOC_MDO_DPD—\-'Erslon 2,07 Rev., 16 KB Microdgft word Doc... a n d CI IC k 0 pe n to a tta c h
] @EouklZS.xlsx 10KE  MicrosofyExcel Wor., .

— B e e amn memo e e o - . ™

— { < >
. 3 Co 1
_ by Network, File name: |DisciplinE_Subsel_SubmillaI Checklist. pdf V| Open ’

Flaces
- Files of type: | e | Cancel

Figure 63 - Attaching the Submittal Checklist

3. Complete the tasks on the checklist and then type your name and a phone number in the
lines provided.
4. Forward a link to the Engineer of Record for digital signing.
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5. After the discipline subset has been digitally signed, open the discipline subset and apply
the QA/QC stamp as shown below: Note if you cannot place the stamp the discipline
subset was digitally signed incorrectly. If you do not have the stamp as shown below you
must first import the Bluebeam User profile as shown in Appendix A.

2.

1. Click on the
tool chest

Select the QA/QC

stamp in the review

STRUED YO MEAN THAT ALL ASPECTS OF TME DESIGN
Y CHECKED BY THME UNDERSIGNED.

._\_/ Theodore H. Nezames

2013.05.08 08:32:25-

tools

EARS TO CONFORM TO APPLICABLE CRITERIA. APPRuvaL 1>

HAVE

04'00"

ON_PRINCIPAL ENGINEER

3. Place the stamp
in the bottom right
hand corner

ROCKY HILL

PROJECT NO.

118-0163

DRAWING NO

G TITe

NDEX OF DRAWINGS [ ©®

A-001

05.01

Vi CTDO

necticut Department of Transporta

QA/QC lmln it ( hul'\

-y -
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3.2 Projectwise

CTDOT is currently using Bentley’s ProjectWise as a data management software for digital
projects. Projectwise allows the CTDOT, and authorized business partners to access its data
anywhere internet access is available. Projectwise shall be used by all consultant engineers
delivering digital contract documents.

3.2.1 ProjectWise

Consultant engineers may use either Projectwise thin client or Projectwise thick client.

Thin client is a web based version of Projectwise, which does not require any software
installations. All that is required to login to the appropriate webpage is a user name and password
supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet access is
available. The thick client conversely requires the installation of the Projectwise client software.
In addition to performing all the functions of thin client; thick client has the addition
functionality:

- Delta file transfer — Improves speed of downloads
- Managed workspaces — Eliminates the need to install the CTDOT DDE
- Attributing multiple documents at once

Users can get Projectwise Thick Client for free if they have an active license of Microstation.
Download Projectwise Client from Bentley using your select ID. Once Projectwise is installed on
your computer use this document to connect to the datasource:

Connecting to Datasource Using Thick Client

Users can get to our Projectwise Datasource using the following various applications. The table
below lists the server URL for each application:

Applications URL
IPAD ctdot-ws.projectwiseonline.com/pwmobileaccess
Microsoft https://Ctdot-ws.projectwiseonline.com/ws

The following workflow shows how to log in and change your password: Projectwise Log in

If you do not have a Projectwise User name and password fill out the following form:
ProjectWise New User Form

Consultant firms are usually given (2) user names that can be used by the whole firm. More than
one person can use the user name at a time. It is the firm’s responsibility to manage the user
name and password in cases where employees leave and work at another firm. This way the
employee that leaves cannot use their old company’s user name and password.

3.2.2 Projectwise Folders for Contract Documents

This section gives directions on which folder contract documents will be submitted in
Projectwise.

If two or more projects are being combined into (1) project, all contract documents for these
projects will be submitted into the lowest numbered project in Projectwise.

100_Contract Plans (PDF) — This folder contains all Contract Plan Discipline Subsets. This

includes all Final plans, Addendum plans, Design Initiated Change Order, As builts, and FIO
Plans.
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110_Contract Specifications (PDF) — This folder contains the Final, Addendum, and
Construction Order Requests Contract Specifications packages. The designer will NOT submit
Final or Addendum specifications into this folder; they shall submit Final Specifications and
Addendum contract specifications in word format, into the 240_Contract Development folder.
The designer can only submit change order specifications into this folder.

CTDOT finalizes the FDP and Addendum Specification Packages into one PDF file and places
the final package into this folder.

120_Contractor Submittals (PDF) — This folder contains all working and shop drawings
submittals.

130_Engineering Reports — This folder contains all the final engineering reports.

140_GIS - This folder contains the project polygon and parcel polygon files and their associated
kmz files.

210 Construction Folders
e Construction Survey — This folder is still in development.
o Office_Of_Construction — This folder is still in development.

220_FHWA — This folder is used for FHWA documents.
230_Contract Administration — This folder is used by CTDOT Contracts.

240 _Contract Development — Designer shall submit the following supplemental contract
documents into this folder:

o All contract specifications and Notice to Contractors (NTC), in word format, both final
and addendum specifications

Proposal Estimate

Federal Estimate

Calendar Day Estimate

Final Design Report

Categorical Exclusion

Design Approval Letter

Environmental Permits

DBE/SBE Approval with percentage

Commitment list

Agreements

Proprietary Item Approval

Standalone Transportation Management Plan Document, taken from the final design
report

310_Review_Documents — The designer shall submit all non-final design documents into this
folder. This includes plans, specifications, reports, estimates, Property Maps (pdf), etc.

320_Permit_Applications — This folder is still in development.

330_Design_Data — Under this folder is a folder for each discipline that is used for all their
design documents.

340_Administration — The lead designer shall upload the following documents into this folder:
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e A 2-D Microstation file that contains a polygon showing the project limits.

500_Pre_Design Folders
01_Planning — This folder is still in development.
02_Concepts — This folder is still in development.
03_Central_Surveys — This folder is still in development.
04_District_Surveys — This folder is still in development.
05_Property_Maps - CTDOT or Consultant Surveyors shall upload the following files
into this folder:
o Polygon ROW Parcel Microstation File (.dgn) for each affected parcel on a
project.
o Property Map (.dgn)
o Final Property Map (pdf)

3.2.3 Uploading Documents - ProjectWise (Thin
Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.
1. Once logged into Projectwise browse out to project and folder you need to upload into.
Then go to View>Interfaces and select the “CTDOT Doc_Code” Interface.
2. Next select Document>New as shown below:

1ced search options

ctdot.projectwiseonline.com:CTDOT e@\ew Tools Help
A

=
Documents ( & )
B T 01.0 - Projects - Active . Upload...
| Lal :scription Main Category Sub Category
] - 0004-0116 & 0004-0118 =
29 O tle Sheet CON FPL
B T o0004-0133 -
&8 O vision sheet CON FPL
100_Contract_Plans (PDF) =
[} < Ipporting documents CON FPL
— Do
110_Contract_Specifications {PDF)
—
_ O :molition sheets CON FPL
120_Contractor_Submittals (PDF) |
-
_ m} vil sheets CON FPL
130_Engineering_Reports =
— .
_ O zchanical sheets CON FPL
B 210_Construction -
— . —
O actrical sheets CON FPL

220_FHWA

Figure 65 - Uploading Document into Projectwise (Thin Client)
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3. Next browse out to the document you want to upload. Then assign the applicable
attributes from the tables in Appendix E: If you cannot assign attributes, the interface

was not selected as detailed in step 1 or this section.
Path 31\100_Contract_Plans (PDF)

Browse out to
the file you want
Attach a file to upload

File Name | |

El File

Browse... |

N

Bl Attributes
Discipline
Select these —(—» e
Main Category Main Category Description
attributes v T | |
Sub Category Sub Category Description

FDP [~ ] | |
Project Number(s)

0110151

Type in these . . Label (User Defined)

:
attributes D:jcrip;m -

Title Sheet and detailed estimate sheets

CT Code (AUto P Iny

Select the | '
\ﬂ CTDOT Asset Tags
Bridges Sign Structures

applicable
asset tags 01234; 02156 =] 2000123004 ]
Signal Intersections

| =

C"Ck —. Cancel

Figure 66 - Thin Client Attributes
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3.2.4 Uploading Documents - Projectwise (Thick
Client)

The following shows how to upload Contract plans into the 100 Contract Plan folder in
Projectwise, but this procedure can be followed for uploading documents into any folder in
Projectwise.

1. Select the Interface “CTDOT_Doc_Code” as shown below, if the interface box is not
shown go to View>Toolbars and select interface.
2. Drag and Drop files into the correct folder in the Project.

- B|5 =@
@4 - | Search (O ~| | ((interface | CTDOT Doc_Code v
Address pw:\ctdot. projectwiseonline,com: CTDOT\Documents\01 - CTDOT Projects0310_p0624100_Contrget_Plans (PODF)\

= | ¥ ConnDOT (mjc-admin) - List | Geospatial

=" Documents
5 [ 01- CTDOT Projects Label {User Defined)

(% 0015_0335 /EDI.DI-GEnera\

[** 0017_0183 #"7)01.02 Revisions

% 0034_0334 # "2 01.03-5tation_Plans

[* 0040_0136 A" 01,04Environmental .

(%% 0056_0309 ZTorosamirak Force (1) MaKe sure the interface
(1% D063_0543 & 0083_0180 #T)CT0oT Hgtway SO j§ "CTDOT Doc Code"

1% 0o63_08672 # ") CTDOT Traffic_STD - -

L% 0079_0230

[ 0082_0299

[ 0084_0106

[1* 0088_0178 & 0093_0186
[ 0092_0531-0622-0627
[** 0092_n532

| 0092_0818

| o092_0534

|/ 0092_0833

L,: 0107_0158 | (2) Select Project folder and
D5 o110 o1z then 100_Contract Plans
{2 0138_0221 /7| folder

% 0133_0232
[ 0150-0126
[ 0152 0148
|/ n158_0207
[ 0166_009%
[** 0170_2296
| 0300_0138
{* 0301_0059 o
{1 0301_0106 (3) Drag and drop discipline
M
/% 0301_0125 subsets
|/ 0301_0140
{1 0310_0033%
|/ 0310_0056
[ 0310_0057
[** 0310_0058
[ 0310_005%
*£ 0310 Q060
=L 0310 005
100_Contract_Plans (PDF)
110_Contract_Spedifications (PDF)
120_Contractor_Submittals (PDF)
130_Soil_Archaeological_Misc_Reports (PDF)
210_Construction
220_FHWA
230_Contract_Administration
240_Contract_Development
241_Contract_Development_Confidential
310_Preliminary_Design_Documents{PDF)
320_Permit_Applications <
330_Design_Data

HEE

=3}

HEHHHEHHHEE

=

Figure 67 - Uploading Into Projectwise (Thick Client)
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Select the “Advanced Wizard”

ok w

Click “Next” until you reach the figure below:
Then assign the applicable attributes from the tables in Appendix E: If you cannot assign

attributes, the interface was not selected as detailed in step 1 or this section.

Advanced Document Creation Wizard

Define Document Attributes
*'ou should define environment specific docurment attributes

Discipline
cT -
Main Categary

Main Category Description

Jcon
Sub Category

ICDnlract Flans & Specs
Sub Category Descri

=

ption

Project Mumber{s)

IF'Ians_D2 - Final Design Plans

I 0004-0116_0004-0118

Label (User Defined)

ID‘I -General VI
Description

Title Sheet and Detailed Estimate Sheets

CT Code (auto Fill In;

|CT_CON_FDP_0004-0116_0004-0118_01-General

Select these
attributes

Type in these
attributes

CTDOT Asset Tags
Bridges
| 01456; 011654 J

Signal Intersections

I [

Sign Structures

4+ Select the correct

Po010:20156

asset tags

Click Next

__-—-"-
ancel |

< Back ‘l Mext D
T —

Figure 68 - Attributing (Thick Client)

o

On the Document Properties page nothing needs to be edited.

7. On the create document page click next and the document will be uploaded into

Projectwise.

8. Once the document is uploaded the user may need to click F5 (refresh) to see the file

name update.
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3.2.5 Combining and Uploading Contract
Specifications and CSI Special Provisions

For projects that are led by a consultant designer, FDP and Addendum Contract specifications
and CSI Special Provisions shall be placed in (1) zipped folder. For projects that are led by a
CTDOT design unit, FDP and Addendum Contract specifications and CSI Special Provisions
shall be placed in individual zipped folders per discipline.

Addendum specifications shall be placed in (1) zipped folder and submitted into the 240 Contract
Development Folder. Each page of the specification section shall be marked in the bottom right
corner of the footer with “Addendum No. Y”, where “Y” equals the addendum number.

Design Initiated Change Orders specifications shall be placed in (1) PDF document and uploaded
into the 110_Contract Specifications folder. Each page of the specification shall have a “C#” and
the date in the bottom right corner of the footer. An example would be, “C1 - 01/01/13”.

The following shows an example of a consultant designed project, but the process shall also be
followed for a CTDOT designed project.

See the figures below for how to zip a folder:
1. Place all specifications (word documents) in one folder.
2. Right click on the folder and select “Compress to” option shown below:

Open
Browse With Paint Shop Pro 7
Command Prompt Here
Explore
Search...

& Snaglt

i Combine supported files in Acrobat...
ClipPath

Scan for Viruses. ..

T COMDLECE e
g ———
1C Compress to "310-056-57_FDP_SPecs.zip”
e

Send To

Cut
Caopy

Create Shortout
Delete
Rename

Properties
——

310-056-57_F
DP_SPecs

Figure 69 - Compress Spec. Folder

Specifications shall be submitted in a zipped folder for every submittal into Projectwise.
Submittals include FDP, revised FDP specifications, Addendum specifications, and revised
addendum specifications. Revised FDP and addendum submissions shall only include the revised
specifications.
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Submitting Contract Specifications
Once logged into Projectwise the final contract specifications shall be submitted as follows:
1. Make sure the Interface “CTDOT_Doc_Code” is selected.
2. Drag and Drop the zipped specifications folder into the 240_Contract Development
Folder or the pdf of the change order specs into the 110_Contract Specifications folder.
4. Use the advanced wizard and then assign the applicable attributes from the tables in
Appendix E: If you cannot assign attributes, the interface was not selected as detailed in
step 1 or this section.
3. Click next until the document is uploaded. The document name and file name will be
automatically updated to match the CTCode when Projectwise is refreshed.

3.2.6 Uploading Supplemental Contract Documents

Once logged into Projectwise, the Final Design Supplemental Contract Documents shall be
submitted and attributed into the 240 _Contract Development folder as follows:

1. Make sure the Interface “CTDOT_Doc_Code” is selected.

2. Drag and Drop the document into the 240 _Contract Development Folder.

5. Use the advanced wizard and then assign the applicable attributes from the tables in
Appendix E: If you cannot assign attributes, the interface was not selected as detailed in

step 1 or this section.
3. Click next until the document is uploaded. The document name and file name will be

automatically updated to match the CTCode when Projectwise is refreshed.

If a supplemental document is revised, a new revised document shall be uploaded into
projectwise with the addition of “Revised” being included in the Label.

The document name and file name will automatically update to match the CTCode when
Projectwise is refreshed.

3.2.7 CTDOT Contracts Finalizing of Contract
Specifications

CTDOT Contracts shall finalize the specifications working in the 110_Contracts_Specifications
Folder following this workflow CTDOT Contracts Workflow.

3.2.8 Notification of Submittals

When Contract Plans, Specifications, and supplemental contract documents are submitted into
Projectwise the applicable personnel must be notified as follows as applicable:

1. For consultant designed projects, the consultant will notify their Liaison Engineer, who
will then notify, by memorandum, processing that contract plans or specifications have
been submitted for review.

2. For state design projects, the project manager will notify, by memorandum, processing
that contract plans and specifications have been submitted.
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3.2.9 Contract Plans Workflow (FDP - Advertise)

Table 3-3 below shows how final digital design plans (FDP) flow from delivery through
processing to their final state in advertising.
Processing personnel shall use the following workflow: Projectwise for Processing

Final Design Submission (Subsets)

Step Group Responsibilities of Group
1 Designer | -Submits FDP subsets into the 100_Contract Plans folder.
Processing . - .
(CTDOT) - Change FDP subsets to the Processing State and digitally mark up with comments and save FDP plans. Keep FDP
Plans in the Processing State. If there are no comments proceed to step 7.
2
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.
- Change subsets to reflect comments made by Processing
3 Designer
- Submits DCD subsets
) - Change DCD subsets to Processing state
Processing
(CTDOT) | - perform a document compare on the FDP and DCD plans using Bluebeam.
© - Digitally markup DCD subsets with comments and save. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.
- Change subsets to reflect comments made by Processing on DCD Plans
5 Designer
- Submits DCD2 subsets
- Changes DCD?2 subsets to Processing state
Processing
(CTDOT) | - Perform a document compare on the DCD and DCD2 plans using Bluebeam.
g - Digitally markup DCD2 subsets with comments. If there are no comments proceed to step 7.
- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder.
- Change the Sub Category Attribute of the approved subset from FDP or DCD(1,2..etc.) plans to FPL plans. STD and
Processing | FIO plans shall not be change to FPL.
(CTDOT)
- Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a “.pdf” on the
end.
-If is a CTDOT Design project, change all discipline subsets to the Manager and Engineering Admin. Sign State. Notify
Designer they have to have Manager and Engineering Admin sign the title sheet. When the Designer notifies processing
7 these signatures have been applied to the title sheet, change all discipline subsets to the Advertise state.

-If is a Consultant Designed Project, change discipline subsets to Advertise State.
-Delete all previous versions of plans, FDP, DCD, DCD2, etc.
-Keep Comment reports in the 240_Contract_Development folder for records if necessary

-Formally notify Contracts when all subset have been approved for Advertising

Table 3-1 Workflow for CTDOT Processing Unit (Contract Drawings)
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3.2.10 ProjectWise Project folder Security

Through the use of Workflows and States, Projectwise can provide dynamic securities to a folder
or document. Dynamic security allows a different level of security to each document at various
phases of its life cycle. This allows a document to reside in one location, in Projectwise,
throughout the project life cycle.

3.2.11 100_Contract_Plans (PDF) Folder
(Dynamic Security)
During the design submittal process the Projectwise workflow, “Contract Plans Processing”, shall
be applied to this folder. This workflow allows three different states (securities settings) to be
applied to documents within this folder. Each state provides a unique security. The CTDOT
Contracts Processing Unit shall determine which state a document in this folder shall be in.
The “Contract Plans Processing” workflow contains the following security states:

Document Transfer State — allows either the Consultant or State Designer to upload, read and
alter a document.

Processing State — Allows only the processing unit read, write access, allowing them to review
the documents in a secluded area. All other users shall have read access.

Manager and Engineering Admin. Sign — Allows the Manager and Engineering Administrator
to sign the project Title sheet.

Advertise State - Allows all users file read access, allowing any user to open and read the
document.

Once the contract is awarded to the low bidder (Contractor), the documents will move into a new
workflow called “Contract Plans Construction” which hands control of the documents to the
CTDOT Office of Construction (all offices).

The “Contract Plans Construction” workflow contains the following security states:

Construction State — allows construction to upload, read and alter a document. All other users
shall only have file read.

Perform As-Built — allows construction to place as-built information on the plans. All other
users shall only have file read.

As-Built Complete — All users will have read only when the documents are put in this state.
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3.2.12 Changing the State of a Document

The designer and district construction will be required to change the state of documents for
contractor submittals during the review process. To change the state of a document, follow the
figure below:
1. Right click on the document that you want to change the state of, then select change
state>change, as shown below:

ctWise Explorer Vi SEries 4
Folder Document Yiew Tools Window Help
% | &by 2y T b @ i g4 - SearchL&Q V|D Interface|C[DOT_Doc_code v| View|Document
a pw:wctdot.projectwiseonline.com: CTDOT\Documents'01.0 - Projects - Active’\0085-0141°100_Contract_Plans [F % | D Go
- B
™ oos7-0117 ”~ i Descripkion

[™ nosa-0325
™ o0s9-0157
/™ nos0-0151

o3+l open

" 0063-0601 & 0063-0674 E

L'?i 7 Blod s Open as Read-Cnly set

™ o0s3-0521 | _
= ZBos Open With...

™ ooe3-0837

™ 0083-0839 / Blos_a Markup Flan

™ 0083-0541 & 0083-0671 j E CTDd View | 0085-0141_CTOOT_Highway_STD
e - y [minls FIC_sTD

™ 0083-0643 & 0093-0180 chack Oout

™ 0083-0544

R el

Right Click on e
a document and pat
select "Change State"
then "Change

B 2 e e R e R

Start Studio Session.,,

™ o0s1-00858 Refresh Local Copy
™ oos1-0091 Purge Local Copy
L,R 0052-0299 Purge Warkspace

[*% 0033-0253
=-[* ooss-0141
{7 100_Contract_Plans (PDF)

Cuk
S Copy

| 110_Contract_Specifications (POF) Document Pr Phota Preview | Dependency Service | Access Contral | Cor
L= 120_Contractor_Submitkals {PDF) =] Copy Ton..
L% 1SD_SoiI_Archa.eologicaI_Misc_Reports (PDF GEnERAL  Move To..
L= 210_Construction
- GEMERAL| Rename..
L 220_FHWA
: inistr i GENERAL| Delets
| 230_Contract_Administration Modi
T 240_Contract_Develapment GEMERAL I d'Fyg tial Attribt
L 241_Contract_Development_Confidential GEMERAL odiny spatial Atributes. ..
' 310_Preliminary_Design_Documents{PDF) GEMERAL Add Cammerit
L 320_Permit_Applications GEMERALN  set N
By Soo-peckn.bets ASSETS - | SendTo v
L 340_Admininstation ;
- ASSETS Copy List To 4
L 341 _Confidential_Administration ' ) R

I Soiscuce e R > -+
¥ Saved Searches ASSETS - .

%% ooss-0142 Design-P¢  gatch print
[** nogs-0177 Design - Py -
L,: 0085-0178 & 0093-0166 Design - Py "roperties... Set Final Status
L'R gg:g'gigz Design -Pr Change filename ko CT_Code
= - Design - C
ign - Co
[*% nogz-0522 Desian - FT Edit attributes for multiple documents
L,N 0092-0531 & 0092-0622 & 0092-0627 o .g D (Core G OCD
L'pg 0092-0532 es!gn - [Core Constr ]
I.-N 0092-0541 Dresign - A0% [Core Constr ADY]
™% 0092-0549 Diesign - Digitally Signed

Figure 70 - Changing the State
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2. Next drag the file(s) from one state to another as shown below:

*= Change Workflow State

Change state

Foldzr
Marme: 100_Contract_Plans (PDF)
Description:  FDP,DCD,FP, Addenda, and Construction Order Plans

Warkflow
Name: Contract Plans - Construction
Description:  Dynarmic Security {Post Award of Conkract)

Documents in States

=] % Contract Plans - Construction

] Select a file or all
the files and drag
them to the desired
state

Close

Figure 71 - Changing the State

3. Click OK when the comment window opens up and the documents state will change.
Next close the change workflow state window.
4. Notice the “State” column, the state of the documents has been changed.

A { Label (User Defined) Description Main Category | Sub Categary Sub Category Description Application State Fie Size  Out to
/ Bloi_seneral 01_General CON FOP Plans_02 - Final Desian Plans Acrobat POF PERFORM AS_BLILT 925 KB
7 Bloz_Revisions Revisions Subset: <ON FLR Flans_02 - Final Design Flans Acrobat FOF FERFORM AS_BUILT 339 KE
7 Blosighway 03-Hghway CON FOP Plans_02 - Final Design Plans Acrobat POF PERFORM AS_BUILT 1,448 KB
o/ Blo4_structures Structusl Subset CON FOP Plans_02 - Final Desian Plans Acrobat POF PERFORM AS_BUILT 1,559 KB
7 B o5 _Traffic 05-TRAFFIC <on FOR Flans_02 - Final Design Plans Acrobat FOF FERFORM AS_BUILT 1,620KB
7 Blos_ater_Fio ATET_Utlty_Plan CON FIO Plans_11 - For Infe, Only Divg, Acrobat POF PERFORM AS_BUILT ZI5KE
o/ B CToOT Highway_STD CT_CON_STD_DD85-0141_CTDOT Highway_STD CON sTD Plans_10 - Standard Drawings Acrobat POF PERFORM AS_BUILT 2,012 KB

/B CTOOT_TRAFFIE_STD CTDOT_TRAFFIC_STD CON SO Plans_10 - Standard Drawings Acrobat POF PERFORM AS_BLILT 3,34 KB

Figure 72 - State has been changed

3.2.13 Paper Plan Order Form

The Paper Plan Order Form was created to allow each unit in the Department to order contract
plans and specifications for DOT Projects. This form is located in each project in Projectwise
and each unit in the Department that needs paper copies of contract plans and specifications is
required to update this form for their paper needs. This form is then used by the Department’s
Engineering Records unit to make the prints and send them out.

Any Addendum or Change Order that is submitted for a project will be printed and sent out using
the information indicated on the form. Addendums will be printed and sent out automatically.
When a Change Order is submitted, the designer must notify Engineering records that a Change
Order has been submitted and that paper copies of the Change Order need to printed and sent to
the applicable units indicated on the Paper Plan Order Form.
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This following shows the procedure for how the Paper Plan Order Form is filled out and the
prints are made.

Contact Information for Engineering Records:

Pascone Place: 860-666-6107 Plan Printing
Print Shop: 860-594-3086 Specification Printing

Step

Project

Stage/Submittals

Group

Action

FDP

Processing

After the contract plans and specifications have
been submitted for FDP an email is sent to each
unit in the Department that requires paper copies
of contract plans and specifications.

FDP

Units

Open the Paper Plan Order Form from Projectwise
and fill out the form for their unit’s needs. Save
the form and check the form back into Projectwise.

DCD

Processing

At DCD, lock the form by placing it in the
Processing state.

Advertise

Contracts

Notify Pascone place and the print shop that the
project is going to be advertised and they can print
the required paper copies indicated on the Paper
Plan Order Form.

Advertise

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form.

All Addendums

Contracts

Notify Pascone place and the print shop that an
Addendum is going to be advertised and they can
print the required paper copies indicated on the
Paper Plan Order Form for this Addendum. Make
sure to tell Engineering Records which subsets are
included in the Addendum.

All Addendums

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form for the Addendum. Make
sure to print all the subset that were affected by the
Addendum including the 02-Revisions subset.

All Change
Orders

Lead Designer

Option 1 - Notify Pascone place and the print shop
that a Change Order has been submitted and they
can print the required paper copies indicated on the
Paper Plan Order Form. Make sure to tell
Engineering Records which subsets are included in
the Change Order. If a unit is not listed on the
Paper Plan Order Form, give Engineer Records
those units’ contact information so those units’ can
receive a copy of the Change Order.

All Change
Orders

Engineering
Records

Print the required paper copies indicated on the
Paper Plan Order Form for the Change Order and
for any other units’ requested by the Lead
Designer. Make sure to print all the subsets that
were affected by the Change Order including the
02-Revisions subset.
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Section 4 Contract Plan and Specification
Revisions (Addenda and Design Initiated
Change Order)

4.1 Addenda

Contract plans that are revised or added due to addenda shall be submitted in digitally signed PDF
discipline subsets containing only the changed sheets. The sheets being revised or deleted shall
not be included in the Addenda submittal. The first sheet of each addendum subsets shall be
digitally signed in a digital signature place holder, that is placed in Microstation as described in
Section 2.0 of this manual, DO NOT ADD an index of drawings sheet. Once digitally signed,
the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section
3.0 of this manual.

Addenda sheets from different subsets cannot be combined and submitted as one subset, they
must be submitted per their respected subsets.

The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise
(See Section 3.0): The addenda subset shall have the same label as the original final plan subset
with the addition of (_A##) added to the end, where the ## equals the addenda number. The sub-
category attribute shall be ADP and ACD if the ADP plans are revised. See example below:
PROJECTWISE LABEL ATTRIBUTE

Original Discipline Subset: 04-Traffic

Addenda Discipline Subset: 04-Traffic_A01
2nd Addenda 04-Traffic_A02
6th Addenda 04-Traffic_A06

The contract sheets (previously submitted final plans or earlier addenda plans), being revised by
addenda shall NOT be modified except; the Engineer of Record shall place an addenda stamp on
the affected sheets. This addenda stamp crosses out the entire sheet with a red X and adds the
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the
addendum number. This stamp is placed over digital signatures therefore; removal of the
signatures is not required prior to placing the addenda stamp. For this process see Section 4.4.

WARNING — When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the
project manager for all addenda, and submitted as described in Section 4.3.1. A new subset must
be updated for each addendum.

A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for
(Consultants) shall be placed on all added or revised sheets. See Section 2.2

Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent to
all applicable units following section 3.2.13.
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4.1.1 Revised Plans - Addenda

Microstation Processes

A note shall be placed, directly above the bottom right hand corner of the title block, on the
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number.
This note is a level in Microstation that needs to be turned on and edited.

For revised sheets the drawing numbers shall not be modified.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed within this clouded area. A like numbered triangle shall be placed in the revision block of
the changed sheet, accompanied by a description of the revision itself. The revision number is
specific to a particular sheet, and increases in consecutive order per revision and per addenda. If a
sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is
changed again under addenda 7 the revision number becomes 2.

Note: If there are a lot of changes to a sheet, do not void out the existing sheet and create a
new sheet by following section 4.1.2. The revised addenda sheet be clouded just inside the
border and have sheet numbers applied in accordance with this section.

Note: When preparing an Addendum that will change quantities on a project that includes a
"Detailed Estimate Sheet"”, never revise the "Detailed Estimate Sheet.” A "Detailed Estimate
Sheet" is never included in an addendum. Also, the "Quantities" box shown on the General Plan
sheet for any structure is never to be revised.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
Original Final Plan Sheet;

Original: 02.25

Addenda 1: 02.25.A1
Previous Addenda Sheet;

Original: 02.25.A2

Addenda 4: 02.25.A4

If a sheet requires further revisions by a subsequent addendum, the addendum shall be prepared,
as detailed above. The previously revised sheet shall now be stamped using Bluebeam after
addendum approval, see Section 4.4.

4.1.2 New Sheets - Addenda

Microstation Processes
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one of
two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within the discipline
subset, the new sheet shall be placed last, and numbered sequentially from the last sheet
of the discipline subset. The total number of sheets noted on the project plans and
discipline subsets stays the same. A note shall be placed on the new sheet stating, "NEW
SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.
This note shall be located directly above the right hand corner of the title block. This
note is a level in Microstation that needs to be turned on and edited. The revision block
on the added sheet, shall not be filled out.

2. If the designer determines that the new sheet must go in a specific location within the
discipline subset, the new sheet number shall be the number of the previous sheet
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followed by (-1.A#), where # is the Addendum Number. For example, if the new sheet
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be
02.57-2.A1. The total number of sheets noted on the project plans stays the same. A
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM
NO."Y", where "Y" equals the addendum number. This note shall be located directly
above the right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. As with the sheet
number the drawing number of the new sheet shall be the drawing number of the
previous sheet plus a decimal and the sheet count. For example, if the new drawing must
be placed in the project plans right after drawing number S-5, the drawing number shall
be S-5-1.

Bluebeam Processes
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
Addenda 3: 04.31-1.A3

Previous Addenda - Added Sheet;

Original: 03.24.A1
Addenda 4: 03.24-1.A4

Previous Addenda - Revised Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-1.A2

Previous Addenda - Added Sheet;

Original: 05.14-1.A1
Addenda 2: 05.14-2.A2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus .A#, where # equals the addenda number.

Original Final Plan Sheet;

Original Last Sheet: 04.31
Addenda 3: 04.32.A3

4.1.3 Adding New Subset - Addenda

The new subset shall be submitted by an Addendum and be prepared the same way as an FDP
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed,
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. This note is a
level in Microstation that needs to be turned on and edited. The label attribute on the new subset
shall contain an “_A##”. The first sheet of a new subset to the contract will be a subset cover
sheet and contain an index of drawings.
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4.1.4 Voiding Sheets

Sheets submitted within final design plan subsets and addenda subsets shall NOT be deleted; but
shall voided by the engineer of record with an addenda stamp, using Bluebeam. This addenda
stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED BY

ADDENDUM NO.”Y"; where "Y" equals the addendum number. See Section 4.4

4.1.5 Addenda Plans Workflow

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings below shows how
addenda subsets are delivered and processed for advertisement.

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings

Addendum Plans

Step

Group

Responsibilities of Group

Designer

-Submits ADP subsets into the 100_Contract Plans folder.

Processing
(CTDOT)

- Changes document to the Processing State and digitally mark up with comments and save. Keep ADP Plans in the
Processing State. If there are no comments proceed to step 7.

- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.

Designer

- Change subsets to reflect comments made by Processing

- Submits ACD Subsets

Processing
(CTDOT)

- Changes ACD subsets to Processing state
- Perform a document compare on the ADP and ACD plans using Bluebeam.
- Digitally markup ACD subsets with comments. If there are no comments proceed to step 7.

- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.

Designer

- Change subsets to reflect comments made by Processing on ACD Plans

- Submits ACD2 Subsets.

Processing
(CTDOT)

- Change ACD2 Subsets to Processing state
- Perform a document compare on the ACD and ACD2 plans using Bluebeam.
- Digitally markup ACD2 subsets with comments. If there are no comments proceed to step 7.

- Create a comment report of these comments and save on your computers desktop. Then upload and attribute this
report correctly into the 240_Contract_Development folder. Notify the designer when this is finished.

Processing
(CTDOT)

- Change the Sub Category Attribute of the approved subset from ACD(1,2..etc.) plans to ADP plans

- Copy the CTCode and make the document and file name the CTCode. Make sure the file name has a “.pdf” on the
end.

- Change discipline subsets to the Advertise State.

-Delete all previous versions of plans, ADP, ACD, ACD2, etc.

-Keep Comment reports in 240 _Contract_Development folder for records if necessary
- Formally notify Contracts when all subset have been approved for Advertising

- Notify the designer that the plans are going to be advertised and they can put the addenda stamps on the affected
sheets.
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4.1.6 Addenda Specifications

Contract Specifications that are revised or added due to addenda shall be submitted digitally in
accordance with section 3.2.5.

4.1.7 Addenda Report

Addenda report shall contain all the changes to the plans and specifications and any contractor
guestions and answers. This report shall be submitted in Word format into the
240_Contract_Development in Projectwise with the following attributes:

Discipline=CT

Main Category = DOC

Sub Category = RPT

Label = “Addn. No. # Report”, where # is the addendum number. If a report is revised the label
shall include “Rev.” at the end. If the report is revised a second time the label shall include “Rev.
2” at the end, etc.

Description = Give a brief description of the submission.

4.1.8 Addendum CTDOT Standard Drawing Subsets

The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance
with the following.

The Addendum for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow section 1.8 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise, add an “A##” to the end of the label attribute.

Update the 02-Revision subset to record this change.

4.2 Design Initiated Change Order (DCO)

Design Initiated Change Orders (DCO) are change order requests in which the designer alters the
original contract by:

e A revision to an existing plan sheet(s) or specification(s)

e The addition of a new plan sheet(s) or specification(s)

o The deletion of an existing plan sheet(s) or specification(s)

The creation and management of DCQO’s shall be as specified in this section.

Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF
discipline subset(s) containing only the added or changed sheets. The sheets being revised or
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset
shall be digitally signed in a digital signature place holder, that is placed in Microstation as
described in Section 2.0 of this manual, DO NOT ADD a cover sheet. Once digitally signed the
DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 3.2
of this manual.

DCO sheets from different subsets cannot be combined and submitted as one subset.

The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See
Section 3.0): The DCO subset shall have the same name as the original final plan subset with the
addition of (_C###) added to the end, where the ### equals the DCO number. The sub-category
attribute shall be DCO (Design Initiated Change Order) See Examples below:
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PROJECTWISE LABEL

Original Discipline Subset: 04-Traffic

DCO Discipline Subset: 04-Traffic_C001
6th DCO 04-Traffic_C006
Original Addenda Subset: 04-Traffic_A03
DCO Discipline Subset: 04-Traffic_C001
3“DCO 04-Traffic_C003

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being
revised by DCO shall NOT be modified except; the Engineer of record shall place a DCO stamp
on the revised sheets using Adobe Acrobat. This digital DCO stamp crosses out the entire sheet
with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITATED
CHANGE ORDER NO."Y" —-mm/dd/yy; where "Y" equals the Design Initiated Change Order
number. This stamp is placed over digital signatures therefore; removal of the signatures is not
required prior to placing stamp. For this process see Section 4.4

WARNING — When placing the stamps, removing the digital signature is not allowed.

The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the
project manager for all DCO, and submitted as described in Section 4.3.2. This includes DCO’s
that affect plan sheets as well as any DCO’s that do not affect the plan sheets. Any DCO that
does not affect a plan sheet shall be recorded on the 02-Revisions set stating, “No Change to
Plans”.

A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for
(Consultants) shall be placed on all DCO sheets. See Section 2.2

Paper copies for all change orders will be requested and sent to all applicable units’ following
section 3.2.13.

4.2.1 Revised Sheets - DCO

Microstation Processes

A note shall be placed, directly above the right hand corner of the title block, on the replacement
sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y”
equals the Design Initiated Change Order number. This note is a level in Microstation that needs
to be turned on and edited.

The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be
placed within this clouded area. A like numbered triangle shall be placed in the revision block of
the changed sheet, accompanied by a description of the revision itself. The revision number is
specific to a particular sheet, and increases in consecutive order per revision and per change to the
sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 revision
number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3.

Any details to be deleted shall be crossed out with an “X” on the revised sheet. Details shown on
the original PDF, but no longer required, shall not be deleted on the revised PDF, but shall be
crossed out. Engineering judgment must be used to produce clear and concise information for the
contractor.

Bluebeam Processes
Sheet numbers for revised plans shall be as follows:
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Original Final Plan Sheet;

Original: 02.25
DCO 1: 02.25.C1
Previous Addenda Sheet;
Original: 02.25.A2
DCO 4: 02.25.C4

Previous DCO Sheet;

Original: 02.25.C2
DCO 4: 02.25.C4

Drawing numbers shall not be modified on revised sheets.

Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 2
of this document.

4.2.2 New Sheets - DCO

Microstation Processes
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one of
two ways, as follows:

1. If the new sheet does not have to be placed in a specific location within a discipline
subset, the new sheet shall be numbered sequentially from the last sheet of the discipline
subset. The total number of sheets noted on the project plans and discipline subsets stays
the same. A note shall be placed on the new sheet stating, “NEW SHEET ADDED BY
DESIGN INITIATED CHANGE ORDER NO. Y — mm/dd/yy” where “mm/dd/yy”
equals the month, day and year the change order request was submitted. This note shall
be located directly above the title block. This note is a level in Microstation that needs to
be turned on and edited.

2. If the designer determines that the new sheet belongs in a specific location within a
discipline subset, the new sheet number shall be the number of the sheet it most closely
relates to followed by (-1.C#). For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet
shall be numbered 03.57-1.C#.

The total number of sheets noted on the project plans stays the same. A note shall be
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED
CHANGE ORDER NO. Y — mm/dd/yy” where “mm/dd/yy” equals the month, day and
year the change order request was submitted. This note shall be located directly above
the bottom right hand corner of the title block. This note is a level in Microstation that
needs to be turned on and edited.

When adding a new sheet a new drawing number is also required. The drawing number
of the new sheet shall be the drawing number of the sheet it most closely relates to
followed by (-#). For example, if the new drawing must be placed in the project plans
right after drawing number HWY-10, the drawing number shall be HWY-10-1.
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Bluebeam Processes
Added sheet numbers, to a specific location, shall be as follows:

Original Final Plan Sheet;

Original: 04.31
DCO 3: 04.31-1.C3
Previous Addenda — Added Sheet;
Original: 03.24.A1
DCO 4: 03.24-1.C4

Previous DCO — Revised Sheet;

Original: 02.45.C1
DCO 2: 02.45.C2
Previous Addenda - Added Sheet;
Original: 05.14-1A1
DCO 2: 05.14-2.C2
Previous DCO — Added Sheet;
Original: 02.45-1.C1
DCO 2: 02.45-2.C2

If adding sheets to the end of a subset, the new sheet number shall be a continuation of the
previous sheet number plus C#., where # equals the Design Initiated Change Order Request
number.

Original Final Sheet

Original Last Sheet: 04.35
DCO 4: 04.36.C4

4.2.3 New Subset - DCO

The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline
subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly above
the right hand corner of the title block, on the replacement sheets stating “NEW SHEET ADDED
BY DESIGN INITIATED CHANGE ORDER NO. “Y” — mm/dd/yy, where “Y” equals the
Design Initiated Change Order number. This note is a level in Microstation that needs to be
turned on and edited. The label attribute shall contain “ C##”. The first sheet of a new subset to
the contract will be a subset cover sheet and contain an index of drawings.

4.2.4 VVoided Sheets

Sheets submitted within final design plan subsets, addenda subsets, or design initiated change
order subsets shall NOT be deleted; but shall be voided by the engineer of record, with a DCO
stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a red
X and adds the following note; "VOIDED BY DESIGN INTIATED CHANGE ORDER NO. Y —
mm/dd/yy; where "Y" equals the Design Initiated Change Order number. See Section 4.4

4.2.5 DCO Specifications

Specifications shall be created in accordance with the Departments policies and procedures for
Contract Development. The Engineer shall also combine all specifications into (1) PDF
document and upload that into the 110_Contract Specifications (PDF) folder in Projectwise
following section 3.2.5.
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4.2.6 DCO CTDOT Standard Sheet Subsets

The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the
following.

The DCO for a standard subset shall only include the added sheets, do not include all the
standards for the project. Follow section 1.8 to prepare the standard subset, only include the
added sheets and check off only those sheets on the index sheets.

When uploading to Projectwise add an “C##” to the end of the label attribute.

Update the 02-Revision Subset to record this change.

4.3 02-Revisions Subset

The project manager is responsible for managing this subset. The subset can be downloaded from
these links:

CTDOT Designed Projects - 02-Revisions Subset

Consultant Designed Projects - 02-Revisions CE_Subset
Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions
Sheet(s)”. These revision sheets are used for tracking all sheet changes due to addenda (ADP)
and Design Initiated Change Order (DCO) with respect to the entire project. The 02-Revisions
subset starts out as an un-signed blank place holder in the project. The figure below is an

example of a blank 02-Revisions subset:

[REV REV] DATE P [REV DATE |Z 2|2
| SHEET Mo, gz DESERIPTION 8 (| SHEET wo. | DATE z DESCRIPTION or Y| seeeT o | O [ E|E |8

o i
...... HHE B

REY

DESCRIPTION

BY

& T i REHABILITATION OF ™ TOLLAND
OFFICE OF ENGINEERING BRIDGE NO. D0B40
STATE OF CONNECTICUT JER (DRF 00880}

DEPARTMENT OF TATION o SHEET

Figure 73 - Blank 02-Revisions Subset
ADDENDA:

When the project requires an Addendum, the Project Manager must record these changes on a
NEW 02-Revisions_A## subset, where A## equals the Addendum ##. New 02-Revisions
subsets shall contain all previous Addendum information. For example, Addendum 4 shall
include all changes made from Addendums 1, 2, 3 and 4.
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Note: A New 02-Revisions subset is required for each addendum because there are times when

multiple addendums are being submitted to processing for the same project. An example of this
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two addendum
revision sheets must be submitted.

DESIGN INITIATED CHANGE ORDER:

When a project requires a Design Initiated Change Order (DCO), the following process shall be

followed:

For each DCO, the Project Manager shall AMMEND the 02-Revisions subset. The 02-Revision
subset shall always contain all previous Addendum information and the new DCO information.
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum
information as well as the changes made for DCO #1.

The following figures are an example of the “Index of Revisions Sheet(s)” completed up to
Addendum #3:
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Figure 74 - Index of Revisions Sheet

Detail A from figure 1 shows the information typed in for a change to the contract plans. The
project designer inputs the Addendum or DCO number, the sheet number, the date, a description
of the change, the person who made the change, and checks the appropriate box for: new sheet
added, revised sheet or deleted sheet.
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Figure 75 - Detail A
Detail B from figure 1 shows the title block information.
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LETETED DRAWINGS JES A3 | 04.09.07B.A3 02/15/11 ¥ EDIT DIMENSION JES
D NOTE 3 JES A3 | 04.09.080.A3 02/15/11 ¥ EDIT DIMENSION JES
LETE DEMONSTRATION SHAFT, EDIT CALLOUT JES A3 | 04.09.083.A3 02/15/11 ¥ EDIT DIMENSION LOCATION JES

DETAIL B

ADDENDUM NO. 3

T - ] ' STARTFORD/MILFORD 138-221
RECONSTRUCTION OF THE "REV-1
MOSES WHEELER BRIDGE ' " REVISIONS
m.nz.nm_,:_s__
_-—-—'—-.___ __-----_

Figure 76 - Detail B

4.3.1 02_Revisions Subset Workflow - Addenda

Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project

Manager as follows:

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their
local computer.

2. With your digital signature USB key inserted within the USB, right click on the Signature
Box and select Clear Signature as shown below, this is the first Addendum this step can
be skipped since the subset will not have a signature on it:

RTATION

/

s
PROJECT 1

/ LT TIT7

Clear Signature

yalidate Signature

Yiew Signed Wersion

RB-01.dgn

Legal Notice. ..

Show Signature Properties.

s

Compare Signed Yersion to Current Yersion

e

tin <

Figu're 77 Clearihg the Digitai Signature '

3. Enter the information into form fields as described in section 4.3.4,

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the
title block, where Y = the Addendum number.
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5. Add new revision sheet each time previous sheet becomes full. Add note “NEW SHEET
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number. Follow
section 4.3.3 of this document.

6. When finished sign using a certifying signature as shown in Section 2.6.2

7. Upload the document into Projectwise.

8. Attribute the subset: Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A##

9. Make the document description 02-Revisions_A##.

4.3.2 02_Revisions Subset Workflow - DCO

The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset. In this workflow the user edits the subset in Projectwise, they do not have to
export the document out and submit a new subset:

1. Check out the 02-Revisions subset from Projectwise.

2. Follow steps 2 through 7 from section 4.3.1 amended as follows:

a. Instep 4 edit note “DESIGN INITIATED CHANGE ORDER NO. Y -
mm/dd/yy”

b. Instep 5 add note “NEW SHEET ADDED BY DESIGN INITIATED CHANGE
ORDER NO. Y — mm/dd/yy”

c. Instep 7 “Check In” the document into Projectwise

4.3.3 Adding a New Revisions Sheet to the
02_Revisions Subset

1. Download a new “Index of Revisions sheet” from Section 1.4 step 16.
2. Insert the new sheet into the existing 02-Revisions subset pdf. Update the title block
information and update the sheet accordingly.

4.3.4 Filling Out Revision Index Sheet

To fill out a form field simply click on the box and begin typing. The first column is the
Addendum or Design Initiated Change Order. The second column is the revised or new sheet
number. The third column is the date, followed by a brief description that is similar to the
description on the actual sheet being revised. Finally click in the appropriate check box per row to
describe the action taken, new sheet, revised sheet, or sheet deleted. Note: The Engineer is not
required to input changes numerically by Sheet No. If another changed sheet is added to an
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of

Revisions Subset”.

REV. DATE |2 |> | R
No. SHEET No. ddjmmiyy % & % DESCRIPTION BY N
Addenda AL\ 02.06.003A1 01/01/11 v REMOVED DETAIL MicC
\ Al (03.05.001A1 01/01/11 (J DELETED SHEET MIC
AZ §04.05.003A2 01/20/11 o~ v ~ BEARING DETAILS MIC
A2/| 02.06.003-1A2 ov/20/11 )| ABUTMENT DETAILS MIC
¥ C1 % 04.01.026C1 02/15/11 b4 (/) WINGWALL DETAILS MIC
| c2 J03.04.055-1C2 03/02/11 e ALL 101 DETAILS MIC
i ‘
Design Initiated \ Deleted Sheet
Change Order Revised Sheet
New sheet
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4.4 Placing Stamps on Affected Sheets - Revised, or
Deleted Sheets

A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that are
affected by Addenda or Design Initiated Change Order. The stamp shall be placed using
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or in
Markup>Stamps as shown below:

William Pratt.pdf

01-Addent

Pages from CT_CON_FDP_0092-0612_03-Highways =

STA. 75+00 (:
? BEGIN STATE PROJ.NO.092-612 -, [N

FAP NO. 0911(123)
S ), STA. 63+00 (NE)
D OVERLAY

— The Addendum and i
~+ Change Order Stamp 7

= can be found
= in both places —

vz gt
e FEE— 1
T Z Z T2 T 7

Figure 79 - Addendum and Change Order Stamp

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User
Profile as shown in Appendix A. If you do not have the stamp in the Markups>Stamp area, see
Appendix A — Bluebeam Stamps

WARNING — When placing the stamps, removing the digital signature is not allowed.
Table 4-1 below lists the notes that shall be used for addenda, construction order requests, and as
built notes. These notes should be used in conjunction with the cross-out stamp.

The following shows how to apply the stamp to the sheet that needs to be crossed out for an

Addendum or Change Order.
1. Select the stamp from the Tool chest or Markup>Stamps and place it:
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BEGIN STATE PROJ. NO.092-612

FAP NO. 0911(123)

STA. 67400 (SB), STA. 63+00 (NB)
vvvvvv

e

The Addendum and
7+ Change Order Stamp =~
= can be found =
in both places

END STATE PR
AP

STA.75+00 (SB), §
11111

Figure 80 - Addendum and Change Order Stam

MR
T R

2. After the stamp is placed a box will pop up. Enter the applicable note from table 4-1

below in all caps as shown below:

. AR A ORTEE - S SRR TS Ty
Add. or CO Note x| Ty
Enter Mote: SR
<
N G ~
ET REPLACED BY ADDENDUM NO. 1
| ok || cancel |

ISTRICT
Al

2 08 3 dfd FOOT o

1 SRR
T3 RASED: Ol HAD BT

Figure 81 - Enter Note for Addendum and Change Order Stamp

Table 4-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts

Addendum Notes

Description of Use

THIS SHEET REPLACED BY ADDENDUM NO. Y

The revised sheet is considered to replace, in
total, the original sheet.

VOIDED BY ADDENDUM NO. Y

Sheet is voided by Addendum.

Design Initiated Change Order Notes

Description of Use

THIS SHEET REPLACED BY DESIGN INITIATED
CHANGE ORDER NO. Y - mm/dd/yy

Used for revisions to existing sheets. Changes
must be noted only on the revised sheet.

VOIDED BY DESIGN INITIATED CHANGE
ORDER NO. Y - mm/dd/yy

Use this for voiding of existing sheets.
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3. The following shows a completed stamp.

(S —p—

2 Text input through
dialog box

THIS SHEET REPLACED BY ADDENDUM NO. 1

LIST OF DRAWINGS

B A Ao o A CA PN Y B

MDG

RDOD

scuE ks WoTED

'Q’EYAYE OF CONNECTICUT @

DEPARTMENT OF TRANSPORTATION

OFFICE OF ENGINEERING

REPLACEMENT OF BRIDGE
NO, 04324 (ROUTE 175 OVER
ABANDONED RAIL ROAD)

NEWINGTON sriss
; &2
GENERAL PLAN -1 0302
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TY REPAIRS TO THE | MiDDLETOWN PORTLAND [wwmsw |
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NOTES AND L
TABLE OF QUANTITIES | 03.02

Figure 83 Typical Sheet Replaced by DCO

Section 5 As-Built Comments - Final Plans

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and
Cross Sections”, it is the responsibility of either the Contracting Engineers (Consultant
Inspectors) or State Forces (Office of Construction) to perform final as-built revisions of Contract
Plans. As-Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction
Manual, amended as follows:

Final as-built revisions will be applied to the digitally signed PDF plans as a digital
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed
over the top of the digital signature and its security, therefore, the original content of the
PDF plans can never be altered. Because as-built comments are digital and placed over
the top of the plans they are easily recognizable, searchable, and may be turned off if
necessary.

As-built comments shall be applied to the original, addenda, or construction order plans,
which every sheet is the latest, located in ProjectWise within the project’s 100_Contract
Plans folder.

CAD drawings may be updated, at the discretion of each design office, to reflect any
addenda, change orders, and as-built revisions for use in the future; however the original
digitally signed as-built PDF plans shall not be replaced and shall be the PDF set for
permanent records.
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5.1 As-Built Revisions (Digital Comments) Workflow

Two methods for applying as-built revisions to the digital PDF plans are provided in the
following sections; 5.1.1 and 5.1.2.

The first method, Section 5.1.1 Post Construction, district staff shall record as-built
revisions on their record set (paper copies) during construction. Once construction is
completed these revisions shall then be applied as comments to the digital PDF per the
workflow in section 5.1.1.

The second method, using Section 5.1.2 Active As-Built, district staff shall record as-
built revisions on their record set (paper copies), and shall apply them as comment to the
final set of digital PDF plans on an intermittent bases, during construction. By using this
method as-built information becomes available to all parties that have access to
ProjectWise during the construction process, improving communication and
transparency.

5.1.1 Post Construction As-Built

As-Built Workflow

Step Personnel Task
1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that
As-Builts can be applied to the Contract Plans.

2 Contracting Engineer | Change the state of the Contract Plans to “Perform As Built”,
or District Staff see Section 3.2.12

3 Contracting Engineer | Apply As-Built revisions to the Contract Plans in accordance
or District Staff with Section 5.3

4 Contracting Engineer | Change the state of the Contract Plans to “As Built Complete”,
or District Staff see Section 3.2.12

5 Contracting Engineer | Fill out the “As-Built Completion” Form As-Built Completion
or District Staff Form and submit to AEC Applications

6 Contracting Engineer | Notify all applicable personnel list in the Section 5.4.2 that the
or District Staff As-Builts have been completed for this project.

7 AEC Applications After the “As-Built Completion” form is received, proceed to
Staff Section X.X (Process for Archiving a Project)

5.1.2 Active As-Built

Under Development:
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5.2 As-Built Markup of Contract Plans

All as-built information will be placed using a few basic Bluebeam commenting tools. These
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be available
under the main toolbar). These tools will be in the right-hand panel under “CTDOT As Built
Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile):

Q ((‘an.t

Tt

MNew Open Save

O -ﬁ-
‘W =1

@ ” S
& [T -
+ Recent Tools
» CTDOT Review Tools
» CTDO op/Working Drawing Review Tools
~ CTDOT As Buitt Tools

Subject Comment
= |Construction Started Construction Started and
and Completed Date Completed Date
=== | Ag-Built Stamps This sheet not comected
=== | Ag-Built Stamps This sheet comected
= | As-Buitt Stamps Typical Section comected
— | Az-Built Stamps These quantities not comected
A Tex Bax
a
& Callout Use to Add a Callout
/ Line Use to Cross Out
/‘I Amow
>

Figure 84 - As-Built Commenting Tools
5.3 Applying As-Built Comments to Contract Plans

5.3.1 Before Using Bluebeam for As-Builts

All CTDOT users are required to complete the steps in Appendix A prior to applying as-
built revisions. By completing these steps as-built revisions will be standardized across the
all CTDOT users. These steps only need to be completed the first time using Bluebeam or
when the user logs into a new computer.

o Perform the initial login steps for Bluebeam. Initial Log Into Bluebeam

. Download the CTDOT Bluebeam profile. Download CTDOT Bluebeam Profile

. The user must have a ProjectWise login/password. Contact Julie Annino if you do
not have a Projectwise Username and Password.

5.3.2 Opening the Contract Plans from Projectwise

The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as
shown below:
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Project Properties | Folder Properties | Dependency Service | Access Control

GEMERAL -
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GEMERAL -
GENERAL -
GENERAL -

Project Mumber(z]

Program Muraber

Project Title

CTDOT Improvement Type
General Description
Federal Proj Dversight
Project Curtent Phase

Figure 85 - Location of the Contract Plans in Projectwise

1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you

are working on.

2. To open adocument with Bluebeam right click on the document, and select “Open With”

as shown below:
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#| | Label {User Defined) Description

e ' 01_General [

/E 02 _Revision

/E 03-Highway

/E 04_Skrucktur

/ E DS_TraFFic Open With. ..

# B o6_nTaT_F
iC= g an 8]

/E CTDOT_High View E-0141_CTDOT Mighway STD

# B croot_tRe 51D . i
Check Out Right click on the
- plan subset to open

opy Oul
n H n
— and select "Open With
Skart Studio Session, ..
— Refresh Local Copy
Purge Local Copy
\FOF Purge Workspace

Zuk

& Copy

Drocument Properti to Preview | Dependency Service | Access Control | Compaon
:;:l) = Copy To... I
GEMERAL - Praj  Move To...
GEMERAL - Prot  Rename...

Figure 86 - Open With Bluebeam

3. Select the Bluebeam icon and check “Always use this program” and select OK. The
document will now be checked out of Projectwise and open with Bluebeam:

x|
Select I
Program
MName | Description | Application

{£%PDF Document
Ehdobe Reader 9.3

PDF Document
Adobe Reader 9.3
Acrobat

"C:'\Program Files\Bluebeam Software'Blusbeam Revu'Revu'Revu,exe”™ "1
C:\PROGRA1\adobe\READER ~2. 0Yreader\acrord32. exe "%1"
"C:\Program Files\Adobe\Acrobat 10.0\Acrobat\Acrobat.exe™ "% 1"

|; Adobe Acrobat Document
Select

J%‘ Check I
v al use this program Select

[~ Open document as read-only
Click here for a list of suggested document viewers

i
Browse |

Figure 87 - Open with Bluebeam

Note: Since we checked “Always use this program”, the next time you open a pdf in

ProjectWise all you need to do is double click on the file.

4. After the As-Builts are applied to the contract plans click save in Bluebeam and then
select “Check In” when a projectwise dialog box pops up. If the document is not checked
back into Projectwise the As-Builts will not be uploaded to Projectwise.

Issued 9-2014 92 Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

5.3.3 Applying Digital As-Built Stamps

5.3.3.1 Construction Started & Completed Dates

The construction started and complete date stamps must be applied to the PDF title sheet, located
in the 01_General subset, as stated below:

1. Select the "ConstructionStartedandCompletedDates”: stamp from the “CTDOT As
Built Tools” tool box and place it at a conspicuous location on the title sheet:

Tom-d @B

Print E-ma Studio Create ‘Combine Batch Export A= Markups  WebTab

- Bax7iNE i/ | QWD A

CT_CON_FDP_0009-0094_01-General* =

hop/Working Drawing Review Tools
OT As Built Tools

Comment

Construction Started Construction Statedand
and Completed Date Completed Date

STATE

This sheet not comected

=== |This Sheet Comected | This shest comected

= T&?;:ge%mmn Typical Section comected

------ gﬁ;&?&'ammes i These guantities not comected

A |7ex Box

a
& Callout Use to Add a Callout

{ Line Use to Cross Out CONSTRUCTION STARTED DATE 04,/61/2611

|coNSTRUCTION END RATE  02/03/2012

/ Amow !

-

Figure 88 - Construction Started and Completed Date Stamp

2. Enter Start and Completed dates in a mm/dd/yyyy format with a space between them and
select OK:

Construction Started and End Da x|

Enter Construction Started and End Date B

a {mim./dd Anyyy mm/dd Ay

ﬂ-1fﬂ1f2ﬂ1ﬂ 0501 fZﬂ121“5
Start N Com » Ieted

Cancel |

Enter start Date, space, Enter
Completed Date (mm/dd/yyyy Format)
Select OK

Figure 89 - Entering the Dates for the Stamp

Below is an example of the placed stamp.
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CC
DEPARTMENT

FLAM 1 A=
m FROFILE HOR 1
CROSS SECTIONS
OTHER, SCALES 4

CONSTRUCTION STARTED DATE 0o1/02/2010
CONSTRUCTION COMPLETED DATE 08/01/2012 |

Figure 90 - Placed Stamp

5.3.3.2 This Sheet Not Corrected Stamp

This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail
Estimate Sheets must never be revised; therefore, they always receive this stamp.
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1. To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet,
select that stamp from the CTDOT As Built Tools tool box and place it in the lower right-
hand corner of the sheet, by clicking once.

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to
every sheet included in plan set, including the as-built revised sheets, and then go back and
remove it from the sheets that were corrected.

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that
stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand
corner of the first sheet in the plan set:

SUBSET 03 - HIGHWAY
INDEX OF DRAWINGS

Figure 91 - Placing the ""This Sheet Not Corrected Stamp"*

2. Right click on the stamp that was placed and select “Apply to All Pages”:
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Cut

Copy

Paste

Delete

Open Pop-Up Note

Tz

Change Colors

Layer

Right click Order

Alignment

Edit Action

''''' - Lock Ctrl+5hift+L

Reply

Set Status

Check

Add to Tool Chest

Sel as Default

Apply to All Pages

Properties

Figure 92 - Placing the Stamp on All Pages

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet
within the pdf set.

NOTE: You must go back and replace this note on the sheets that contain as-built revisions
with the appropriate stamp.

5.3.3.3 This Sheet Corrected

This stamp must be applied to all PDF sheets that contain as-built revisions.
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1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select
that stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand
corner of the sheet, by clicking once.

If the majority of the sheets contain as-built revisions it is easier to apply this note to every
sheet included in plan set, including sheets that do not contain as-built revisions, and then
go back and replace it, with the appropriate stamp, on the sheets that were not corrected.

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that
stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand
corner of the first sheet in the plan set:

2. NOTE: You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.

5.3.4 Applying Digital As-Built Notes

To place an as-built revision, simply select any of the provided tools located within the as-built
tool box shown below and apply it to the document that is being as-built.

CTDOT Review Tools

CTDOT Shop/Working Drawing Review ...
CTDOT As Built Tools

Comment

Construction Started
and Completed Date

| This shest Not

Comected

* | This Sheet Comected

| Typical Section

Comected

| These Quantities Mot

Comected

Temt Box

Construction Started
and Completed Date

This sheet not
comected

This sheet comected

Typical Section
comected

These quantities not
comected

Line Tool

Use to Add 3 Callout

Line

o
X

Use to Cross Out

N\ B m>

Amow

In the following example, the Line tool was used to cross out the existing text and the Text Box

tool was used to add text:
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BITU MINBU
CONCRET
- PARIK-LCURBIN

\ Line Tool
\ \L I P\ Text Tool h /L’

N
Figure 94 - As-Built Note Example

Additional tools are available by selecting Markup:

Measure Window Help

RmN- &

Pen Lines  Shapes  Image  Hyperink  Ammachment

s NE i/ | QWD A

A B C D E F G H I J KL M NOP Q R
List of Commenting Tools:

Text — commonly used tool for as-builts

Typewriter — Do Not Use for As-Builts — cannot edit text
Note - Do Not Use for As-Builts — will not print

Flag

Pen

Highlight

Eraser - Do Not Use for As-Builts — cannot edit graphics

I @mmooOwp»

Line— commonly used tool for as-builts

Arrow— commonly used tool for as-builts
Arc

Polyline

Callout— commonly used tool for as-builts
Dimension

Box

Circle

vTozzr x¢«

Polygon
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Q. Cloud — Do Not Use for As-Builts - this may be confused with change orders
or addendums

R. Picture — Pictures can be inserted into a document or attached. It is
reccommended that pictures be attached as not to obstruct any part of the pdf.

Do not add a note to a comment by double clicking on the comment. For example, if a line
was placed the user could double click on the line and add notes to it:

!I"F'
.
T

/"” Line X
/ Ronald Teller Supe... 10M11/2012 1268 ..

- A A

Figure 96 - Incorect Way to Add Text
If notes are added this way they do not print.

5.3.4.1 Digital As-Built Stamps and Notes Using
ADOBE

The following stamp files need to be downloaded to the user’s computer and placed in this folder:
C:\Documents and Settings\Usen\Application Data\Adobe\Acrobat\8.0\Stamps\. This could be
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current
user’s login Username. If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous
sentence, if version 10 is used replace with 10.

Stamp Files

As-Built stamps.pdf

Construction started and completed dates.pdf

These stamps are to be placed following Section 5.3 above.

As-Built notes shall be placed on the plans in accordance with Section 5.3 using the Adobe
commenting tools in the following format:
1. Text Font shall be Cambria 16, and the color Red.

2. All line work shall be line width 2 and the color Red.
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5.4 Notifications

5.4.1 Completion of the As-Builts

After the as-built information has been completed, the person responsible for the as-builts
revisions must notify AEC Applications by filling out the following form:

As-Built Completion Form

5.4.2 Notifying Department Personnel

After the as-built information has been completed and the above form has been sent to AEC
Applications, the person responsible for the as-built revisions shall notify the appropriate
Department personnel (via e-mail):

Issued 9-2014

Lead Designer
Chief Inspector
Central Surveys
ROW

Central Construction

Bridge Maintenance (if a structure is on the project)
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Section 6 Contractor Submittals

Under Development

The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which
allows the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized
location. Projectwise also allows the Contractor to access the Department’s comments quickly
after they review the submittal.

At the FDP date the designer is required to fill out columns A through F in the spreadsheet
labeled “CNS Item List” located in the 240 _Contract_Development Folder under the project in
Projectwise for each item in the contract that requires a shop or working drawing submittal. The
first two rows in the spreadsheet are filled out as an example and should be deleted when the
designer fills out this spreadsheet. Once the designer fills out this spreadsheet they shall notify
Mathew.Calkins@ct.gov and Henok.Abdissa@ct.gov of AEC applications. AEC applications
will then create place holder documents in Projectwise that the Contractor will edit for each
Contractor Submittal. If this spreadsheet is not updated the place holder documents will not be
created and the Contractor will not be able to submit their Contractor Submittals.

The Contractor is required to use the latest version of Bluebeam REVU to edit the Shop and
Working Drawing submittals as well as digital sign any Working Drawing Submittals. See
section 1.3 for the required prerequisites and policies for the following workflows.

Issued 9-2014 101 Version 3.07


mailto:Mathew.Calkins@ct.gov
mailto:Henok.Abdissa@ct.gov

Connecticut Department of Transportation Digital Project Development Manual

6.1 Workflows

The following shows the workflow for the Shop Drawing submittal process:
SHOP DRAWING WORKFLOW

Gain Access to CTDOT’s Projectwise Site, Contractor/Designer
See section 1.3 step 13.
| Contractor
Purchase Bluebeam and have it installed on
your computer, See section 1.3 step 10. Designer
1
|
1. Prepare Shop Drawing Submittal, See Section 6.2
2. Add drawings to the submittal located in Projectwise, See Section
6.3.1 <
3. Submit the 2", 3, 4™ etc. submissions, See Section 6.3.2
I
Send an email notification to the Designer stating a shop drawing
submittal is ready for CTDOT review, See Section 6.3.1 step 14 for the
initial submittal and Section 6.3.2step 10 for subsequent submittals
I
Review the Shop Drawing submittal. Markup the plans as necessary and
stamp each drawing: Conforms, Conforms as Noted, or Revise and
Resubmit. See Section 6.4.1 for the initial submittal and Section 6.4.2 for
subsequent submittals.
| ]
If all drawings are stamped If any drawing is stamped
Conforms or Conforms as Noted Revise and Resubmit
I I
Change the State of the document to Create a New Version of the
CLOSED, see Section 6.4.1 step 14 submittal, see Section 6.4.1 step
11
| I
Send an email notification to the Contractor stating the Send an email notification to the Contractor stating
shop drawing submittal has been reviewed and include the shop drawing submittal has been reviewed and
the status of each drawing, whether it is Conforms or include the status of each drawing, whether it is
Conforms As Noted. See Section 6.4.1 step 15 Conforms, Conforms As Noted, or Revise and
i Resubmit. See Section 6.4.1 step 15

Print the required paper copies of the submittal and mail
to the required people.
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The following table shows the workflow for the Working Drawing submittal process:

WORKING DRAWING WORKFLOW

Gain Access to CTDOT’s Projectwise Site,
See section 1.3, step 13

Purchase Bluebeam and have it installed on
your computer. See section 1.3, step 10.

=

Prepare Working Drawing documents, See Section 6.2

6.3.1
3. Submit the 2™ 3™ 4™ etc. submissions, Section 6.3.2

2. Add document to the submittal located in Projectwise, See Section

Contractor/Designer

Contractor

Designer

District Construction

District Construction
or Designer

Send an email notification to the District Construction and the Designer
stating a working drawing submittal is ready for their review, See Section
6.3.1 step 14 for the initial submittal and Section 6.3.2 step 10 for

A

subsequent submittals

NO

Designer Review

Required

Review the working drawing submittal. Markup the
plans as necessary and stamp each drawing:
Conforms, Conforms as Noted, or Revise and
Resubmit. Resubmit and update the submittal cover
sheet. See Section 6.4.1 for the initial submittal and
Section 6.4.2 for subsequent submittals.

YES
|

Review the working drawing submittal. Markup the plans as
necessary and stamp each drawing: Conforms, Conforms as
Noted, or Revise and Resubmit and update the submittal cover

sheet. See Section 6.4.1 for the initial submittal and Section
6.4.2 for subsequent submittals. If the submittal is conforms or

conforms as noted send an email to district construction for their
review

If all drawings are stamped

‘| Conforms or Conforms as Noted

If any drawing is stamped
Revise and Resubmit

If all drawings/documents are
stamped Conforms or Conforms
as Noted

If any drawing is stamped
Revise and Resubmit

Change the State of the document to

Create a New Version of the
submittal, see Section 6.4.1 step

CLOSED, see Section 6.4.1 step 14

Send an email notification to the Contractor stating
the working drawing submittal has been reviewed
and include the status of each drawing/document,
whether it is Conforms or Conforms As Noted. See
Section 6.4.1 step 15

Print the required paper copies of the submittal and
mail to the required people.
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Send an email notification to the Contractor stating
the Working drawing submittal has been reviewed
and include the status of each drawing, whether it is

Conforms, Conforms As Noted, or Revise and
Resubmit. See Section 6.4.1 step 15
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6.2 Submittal Format Requirements
The following lists the requirements for contractor submittals. For both Shop and Working
Drawing submittals, CTDOT will create a document for all required submittals in Projectwise
based on the “CNS Item List”, see section 1.4 step 21 that is submitted by the designer at FDP.
The Contractor is required to edit these documents by adding the drawings/documents required
for each submittal:

SHOP DRAWING SUBMITTALS

1. Drawings shall be sized 34” x 22” and each drawing shall be in a separate PDF file.

2. Drawings shall be added to its associated item number document in Projectwise.
Documents shall be named in accordance with the following before being added to the
associated document in Projectwise:

a. The file names for the shop drawings must match the drawing number of that
sheet.

b. The file names for revised shop drawings must match the drawing number and
include
“ 2™ Submission” for the second submission of the drawing, “ 3" Submission”
for the third submission of the drawing, etc. An example for the second
submission of drawing D-1 would be D-1_2" Submission. The third submission
would be D-1_3" Submission.

3. The documents in Projectwise contain a cover sheet for the submittal that must be filled
out before notifying the CTDOT that a submission is ready for their review.

4. Drawings shall be added to the documents in Projectwise in accordance with Section
6.3.1

5. Drawings for the 2M 31 4™ etc. submissions of a submittal shall be added in accordance
with Section 6.3.2
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WORKING DRAWING SUBMITTALS

HowpnpE

o o

10.

11.

Drawings shall be sized 34” x 22” and be combined into (1) multi-page PDF document.
Calculations shall be sized 8.5” x 11" and be in a single PDF document.
Catalog cuts shall be sized 8.5 x 11” and be in a single PDF document.
All drawings must contain a watermark of the engineer’s PE stamp place in a common
area of the border. The watermark shall be placed in accordance with section 2.4
All drawings shall be digitally signed using a CDS signature in accordance with section 2
All calculations shall be digitally signed using a CDS signature in accordance with
section 2
Each submittal shall only contain drawings, calculations, and catalog cuts for one item
number. If an item has multiple sites the working drawings, calculations, and catalog
cuts for the multiple sites can be combined into one submittal.
All documents for a submittal shall be added to the associated document in Projectwise.
Documents shall be named in accordance with the following before being added to the
associated document in Projectwise:
a. The file names for the initial drawings shall be “Drawings”.
b. The file name for the calculations shall be “Calculations”.
c. The file name for the catalog cuts shall be “Catalog Cuts”.
d. The file names for revised working drawings, calculations, or catalog cuts must
match the original file name and include
“ 2™ Submission” for the second submission, “ 3™ Submission” for the third
submission of the drawing, etc.
The documents in Projectwise contain a cover sheet that must be filled out before
notifying the CTDOT that a submission is ready for their review.
Drawings shall be added to the documents in Projectwise in accordance with Section
6.3.1
Drawings for the 2", 3", 4™, etc. submissions of a submittal shall be added in accordance
with Section 6.3.2
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6.3 Contractor - Adding Documents to the Contractor
Submittals

6.3.1 Initial Submittal

The following shows the procedures and responsibilities of the Contractor when adding
drawings/documents to the initial Shop or Working drawing submittal.
1. Prepare the drawings/documents for the submittal in accordance with Section 6.2 of this
manual.
2. Next log into Projectwise by clicking on this link and entering your Projectwise
Username and Password- https://ctdot.projectwiseonline.com

=
'I;Tl }L\.\

User name: | € PwonLINEWMsthew. Calkins = |

Password: I TTITITIIIITI LY

[~ Remember my password j

oK | Cancel |

Figure 97 - Projectwise Log In Screen
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3. Browse to the active construction projects located in the 01.0 — Projects Active area in
Projectwise. Then browse out to your project and click on the 120_Contractor Submittal
folder as shown below:

P

Advanced search options

E ctdot.projectwiseonline.com:CTDOT

=1
=l | | Documents

Click here to browse

active projects

@ | II 01.0 - Projects - Active

-

" 0004-0116 &

|| 100_Contract_Plans (PDF)

110_Contract_Specifications (PDF) /

120_Contractor_Submittals {PDF])
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130_Engineering_Reports
210_Construction
220_FHWA
220_Contract_Administration

240_Contract_Development

Figure 98 - Browsing out to a Folder

107

Click on the
plus next to
your project

r

-

r

-

der Document

™y
a [
Label (User Defined)

=
SR

=
—

=

And click on
this folder

o

r |

0 G

o &3

=l

—_— =
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4. Next open the file for the submittal you are working on as shown below:

Folder Document View Tools Help
w .
@ 48 [ B e
Fl Label (User Defined) Created By
-_: .
B View
Right click B oownions. 2 )
on the file .
4 Export. % Open as Read-Only
and selct More
then Open
J Check Out
Change State »
Copy Link{s) »
Eﬁ Delete L] copy out
_1_ Er* properties % Purge Local Copy
I@ Move...

ProjectWise Properties

Mo content available to display.

Figure 99 - Opening a Document from Projectwise
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5. When you open it you will be looking at the PDF Package. After the file opens double
click on the submittal cover sheet shown below:

shop_drawing_submittal_template.pdf = 01_Shop Drawing Submittal Cover Sheet

PDF Package

File Name: shop_drawing_submittal_template pdf

Author: ca
Created: 13741 AM . Double Click
on this file

i 071_Shop Drawing Submittal Cover Sheet pdf

Figure 100 - Filling out the submittal cover sheet
6. Fill in the fields on the top portion of the form, as shown below for the initial submittal:
The section below shows a shop drawing submittal but the procedure is the same for a
working drawing submittal.

Connecticut Department of Transportation - Shop Drawing Submittal Cover Sheet

L, Project No.: 123456 Project Title: Beering Replacement for Various Bridges Iterm No.: 156475 Site No(s): 1and2 ERIDGE_Q
x FIRST SUBMISSION i SECOND SUBMISSION
i P oate; snene FROM:  Southingion Mela DATE: DATE:
- To: Jon Hagart dahn Smith NOTES: TOTAL PAGES: NOTES:
v T
eer Distrct s JzsMein®t
— ———— > All these fields must
___| e
NOTES:  uring Shop Drawings TOTAL PAGES: 3 be filled out for the
= mgm - -
S - ;initial submission —
Drawing | Response Rw:;wod E 8 Response Response lcv;‘:vcd ,E £ Respanse [ ame dwisu;\

Figure 101 - Initial Shop Drawing Submittal

Issued 9-2014 109 Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

7. After the fields are filled in, click save and close the cover sheet as shown below:

f? Qo Fie Edit Wigw Document Form Markup Measure Window Help

—

7rint. E-miail S Fditor Data Highlight Javade

rd 1 S Y 4 ol [ ¥ &

a2 zE
O %I |

ITEM NO.: DI564TH BRIDGE

= Click Save and then — T o ==

= Click on the X to close — ETo0Ts cxments

SITE NO{s}): 1and2
SECOND SUBMISSI

w (w2 HRE
EIEESE E|EYCE
Reviewed | 5 5 2|B2 Response | Reviewad | & |2 2| % 5|
By B gﬁ%ﬁ Response Date By g Sigﬁ |
4|58 S |5 )
MJC [Ef{myim| [mjim)ym]
MG MO0 ] ] g

Figure 102 - Saving the Form

SHOP DRAWINGS

8. This step is for shop drawing submittals only. Next add the drawings for the submittal
by clicking on the Add files icon and selecting the drawings to be added to the submittal.
Then click Open as shown below:

Click on the
"Add Files"
icon

Lok in | (£ Deskiop

Type

FDF Dacument

PDF Document:
Documents ™ Gl PDF Document

tal Farm.pdf 51372013 1008 &b rl‘a i Microsoft Word Doc...

Description Modified

FDF Dacument
PDF Document:
1B Pands from CT_con_FRL sy, PDF Document
B ragfs from CT_CON_FRL_03... PDF Document
m GMN-1Revisedz, pdf PDF Document
PDF Document

Select all the P Fie
- <Flaw.docx [Microsoft Word Doc. ..
drawings

Dieskiop

iper Plan ... E57 KB

|

File name: |"GN—1 pdf “E-1.pdf" "D-1.pd"

Files of type |&nFies )

Figure 103 - Adding Drawings to a Shop Drawing Submittal

9. Click save and close Bluebeam.
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10. Next go back to Projectwise and right click on the submittal in Projectwise and select
Check In as shown below:

ed search options
tdot.projectwiseonline.com:CTDOT Folder Document View Tools Help
= &
| Documents 1 'E I;_Jg de @ A B
f'—1 =
B I | 01.0 - Projects - Active
o O Label (User Defined) Created By
B | gy 00040116 & 0004-0118 ) )
} : i MIC- Admin
B [Cag 0004-0133 . . e
Right click
(] H
L wo_conrracepl 0N the submittal
\ , 110_Contract_Specifications (PDF) @ Download. ) =
Open

D

120_Contractor_Submittals (PDF)
Open as Read-Only

D

130_Engineering_Reports

210_Construction ( 4 ) I
220_FHWA /' Change State » ( E&
»

D

D

)

'E_l 230_Contract_Administration Then seIECt Copy Link(s] =
More and the S e
l‘='_| 240_Contract_Development Check In
U' Properties

ProjectWise Properties

Mo content available to display.

Figure 104 - Checking a Document In

11. After the submittal is uploaded to Projectwise, send an email notifying the designer. The
email shall include the project and item number in the subject line. Below is an example
of an email for a shop drawing submittal.

Clipboard ] Easic Text ] MNames Include Tags % | Zoom
H:
To... |Hagert( Jon R;
]
— e |
Send

Subject: |Project#123-1234 Ttem #0602000 Deformed Steel bar shop drawings.

Jon,
The shop drawings for the deformed steel bars for project 123-1234 have been submitted into Projectwise for your review.

John Smith
Southington Metal
100 Industrial Way
Southington CT, 06246

Figure 105 - Email Example
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WORKNG DRAWINGS
12. This step is for working drawings submittals only. Next add the drawings, calculation,

and catalog cut files for the submittal by clicking on the Add files icon and selecting the
applicable files.

el

! Working Drawing Submittal_template.pdf =

PDF Package

File Name: Working Drawing Submittal_template pdf
Author: calkinemj
Created: 61972014 7:27 AM

ﬁ 0 (% Select files to attach / Click on the 19/2014 2:50 PM

@Uv| .+ Working Drawing Submittal / v|¢,| F add files icon

i = s

Organize » Mew folder

MName

[ Favorites
Bl Desktop M calculations.pdf
& Downloads = @ Catelog Cuts.pdf
2| Recent Places @ Drawings.pdf

4 Libraries
3 Documents

& Music Select all the files

§|:‘dt and then click Open

"M Computer 4] L &
File name: "Calculations.pdf" "Catelog Cuts.pdf” [A” Files (") ']
—
[ Open l D Cancel ]

Figure 106 - Adding files to a Working Drawing Submittal
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13. Next go back to Projectwise and right click on the submittal in Projectwise and select
Check In as shown below:

L]
ed search options
tdot.projectwiseonline.com:CTDOT Folder Document View Tools Help
E‘ Documents E I:a |:e$ Ej @ A B
B ,‘b, 01.0 - Projects - Active 1
o O Label (User Defined) Created By
B 3 0004-0116 & 0004-0118 }( e AT
=l 3 0004-0133 . . .
Right click
2 100_conmaceel o the submittal
'E:I 110_Contract_Specifications (PDF) Ej Download.) open
r=_| 120_Contractor_Submittals (PDF
o B B ‘ ! Open as Read-Only
'E__; 130_Engineering_Reports
@ 'g__, 210_Construction C ’) l
(L] 220_Frwa /' Change State » (@ )
F:, 230_Contract_Administration Then SEIECt Copy Link{s) 4 :
More and the S e
_| 240_Contract_Development Check In
I:T' Properties
ProjectWise Properties
Mo content available to display.
Figure 107 - Checking a Document In
14. After the submittal is uploaded to Projectwise, send an email notifying the designer and
district construction. Below is an example of an email for a shop drawing submittal.
g Clipboard Fl Basic Text Fl Mames Include Tags = | Zoom
H
To... |Hagert( Jon R;
E Cc... |
Send
Subject: |Project#123-1234 Ttem #0602000 Deformed Steel bar shop drawings.
Jon,

The shop drawings for the deformed steel bars for project 123-1234 have been submitted into Projectwise for your review.

John Smith
Southington Metal
100 Industrial Way
Southington CT, 06246

Figure 108 - Email Example
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6.3.2 Contractor — Subsequent Submittals (Revise
and Resubmit)

The following shows the Contractor how to upload revise and resubmit contractor submittals.
After being notified by the designer or district construction that the drawing(s)/document(s) have
been stamped “Revise and Resubmit”, the Contractor will do the following depending on what
type of submittal they are working on:

Shop Drawings — Add the revised sheets into the initial submittal PDF Package.

Working Drawings — For revised drawings, submit (1) pdf document that contains only the
changed sheets. For calculations, submit (1) pdf document that contains only the changed sheets.
The revised drawings need to be watermarked and the first sheet digitally signed in accordance
with section. The revised calculations need to be digitally signed on the first sheet in accordance
with section.

The following shows how to submit the updated drawings/documents.
1. Log into Projectwise — https://ctdot.projectwiseonline.com

2. Browse out to your project and go to the 120_Contractor_Submittal folder:

O

’
Advanced search options

g ctdot.projectwiseonline.com:CTDOT der Document )

. Click here to browse
=] 1 | Documents active prOjeCtS

01.0 - Projects - Active )
. - Label (User Defined)

B (a ooos-oiiss Click on the .
/m plus next to r
: j 0004-0133 your project - ..-=—.

—

| 100_Contract_Plans (PDF) - P

110_Contract_Specifications (PDF) / And CIiCk On

( I_ | 120_Contractor_Submittals (PDF) ,
1
I_ | 130_Engineering_Reports P
r
(] I_ | 210_Construction —
r
[ | 220_FHwa —_
r
I_ | 230_Contract_Administration P
r
I_ | 240_Contract_Development — —
|4l

Figure 109 - Browsing to the Project
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3. Next open the submittal as shown below:

Folder Document View Tools Help
e/ ;
1
@ [4 & 2 =y
Fl Label (User Defined) Created By

M

MIC-Admin

WView

Right click (& Download. Z )
on the file

T Export... % Open as Read-Only
and selct More
then Open
] Check Out
Change State »
Copy Link(s) 4
Eﬁ Delete L] copy out
v 45 E1* Pproperties E[’;; Purge Local Copy
|‘@ Move...

ProjectWise Properties

Mo content available to display.

Figure 110 - Opening a Document from Projectwise
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4. After the submittal opens double click on the submittal cover sheet.

CT_CON_SDR_9876-5432_0156478-Beating_(1).pdf &

PDF Package

Double click
on the form

File Mame

i 01_Shop Drawing Subrittal Farm.pdf 10772013 215 P

D-1.pdf T0/7/2013 213 PM

E-1.pdt 1072013 213 P

GN-1.pdf T0/712013 2:13 Phd

Figure 111 - Opening a file in a PDF Package
5. Next fill out the fields circled below, as shown below:

SHOP DRAWING SUBMITTALS

Connecticut Department of Transportation - Shop Drawing Submittal Form
PRODECT NO.: 121456 PROJECT TITLE: Bearing Replacement for Various Bridges ITEM NO.: 0156478 SITE NO{s): 132 BRIDGE NO(s): DISE 01457

3 FIRST SUBMISSION SECOND SUBMISSION THIRD SUBMISSION
, i DATE: 970313 FROM: a%;gmgn Metpl DATE: 82513 DATE:

] To: Jan Hagart n it NOTES: @ drawing GN-1 10 resalve TOTAL PAGES: 1 TES: T

§ i o

g e Disio i Sollgmswes CTOOTE ek 4———— Fill in these
a _ Plainvle CTOSOX -

i = fields

3

2 | MOTES:  oning Shop Drawings for Brdgs | TOTAL PAGES: 3

= 01564 and 01457 \

T T T T =T T T T =T T T 1 =T

Figure 112 - Subsequent Shop Drawing Submittals
WORKING DRAWING SUBMITTALS

Connecticut Department of Transportation - Working Drawing Submittal Cover Sheet

PROJECT NO.:123-156 PROJECT TITLE: Bridge replacemant of bridges 01234 r TTEM NO.:
FIRST SUBMISSION SECOND SUBMISSION
DATE; 6142014 FROM: Southing Mstal DATE:  BA92014
o

=§- To:  Jon Hager gl Documents Included in Submittal:
[ cc: 100 Main 51 Revised Drawings and Calculations
I.: THrmex] AT
E plainville ot
L-]
3 860-594 5980
z Pt Momber)
3 Fill in these ___aane=W
k-]
R Documents Included in Submittal: - Comments:
] -
Z | Drawings, Calculations, Catalog Cuts fields We have added 10 shests to the calculations.

=

.% Reviewed By: Reviewed Date: Reviewad By: Raviewed Data:

Figure 113 - Subsequent Working Drawing Submittals
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6. After the fields are filled in, click save and close the form as shown below:

f? Qo Fie Edit Wigw Document Form Markup Measure Window Help

—

Jave 7rint. E-miail Studio Fditor Inzert Data Highlight Reszel Ja pt
1O - - - 5 . : . y 3
BN wEES®m- SR U BE -0 LI oiAm S 2 e X J 4

al 2 s E W ® g ng Submittal Form Examnple. pdf* 01_5hop Drawing Submitta Form® &

O MIEID DX |-

ITEM NO.: DI564TH BRIDGE

SITE NO{s}): 1and2

- SECOND SUBMISSI
= Click Save and then = om =
= Click on the X to close — | ™™ &Geemdmme ™ o™ ™"
- the form p—
Reviewed E Eg g.‘g Response Response | Reviewad E Eg QE |
MIC OO ojajo
MG F{O|O Oojojo

Figure 114 - Filling in Fields for Second Submission

7. Next add the revised drawings/documents to the submittal. To add the revised
drawings/documents click on the Add files icon and then select the revised
drawings/documents and click Open as shown below: The figure below shows a shop
drawing submittal but the same procedure is used for adding the revised drawings,
calculations, or catalog cuts to a working drawing submittal.

Click on the ,
Filz Name - . Look in: | (4} Deskiop v Q@ m-
Add files icon = "
| 01_Shop Drawing 8 i el THE =
- @ Shap Drawing Submittal Farm Example. .. 1,090KE  PDF Docurment W
B etpdr 210KB  PDF Document
= i NS 204 KB PDF Document
E-1.pdf = 265KE  PDF Document
L[a i orkflow, dacx SE5KE  Micrasoft wWord Doc...
Dieskh orms_019-12-201... 69KB  PDF Document
5 E-1.pdf Eeter B Pages From CT_con_| 4,839KE  PDF Dacument
. B Paes from CT_cON_FRL 7,793KE  PDF Document
- 294 KB PDF Document
. GIMN-1 pdf 272KB  PDF Document
SeIeCt the STKE TMPFilz
revised sheets daex 1KB  Micrasoft Word Doc...
. KB Microsoft Excel Wor..,
and click open  sxoserra. SNE  FDF Document 2
>
¢ -g File name. [En1_ppe v Open
LB Files of type: |A\I Files ["*] Ld ‘ Cancel

Figure 115 - Adding Revised Sheets

8. Then click save and close Bluebeam.
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9. Next go back to Projectwise and right click on the submittal in Projectwise and select
Check In as shown below:

Fe]
ed search options
tdot.projectwiseonline.com:CTDOT Folder Document View Tools Help
g . & : : § !
| Documents [z & d y-J r_v'

= =
E‘ | | 01.0 - Projects - Active
O Label (User Defined) Created By

— .
B 22 0004-0116 & 0004-0118 .
; MIC-Admin

F| Wiew

—
B Ag 0004-0133

Right click

| 1o_conrrace i 0N the submittal

110_Contract_Specifications (PDF) 1 Download.|
- Open

120_Contractor_Submittals (PDF) =
% Open as Read-Only

130_Engineering_Reports

E |.=_I 210_Construction C ') l
(2

[ 220_FHWA /' Change State (
»

)

'_=_| 230_Contract_Administration Then seIECt Copy Link(s] -
o More and the B Free
| | 240_Contract_Development Check In

Ij' Properties

ProjectWise Properties

Mo content available to display.

Figure 116 - Checking a Document In

10. After the revised shop drawing(s) or working drawings are submitted, send an email
notifying the designer or district construction that the revised drawings/documents have
been uploaded into Projectwise and is available for review. Below is an example of an
email for a shop drawing submittal:

Clipboard ] Basic Text ] Mames Include Tags % | Zoom
H:
To.. Hagert, Jon R;
=
A Cc...
Send

Subject: Project #£123-1234 Ttem #0602000 Deformed Steel bar shop drawings.

Jon,
The shop drawings for the deformed steel bars for project 123-1234 have been submitted into Projectwise for your review.

John Smith
Southington Metal
100 Industrial Way
Southington CT, 06246

Figure 117 - Email to CTDOT
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6.4 CTDOT/Consultant - Contractor Submittal Review

CTDOT shall review the contractor submittals using Bluebeam to apply any markups and the
Submittal Review stamp to each drawing/document in the submittal. Before starting a review
make sure you have downloaded the CTDOT Bluebeam profile. This profile contains all the
markup tools as well as the submittal stamp that needs to be applied to all contractor submittals.

CTDOT Newington Employees — The profile is located on the X:// Drive in the V8
Admin>Bluebeam Resources>Settings folder. Just double click on the file called CTDOT
Bluebeam User.

CTDOT District Construction Employees — Save this file to your desktop and then double click
on it Bluebeam Profile

Outside Consultants/Designers — See Appendix D of this manual.

In each submittal there will be a submittal cover sheet that tracks all the information for the
submittal. The CTDOT/Consultant shall record all their resolutions for the submittals on this
cover sheet, whether the drawings/documents are stamped Conforms, Conforms as Noted, or
Revise and Resubmit. The form shall be updated throughout the review process for all
submissions associated to a Contractor Submittal.

For working drawing submittals that are reviewed by the engineer, the drawings and calculations
need to be stamped by both the engineer and district construction and the submittal cover sheet
will need to be filled out by the engineer and district construction. If district construction does
not need the engineer to review the submittal their will only be one submittal review stamp on the
drawings or calculations and the submittal cover sheet will only have district construction’s
resolution.
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6.4.1 Initial Contractor Submittal Review
CTDOT or Consultant Review
The following shows how to review an initial contractor submittal. The figures show a shop

drawing submittal but the procedures are the same for a shop or working drawings submittal.
1. Log into Projectwise.

2. Browse out in the 01.0 — Projects — Active folder to the project’s 120_Contractor
Submittal folder. Then double click on the contractor submittal file to open:

e o P

= [ Projectivise Explorer Datasources L List | @ Geospatial
= |y CTDOT (mjc-admin}

5 Documents —=ipe = = Drescription
m EBridge Mo 01534 and 01567Bearing shop drawings
Sl OO04-0gE & 0004-0118
A AN
\ T 100_Corkract_Plans (PDF)
‘ {7 120_Contractor_Submittals (PDF) ’

[ v g )

Double click

H-{ 210 _Construction on the f”e to
Browse to your Zv open
p roj ect iment_Confidential

ks
L 2EU_FENHIL_HpPILaUuns
+-{_ 330_Design_Data
L= 340_aAdministration
L= 341 _Administration_Confidential
+-{_ " S00_Pre_Design
+- 4 Saved Searches
[ ooos-0122
[ 0007-0182 & 0170-3155
+ ™ 0009-0094
+- ™ 0011-0151
[ 0012-0095
[ 0012-0096
+- [ 0014-0177
+- [ 0014-0183

Figure 118 - Opening a file from Projectwise
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3. When the submittal opens, you should see the submittal cover sheet followed by the shop
drawings or working drawings, calculation and catalog cuts as shown below: The
following shows a shop drawing submittal but the procedure is the same for a working
drawing submittal.

CT_CON_SDR_0D04-0133_0153468-Bearings.pdf*

PDF Package

Submittal form

01_Shop Drawing Submittal Form.pdf 1.23MB 91372013 10:08 Aw

D-1 pdf 9N32013 11:47 A

&— Shop drawings

E-1 pdt 91312013 11:47 A

GMN-1.pdf 91312013 11:47 A

Figure 119 - Example of a Submittal

4. Review the drawings/document by double clicking on one of the files and it will open in
a new tab as shown below. Markup the drawings/document with comments using the
markup tools located in the tool chest shown below. Also place the submittal review
stamp that is also located in the tool chest.

BOERSE:/ | OND A Ae B i[5

It /@

The file will open To review use the

LOCATION
aTy. . -
ABUT/PIER SPAN =4 in a new tab and you CTDOT ShOp/WOTklng .
z PIER 2 3 BA1EE . . .
4 PiER 2 2 = can start your review drawing Review tools = |suomia Gontanty ik
i PIER 2 3 B . g eview Stamy
] o T - located in the tool chest i
Az A2
SoLE PL| S0LE PL | Highicht
I 2 |
w2 2 1
w/m W'/,,m T km‘ Test Box Use to Add text
FEAe Wl o Callout Use to Add a Callot
—— | nl
T T 1 Use o Clowd
g | ! B B Canectans
9
3 % X i . Line Uss to Cross Dt
3 Bs| | 3
vl | R
Pl |
e -
a I
g 1 | 1 COVER PLATE
ERNIl 1 PLIE K e X A
3 1 I ASTM A3 (UNPAINTED)
i Akttt et 4 ME] BTG HOLES I S Flavce
— = 116A (195" HOW) INTERNAL St - |2
168 Carage sy e, s — L e B e Toma. resonen
ELAN VIEW TN AROUND 1, P
4l
8 SEE_SHEET GM1OF 1 FOR GENERAL NOIES
AAAAA DETAL 1 SRS ToR -
STATION I" % W x L LAMINATED PAD STATE OF GONNECTICUT
AINT ON_TOP— BEVELED SOLE PLATE 50 DUROMETER NEOPRENE GRADE 3 HAVING A SHEAR DEPARTMENT OF TRANSPORTATION
\CE OF SOLE TH 8 CLx B A MODULUS OF 085 KSI £15% A\ BRIDGE NO. 01702
ELD WELONG . WLCHHED 10 SOLE PLATE ROUTE 2 WESTBOUND OVER
|2 7). REQUIRED QUARRY ROAD
® seanns | 7 © ey =EFEIVL DISTRICT 1 — SITE 6
- 1" % W x L LAMINATED PAD ) b T
L — —1 50/ DUROMETER NEOPRENE GRADE 3 HAVNG A SHEAR
MODULUS OF 035 KS 415%
E PAD ONLY - NG SOLE PLATE
== {1) REQUIRED

\SEZ DETALL 1

ELEVATION VIEW
IANSION ELASTOMERIC.BEARING ASSEMBLY

Figure 120 — Shop/Working Drawing Review Tools
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Submittal Review Stamp
5. For CTDOT Engineers and district construction the submittal review stamp is located in
the tool chest in Bluebeam and should be placed on an open area of the drawing. For
Consultants Appendix D must be followed before their stamp is located in the tool chest.

To place the stamp, click on the stamp in the tool chest and then place it. Then select the
appropriate option from the java script window. If the stamp is too big and is covering
part of the drawing, resize the stamp by dragging a corner as shown below:

12 - p—
BEARING LOCATION BEARING TOTAL BEARING DIMENSIONS
MARK an ABUTIPIER SPAN BEAM(S) TYPE L(;APZ? L w T A
- EBA2-D 4 PIER 2 3 B12 EXP. 75 " E 1.735" 9
EBA3-D 1 PIER2 3 B-12 B EXP. 75 8" 9 1.735" 9"
TEST-D 1 NiA NIA D EXP. 75 8" 9 1735 NIA
A2 A2
LE PL | SOLE PL SUBMITTAL RENVIEW
2 w2 DESIGNER'S REVIEW
| = B 7 g e
B BEARING ™ | THE SOLE PLATE
\
T
, 1
Sl 1oz
I [ &lE
7L,,,+,,,J e Cng s To resize the stamp,
. first click on the middle
e of the stamp so the
N AT o1 o BEVELED SOLE PLATE N
nuate FBH D e o yellow circles appear,
° then click on a corner and
drag it to the size
that fits.
Figure 121 - Submittal Review Stamp
The stamp is now resized as shown below:
otk & g Q
CT_CON_SDR_00( ings. pf* D-1* =
BEARING | LOGATION BEARING :
MARK ) ABUTIPIER SPAN BEAM(S) TYPE (
EBA1-D 2 FIER 2 3 B-11E & B-11W EXP.
. EBA2-D 4 PIER 2 3 812 EXP.
EBA3-D 1 PIER 2 3 B-12 EXP.
TEST-D 1 NIA NA | NA EXP.
AfZ AS2
SOLE PL SOLE PL. SUBMITTAL REVIEW
DESIGNER'S REVIEW
Lz L2 =
LAM. PAD | LAM. PAD
& BEARING
- :
w Q .I—___J-___—‘.
= |
R ! /?

The stamp is
now resized

11GA (11967 NOM.) INTERNAL SHIM
[3) REQUIRED

Figure 122 - Resized Stamp
6. After the review is completed, close the file and click yes to save.
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Figure 123 - Saving the Shop Drawing

7. Repeat the review process for the each drawing/document in the submittal.
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BEARING BEARING TOTAL BEARING DIMENSIONS STEEL SOLE PLA®
mark | 9T TYPE LoADS
ABUT/PIER Ps) L w T A B Th
EBA1-D 2 PIER 2 EXP. 75 8" a" 1.735" ar 1134" 3.09"

. EBAZ-D 4 PIER 2 10" 3.09"
EBA3-D 1 FIER 2 - 10" 3917
TESTD 1 NiA | Close the file NiA NiA

A2 .
ot 7 and click yes to save ,
L2 s _1--..
Land. PAD [ LAM. LAMINAIEY FAL 10
LAk BE VULCANIZED TO —
THE SOLE PLATE R
. nl g
J:r---- - / o
: |
L ! L
o = |E ezl
Rl B+ o
3 e o] " s
= |l I X N %
" o | | Save changes to follawing PDF files? 3 E =
% alg I I #|5
gz e | | I File Path Z|a COVE|
oy 7|2 | I D-1.pdf Bl PL 3/8
& |3 | | : Z|m ASTM A36
o3 L o e T0 BE FELD
R 1164 ( 3 EXISTING HOLES
| 6a (] (14) TOTA
AHEAD SEL_SHEET @1
STATION P . STATE (
NO PAINT OGN TOP— BEVELED SOLE PLAT DEPARTMEN
SURFACE. DF SOLE THOCLx B xA BRID!
PLATE FOR FIELD WELDING : 4 Q Ty ROUTE L':\ZL
& es Nao Cancel e
® 4 fmmnc - lm J( ] i DISTRI
2 (* — —t= 50 DUROMETER NEOFRENE GRADE 3 HAVING A SHEAR s
MODULUS OF 085 KSI +15% A | [
- PAD ONLY — NO SOLE PLATE di FRG), N0 171
— 2 {1) REQUIRED 1  —r
\\sgg BETAIL 1 ’I " LAMINATEL
AT EW L
]
EXPANSION_FLASTOMERIC BEARING ASSEMBLY &
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8. After all or each one of the drawings/documents in the contractor submittal is reviewed
the submittal cover sheet needs to be updated. To update this sheet double click to open
and then fill in the appropriate information. See below:

3468-Bearings. pof* 01_Shop Drawing Submittal Form =

Connecticut Department of Transportation - Shop Drawing Submitt

VPR Nemider)

PROJECT NO.: 123-456 PROJECT TITLE: Bearing Replacement for Various Bridges ITEM NO.: 0156
L FIRST SUBMISSION
ﬁ DATE: 21313 FROM: Southington Metal DATE:
£ S m—
' on ami .
c To: (JonMngert S NOTES:
v ec:  District 3 Construction B;J::?'” Street
z e Plainville CT 06XXX
E 860.665-7778
-]
3
[

NOTES: Bearing Shop Drawings for Bridges TOTAL PAGES: 3
01564 and 01457

=]
Drawing | Response | Reviewed | o |0 2|¥% o Résponse
No. Date By EHERET Response Date
a|log|2E
D1 9152013 |MJC MO0
[ ]
E-1 9/15/2013  |MJC (mp
for any raason
GMN-1 9/15/2013  |MJC Oig&E
"4
mmne| ‘
o)

* Fill in this information
for the submittal

Figure 124 - Shop Drawing Submittal Form

For working drawing submittals that are reviewed by the engineer, the drawings and calculations
need to be stamped by both the engineer and district construction and the submittal cover sheet
will need to be filled out by the engineer and district construction. If district construction does
not need the engineer to review the submittal their will only be one submittal review stamp on the
drawings or calculations and the submittal cover sheet will only have district construction’s
resolution.
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9. Atter filling in the fields close Bluebeam and save. Then check the document back into
Projectwise, by clicking on Check In in the Check In dialog box:

x

General I
—Documents
E= | File Marme
T COM... CT_COM_SDR_9876-5432_01564758-Bearing (1).pdf
J | »
Folder; 01.0 - Projects - AckivelShop Drawing Testh120_Contractor_Submittals (POF)
[T Create new version during Che C I - k C h k I
Version: I ?/

| Check In ' Update Server Copy | Free | Cancel

10. If all the drawings/documents are conforms or conforms as noted, proceed to step 14. If
any of the drawings need to be revised and resubmitted, proceed to step 11.
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Drawing Stamped Revise and Resubmit

11. If any of the drawings need to be revised and resubmitted, the engineer will created a new
version of the submittal to keep as a record of that submittal. To create a new version
right click on the submission in Projectwise and select New>Version:

[[™ J5R_DEv_553

[/* 15R0000_Test

=™ shop Drawing Test

' 100_Contract_Plans (PDF)
110_Contract_Specifications (PDF)
120_Contractor_Submittals (PDF)
130_Engineering_Reporks
210_Construction

220_FHWA
230_Contract_Adminiskr ation
240_Contract_Development

|
ISASASANATASARANANAS

310_Review Documents

* Right click on

241 _Contract_Development_Confidergfal

& B 0156478-Bearing
[7I[E) 0156475-Bearing
[71[E) 0156478-Bearing

Bearing Shop drawings For Bridge 01564 and 01457
Bearing Shop drawings For Bridge 01564 and 01457
Bearing Shop drawings For Bridge 01564 and 01457

Open

Open as Read-Only
Cpen With..,
Markup

Wiew

Check Out

the submission

, and select New>Version

[+ Saved Searches

[I™ test securities

I.-R test securitiesz

L BMAP

01.1 - Projects - Legacy

01.2 - Projects - Reseatch

01.3 - Projects - Research - Legacy
01.4 - Projects - Local

02.0 - Assek - Bridges

#-{ 02,1 - Asset - Signal Intersections
# 02,2 - Asset - Sign Structures
#-_ 03,0 - Imagery

B
ATASARAAGE RN

Issued 9-2014

Refresh Local Copy
Purge Local Copy
Purge Workspace

Cuk
Copy

Figure 125 - Creating a New Version
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12. Next type in the version as shown below. The example below is for a second submission:

Wersion | Comments |

Type in 1st submission

here to tag the 1st

submission

Fiolder
M arne; 120_Contractor_Submittals [PDF)
Dregcription: Contractor Submittalz Working Drawings, Shop Drawings, etc.
Documernt
M ame: CT_COM_SDR_9876-5432_0154E78-Paint Platform. pdf
Descriptian: Faint Platfarm for Bridge 00001
@rsion: | 1zt Subrmizzion | )
Sequence: 1}

Mew version
Wersion:

|2nd Submission

G oK -]\} Cancel ]

Type in 2nd submission
here to tag the 2nd
submission and

then click OK

Figure 126 - Creating a New Version

13. After you create a version you will not see the previous version but it is saved in
Projectwise, however in the version column you will see what version you are on. Next
proceed to step 15 for the email notification back to the Contractor.

i regmaes s amees

e e e e v

2

List |. Geosp
Label {User Defined)

/7 B 0605205-Def

/ Template(Item#-Itkem Mame)

# [B) 0205105-5tructural Steel
# [B) 0156478-Bearing
./ [B) 0154678-Paint: Flatform

atial|

Description

Issued 9-2014

Enter submittal title
armed Steel Ba Deformed Steel Bars Shop drawings For Bridge 01564 and 01457
Skruckural Steel Shop drawings For Bridge 01564 and 01457
Beating Shop drawings For Bridge 01564 and 01457

Paint Platform for Bridge 00001

/

Notice the
version column

127

State .. Sub Category De... Bridges
01-COPEM 1st Submission E Contrackor Sub...
02-CLOSED Contractor Sub...  01564;0
02-CLOSED Contrackor Sub... 015640
01-CPEMN 3rd Submission 3 Contrackor Sub... 015640
01-0PEM 2nd Submission | Contrackor Sub... 00001

Figure 127 - Version Column
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14. Only for submittals where all drawings/documents are stamped Conforms or
Conforms As Noted: Once all the drawings/documents are stamped Conforms or
Conforms as Noted the state of the sumbittal must be changed to CLOSED. To change
the state follow the figure below:

/a 0205105-Structural Steel Structural Steel Shop drawings for Bridge 01564 and 01457 02-CLOSED
_/' a 0605205-Deformed Steel Ba Defarmed Steel Bars Shop drawings for Bridge 01564 and 01457 02-CLOSED

Mew »
Open
©pen as Read-Only
Open With...
Markuy
) i
Wiew
Right Click on | checkou
Check In
the submittal ez
Copy Out
and select Espor..
Change State>Next -
g tart Studio Session...
4 port Dependency: Map(s)...
—— port Dependency: Map(s)...
Drocument Properties l review | Dependency Viawerl Access Ennlrn\l Components
jate Server Copy
View: |<Defaults Feefresh Local Copy
~  Pullige Local Copy
_ L p Works ‘ Property value
urye Workspace CT_CON_SDR_9876-5432_Templ:
|| 120_Contractor_Submittsls (PDF)
CTDOT _Design_Envir
F u F CT_COM_SDR_9576-5432_Templ:
120_Conkractor_Submittals
MIC-Admin
MIC-Admin
MIC-Adrin
Checked In
15k Submission
Set »
Send To 2
Copy List 3
e Change. ..
Properties... )
Set Final Status
Edit attributes for multiple documents Remove Final Shatus
lan_2011a

Figure 128 — Changing the State of a Document
|
Comments |

Erter Camment:

Click OK you
do not need to =]
enter a comment

Y a—
(o 1 Joen |

Figure 129 - Changing the State
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15. Next send an email notification to the Contractor after all the shop or working drawings
have been reviewed. Include a table in the email detailing your comments. Below is an
example of a response for a shop drawing submittal with a revise and resubmit required:

i | 9 [= Project 150-126 Bearing Shop Drawings - Message (Rich Text)

File Message Insert Options Format Text Review
] X s — . @ ggﬂ =2/ 0l ¥ Follow Up ~
_)I - T A ¢ : = ¢ V’ J &

‘? High Importar

,,_
11

Paste . B 7 U | % \ = = = | iE iE | Address Check | Attach Attach Signature
A 7 - o Book MNames File  Item~ A § LowImportan:
Clipboard 1 Basic Text MNames Include Tags
To... |
:l
s
Send

Subject: Project 150-126 Bearing Shap Drawings

We have reviewed the submittal for the Bearing Shop drawings for project 150-126 and find the following:
i

Drawing No. | Status Comment
G-1 Conforms
H-1 Conforms as noted Dimension updates
J-1 Revise and Resubmit | Drawings missing for girders 4 and 5
K-1 Conforms
m}

Please add the updated drawings to the submittal in Projectwise.

Mathew Calkins P.E.

Transportation Engineer 2

Engineering Applications

Connecticut Department of Transportation
860-594-2988

mathew.calkinsi@ctgov

Figure 130 - Email Response to a Shop Drawing Submittal
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6.4.2 Subsequent Contractor Submittal Reviews

CTDOT or Consultant Review

After notifying the Contractor through email that all the drawings/documents have been reviewed
they will revise and resubmit any drawings/documents that were stamped as such. Once they
contact you via email that the revised drawings/documents have been uploaded, the
drawings/documents can be reviewed in accordance with the following:

1. Log into Projectwise

2. Browse out to the project’s 120_Contractor Submittal folder. Then double click on the
submittal file to open. Note: The initial submittal will be updated to include any revise
and resubmitted drawings/documents, a second file will not be submitted:

e o P

= [ Projectivise Explorer Datasources
= |y CTDOT (mjc-admin}

= Documents
= 01.0 - Projects - Active

+ % nnn iR £ 0004-0118
- [ " 0004-0133
\' L 100_Contract_Plans {PDF)

‘ {7 120_Contractor_Submittals (PDF) ’

L LA ENdmeeTng ZReport
+-|_ 210_Conskruction

Browse to your

iment

p roj ect iment_Confidential

ks

L 2EU_FENHIL_HpPILaUuns
+-{_ 330_Design_Data
L= 340_aAdministration
L= 341 _Administration_Confidential
+-{_ " S00_Pre_Design
+- 4 Saved Searches
[ ooos-0122
[ 0007-0182 & 0170-3155
+ ™ 0009-0094
+- ™ 0011-0151
[ 0012-0095
[ 0012-0096
+- [ 0014-0177
+- [ 0014-0183

Lizt | @ Geozpatial

? [B) 0153468-Bearings

Drescription
EBridge Mo 01534 and 01567Bearing shop drawings

Double click
on the file to
open

Figure 131 - Opening a file from Projectwise
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3. When the file opens you will see the revised document or drawing that has been added to
the submittal. Also if you open the submittal cover sheet the Contractor will have
updated the submission information, as shown below:

I & /

CT_CON_SDR_9876-5432_0156478-Bearing_(1).pdf*

aring_(1).pdf

B

start. pdf
df

D-1.pf

E-1.pdf 64 KB

o ot Example of a revised e
drawing

GM-1_2ndSubmission.pdf

110 KE

Figure 132 - Revised Shop Drawings

ITEM NO.: 0156478 SITE NO(s): land 2 BRIDGE NO(s): D1564,01457
- CECOND SLIRBMTICCTAM -
DATE: 9/26113 DATE:
L NOTES: Resubmitting drawing GN-1 fo resolve TOTAL PAGES: 1 NOTES:

CTDOT's comments

hh._ _)
~ Contractor will fill

Response | Reviewed | 5 |5 5|3 5 in this mformatlo__n

Figure 133 - Revised Shop Drawings

4. Open up the revised drawings/documents, review, apply comments if necessary, apply
stamp and save the file.
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5. After the file is reviewed record the resolution for the drawing/document under the
applicable submission as shown below:

. FIRST SUBMISSION “SECOND SUBMISSION
S| opare: 91313 FROM:  Southingion Metal DATE:  9/25/13 DATE:
E To:  Jon Hagert 536:5;;'“"” NOTES: ing drawing GN-1 to resolve TOTAL PAGES: 1 NOTES!
o cc:  District 3 Gonstrustion 31 Main Stroet CTDOTS comments
.E R Flaimile T 06XXx In the second
: e submission line
| " iRl TOTAn PActs: Bim— record the resolution
Dr:‘wlnq nqspgnsa Revlaewed é Eg;g Response Ra;pt::sa Revlnewed g §§§§ Response Ra;m::s
) 815428 " Y 1815428 ”
D-1 9/15/2013  |MJC oo [m]ym]
V.
-1 9152013 |MIC =00 [m] a
GN-1 9/15/2013  |MJC (] | [ 9/26/2013  |MJC O [ |bearings. " " ]
ajo|ia ﬁ- [m] =] =]
Figure 134 - Revised Shop Drawings
6. After the information is filled out, close the form and save. Then close Bluebeam and
select “Check in” to Projectwise.
7. If any of the drawings/documents need to be revised and resubmitted, create a new

version as shown in Section 6.4.1 step 11. If all the drawings/documents are conforms or
conforms as noted proceed to the next step.
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8. Only for submittals where all drawings/documents are stamped Conforms or
Conforms As Noted: Once all the drawings/documents are stamped Conforms or
Conforms as Noted the state of the PDF Package must be changed to CLOSED. To
change the state follow the figure below:

Right Click on

the submittal
and select

# Bl 0z05105-5tructural Steel
# B o605205-Deformed Steel Ba
Template(Item#s ¥

Change State>Next

lan_2011a

Issued 9-2014

Document Properties I_

Wiew, | <Default:

'

Hew

Open

Open as Read-Only
Open With,..
Markup

Wiew

Check Qut
CheckIn
Free.
Copy Cut

Export...
Iinpart
tart Studio Sessian...

W

port Dependency Map(s)..
port Dependency Mapls)i..

Structural Steel Shop drawings for Bridge 01564 and 01457
Deformed Steel Bars Shop drawings for Bridge 01564 and 01457

02-CLOSED
02-CLOSED
01-0OPEM

late Server Copy
Refresh Local Copy
Pullge Local Copy
Purfje Workspace

revlewl Dependency VIEWEII Access Eontroll Compaonents

| Property value

CT_COM_SDR_9676-5432_Templ:

120_Contractor_Submittals (PDF)
CTDOT_Design_Ernvir

CT_CoN_SDR_9876-5432_Templ:

F u F 120_Contractor_Submittals

MIC-Admin

Copy MIC-Admin

Move MIC-Admin

Renam Cherked In

Delete 1st Submission

Modify,

Modify Spgtial Attributes, ..

Add Com

Set 3

Send To 3

Copy List 3

ST Change...
Froperties... et Final Status
Edit attributes For multiple dacuments Remave Final Status

Figure 135 - Changing the State of a Document
Comments |

Erter Camment:

Click OK you

do not need to =]
enter a comment

e,

x|

(o1 Jos

Figure 136 - Changing the State of a Document
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9. Once review is completed send an email notification to the Contractor. Include a table in
the email detailing your comments. Below is an example of a response for a shop

drawing submittal:

HEd92 O |=

We have reviewed the submittal for the Bearing Shop drawings for project 150-126 and find the following:

Mathew Calkins P.E.
Transportation Engineer 2
Engineering Applications

860-394-2988
mathew.calkins@ct.gov

H
Drawing No. | Status Comment
G-1 Conforms
H-1 Conforms as noted Dimension updates
J-1 Conforms
K-1 Conforms
Pleas:

Connecticut Department of Transportation

Figure 137 - Email Response to Shop Drawing Submittal
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Section 7 Digital Review and Commenting

7.1 Introduction
What is a Digital Review?

A digital review is when a document is reviewed in its native digital format or as a digital
copy of the original paper document, and any required markups are placed directly on the
document using a computer and software designed for managing digital reviews. The
documents can always be printed from the review session and the paper copy marked up,
but those mark ups must get transferred back to the digital copy.

Advantages of a Digital Review Compared to Conventional Paper Review

Higher Transparency — Increased Collaboration.

Digital markups are searchable and sortable, by comment, author, etc.

Real time collaboration review process improves turnaround time and quality.
Real time feedback allows easier handling of large amounts of data.
Reduction in time required to compile and resolve comments.

Eliminate document mailing time.

Eliminate shipping cost.

Easily store a permanent digital record on the cloud.

Reduction in overall review time.

©CoNO~wWNE

Types of Reviews:

This manual may be used as a guide to perform a digital document review on any digital
document. Below is a list of examples:

Preliminary Design Plans
Structure Type Studies
Semi-Final Plans

Final Plans for Review
Specifications
Engineering Reports

Review Process:

To help participants of a digital review more easily track the digital review process it has been
split up into six Phases as described below:

Phase 1 — Preparation of the Digital Documents
Phase 2 — Set Up Digital Review
Phase 3 — Invite Attendees to Review
Phase 4 — Digital Review
Phase 5 — Ending the Digital Review
e Phase 6 — Resolve Comments
Each phase and its required steps will be discussed later in detail.

Digital Comments:

Digital documents may be printed to paper copies to facilitate the digital review process.
Reviewers will have the ability to print the digital review documents to paper and mark them up,
however, in the end all comments must be transferred from paper to the digital documents, during
the review session, see Section 7.7.3
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In the case of preliminary contract plan reviews, the original digital documents, with comments,
will become the final record.

Comments associated with a design submission should be applied to the digital documents. Any
email or phone call comments must be applied, by the staff member who received them, to the
correct digital document, use engineering judgment to determine the most appropriate location.

All comments must be placed on the digital documents prior to the end of the session. The
district may review on paper but those comments need to be transferred into the digital review
session in accordance with this manual.

The following video gives an overview of the Digital Review Process. Specific details are found
in this document.

Digital Review Video

7.2 Prerequisites

1. CTDOT is standardizing its digital review process using the document format PDF, and
the software Bluebeam Revu. Bluebeam Revu was chosen for the following main
reasons:

a. Includes a collaborative live review feature (STUDIO) with real time feedback,
enabling all reviewers to comment on the same document at the same time out on
the cloud.

b. Rewvu is cost affective, it is much less expensive to purchase and maintain vs.
competitive software like Adobe Acrobat.

c. Only the Organizer (person setting up the review) is required to have a licensed
copy of Bluebeam. All other attendees can participate in the digital review using
Bluebeam’s free software, Bluebeam VU.

d. Bluebeam is integrated with ProjectWise. This simplifies delivering of the
original review documents and saving the final reviewed copies and their
comments.

e. Easy to use without sacrificing technology.

2. The following table lists the software required in order to organize or participate in a
CTDOT digital review.
Note: The roles stated below are further defined in Section 7.3

Role Software

Organizer — Manages review | Bluebeam Revu Standard Latest Available Version

Projectwise Explorer Latest Available Version

Author — Produces documents | Projectwise Explorer Latest Available Version

Reviewer — Reviews Bluebeam Revu Standard or Bluebeam VU latest available

documents version*

Approver — Reviews Bluebeam Revu Standard or Bluebeam VU latest available
version*

*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT
organizing a review). When a staff or consultant is invited to a digital review and they do not
have Bluebeam VU or a licensed copy of Bluebeam Revu Standard installed on their computer, a
link to download Bluebeam VU will be included with the invitation. Note: An IT administrator
may have to install this software on your computer.

3. All CTDOT digital review participants are required to complete the steps provided
in Appendix A prior to organizing or joining a review session. Completing these
steps will standardize the Bluebeam format across all CTDOT digital reviews.
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7.3 Digital Review Workflow

&
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PHASE 1 PHASE 2 PHASE 3 PHASE 4 PHASE 5 PHASE 6
Figure 138
All CTDOT digital review participants are required to complete the steps provided in
Appendix A prior to organizing or joining a review session. Completing these steps will
standardize the Bluebeam format across all CTDOT digital reviews.
Below is the workflow for a typical Digital Design Review.
Step | Role | Task | Section
Phase 1 — Preparation and Delivery of the Digital Documents
11 Organizer | Coordinates the organization and preparation of the review Section 7.4
documents. Request all Authors to upload their review
documents into Projectwise.
1.2 Author Prepare and upload review documents into Projectwise. Then | Section 7.4
notify Organizer this step has been completed.
1.3 Organizer | Check that all review documents have been prepared and Section 7.4
uploaded correctly into Projectwise.
Phase 2 — Set up Digital Review
2.1 Organizer | Change the state of the review documents in Projectwise to Section 7.5
“Review”. Starts a Bluebeam review session.
Phase 3 — Invitation to Review
3.1 Organizer | Create a Digital Review memo, which includes a link the Section 7.6
digital review session, and send it to all Reviewers. Also
send paper to District Construction.
Phase 4 — Digital Review
4.1 Reviewer Join the review session by clicking on the link provided in Section 7.7.1 and
the review memo. Familiarize yourself with the review Section 7.7.2
session layout.
4.2 Reviewer Set Status to “Reviewing” Section 7.7.3
4.3 Reviewer Review the documents in the Bluebeam review session and Section 7.7.3
place comments on documents as necessary.
4.4 Reviewer | When finished reviewing, Set Status to “Finished” Section 7.7.3
Optional: Notify supervisor (Approver) to review your
comments. If supervisor approval is not needed, skip to Step
4.9
45 Approver | Join session by clicking on the link in the review memo. Section 7.7.3
Familiarize yourself with the format of the Bluebeam review
session layout.
4.6 Approver Set status to “Reviewing” Section 7.7.3
4.7 Approver Review your subordinate’s comments. Section 7.7.3
If you would like to review the documents yourself, markup
the documents with comments. (Step 4.1 —4.3)
4.8 Approver | Set Status to “Finished” and notify Reviewer that you have Section 7.7.3
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finished.

4.9 Reviewer Create a comment report memo for each document in the Section 7.7.3.1
review session. Then send the memo for each document to
that document’s author.

Phase 5— Closing the Digital Review

51 Organizer | Close the Bluebeam review session and check the documents | Section 7.8
back into Projectwise.

5.2 Organizer | Change the State of the documents to “REVIEW Section 7.8, Step
RESOLUTIONS” 5
Phase 6 — Resolve Comments
6.1 Organizer | Notify Authors that they can review the markups on their Section 7. 9.1

review documents in Projectwise. Provide them with a link
to the folder in Projectwise.

6.2 Author Open your document(s) from Projectwise. Section 7.9.2
6.3 Author For each comment on your document, type a final resolution. | Section 7.9.2
6.4 Author After all resolutions are applied to comments, create a Section 7.9.2

response to comment memo for your review document(s).
Send the response to comments memo to all applicable

personnel.

6.5 Organizer | Create a “Response to Review Comment Memo™ and send to | Section 7.9.2
all necessary staff. This memo shall include a link to the step 8.
folder in Projectwise where the review documents are
located.

6.6 Organizer | Change the state of all the review documents to “Review Section 7.10

Complete” to make all review documents read only.

7.4 Phase 1 - Digital Document Preparation

7.4.1 Organization
The Organizer shall organize the review documents as detailed below:

Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Plans - Shall be in discipline subsets. The Organizer is responsible for assigning each
Author a subset number in accordance with Section 1.10 or Section 1.11

2. Specifications — Each discipline shall combine all of their specifications into (1) PDF
document. Each discipline’s specifications will remain separate throughout the review
session; they will not be combined with the other discipline’s specs.

3. Other Documents — Shall be individual PDF documents.

4. Plans must be sent to District Construction, but any comments they make on the paper
plans must be transferred to the digital plans in accordance with this manual.

Other Reviews

1. The only requirement for the organization of other types of reviews is the documents
must be in PDF format.

7.4.2 Preparation and Format

Authors shall prepare their digital documents in accordance with the following:
Preliminary Contract Document Reviews — PD, SF, FPFER, etc.

1. Plans:
a. Shall be in PDF format
b. Indiscipline subsets
c. Sized34”x22”
d. Shall not have watermarks, sheet numbers or be digitally signed.
2. Specifications:
a. Each discipline shall combine all of their specifications for review in (1) PDF
document.
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b. Sized 8.5”x11”
3. Other Documents:
a. Shall be in PDF Format

Other Reviews

1. Documents:
a. Shall be in PDF Format

7.4.3 Uploading

Authors shall upload their digital documents into Projectwise in accordance with the following:
Preliminary Contract Document Reviews — PD, SF, FPFR, etc.

1. Launch Projectwise and log in.
2. Browse out to the project this review is for and open up the 310_Review_Documents
folder:

B ProjectWise Explorer V8i (SELECTseries 4)

Datasource Folder Document View Tools Window Help
i ™| =% Op o EEEE @ : @% - search (D

(]:I - E{) - Lf_l Address [ puwe\\ctdot. projectwiseonline.com: CTDOT\Documents'01.0 - Projects - /

=gl ProjectWise Explorer Datasources Ind List | @ Geo
- [ CTDOT (mjc-admin) LI
217" Documents
-4 01.0 - Projects - Active Browse out to the
0004-0116 & 0004-0113
4 L oo0a0t33 applicable project
-4 100_Contract_Plans (P
-1 110_Contract_Specifications (PDF) 1
-4 120_Contractor_Submittals (PDF) and CIICk on the
| 130_Engineering_Reports H
#-=" 210_Construction thls fOIder
-7 220_FHWA
-4 230_Contract_Administration
-1 240_Contract_Development
-4 241 Contract_Development_ @ nfidential
42" 310_Review_Documents
=y Permit_Applications
-4 330_Design_Data
-4 340_Administration
-4 341_Administration_Confidential
#-4=" 500_Pre_Design
- Saved Searches

-[7% 0005-0001
- [1% 0006-0122 1

e

e I —

[-|7% 0007-0182 & 0170-3155 Project Properties
e -

EJ Lo* 0009-0094 Real (Werkflc

e

E

o-% 0011-0151
H- [ 0012-0095 MName
0.7 0012-0096 | ot Elimn bomrm

Figure 139 - Projectwise Project
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3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

<< ProjectWise Explorer V8i (SELECTseries 3)

Datasource Folder Document Tools  Window Help

Tl # 2 o ©@ @A - |searcn[ v‘(Interlac:kmm,nng(one v  vidw| Document v

e B Address‘l; pur\ctdot projectwiseonline.com:CTDOT\Documents\0L.0 - Projects - Active\0004-0116 &_’wusam,pml v ce

Select View> [Exp\nrder D)atasnurces & [E i |® Geospetel|
mjc-aamin,
Label (User Defined) Description Main Category | Sub Category
Toolbars>Interface

01.0 - Projects - Active

of the Interface box 3% s (1) Select

[ 100_Contract_Plans (PDF)

is not displayed oo CTDOT_Doc_Code

{7 120_Contractor_Submittals (PDF)

[ 130_50i_Archsesiogical_Misc Reports POF) ) § the |nterface
[ 210_Construction

(= 220_FHWA

| 230_Contract_Administration

{7 240 _Contract_Development

[’ 241 _Contract_Development_Confidential

109 310 _Preliminary_Design_Documents(PDF)
L 320 Permit_Applications

| 330_Design_Data
[ 340_Administration

{7 341_Administration_Confidential
[ 500_Pre_Design
@ saved Searches
{* 0003-0094
{*% 0011-0151

- 00140177 (2) Dl'ag and dl'Op

{* 00140183

s file into this area
e in Projectwise

{*% 0025-0118
Figure 140 - Uploading Documents into Projectwise
4. Select Advanced Wizard

# Select a Wizard

@ |- T

Mo Wizard Advanced
Wizard

[ ] Make this wizard the defautt.

Figure 141 - Advanced Wizard
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5. Click next until you get to the attributes screen shown below and enter the correct

attributes from table below, and then click next until the document uploads.

Advanced Document Creation Wizard

Define Document Attributes

Discipline
cT v

Main Category Main
CON v Contra:

Sub Category
PRE v

Project Number(s)
0004-0116_0004-0118

You should define environment specific document atiributes:

Sub Category Descrip

Plans_01 - Preliminary Pihs (2) Type

X

(1) Select °
appropriate
Category Descri
ct Plans & Specs

appropriate

Label (User Defined)
30% -01-General v

Description

[1-General Preliminary Design Plans

CT Code {Auto Fill In)

(3) Click Next

CT_CON_PRE_0004-0116_0004-0118_30% -01-General

\sset Tags
Signal Intersections

| \ v
>

< Back Next > Cancel

Figure 142 - Attributing a Document

The Label attribute shown below must start out with 30%, 60%, 90%, or 100% where applicable.
This allows for the documents to be sorted together in Projectwise. See Figure 147 for an

example.
Document Attributes
Document Disc. Main Sub Label Description
Category | Category
30% - 01-General, 30% - 03-Highways,
Discipline etc. .
Subsets CT CON PRE 60% - 01-General, 60% - 03-Highways, 01-General Semi Final Plans...
etc.
90% - 01-General, 90% - 03-Highways, etc
R 30% - HWY- Specs, 30% - SB-Specs . -

Specification CT CON PRE 60% - HWY- Specs, 60% - SB-Specs Highway Semi Final Specs,
PD Statement CT DOC MDO 30% - PD Statement Preliminary Design Statement
Cost Estimate CT DAT EST 90% - Cost PD Cost Estimate
A Bike CT DOC MDO 30% - Bike Assessment i.e. PD Bike Assessment

ssessment

g?ﬁrl‘zdsir cT DAT EST 90% - Calendar Day i.e. SF Calendar Day Esitmate

Other Reviews

Table 2 - Projectwise Document Attributes

1. Launch Projectwise and log in.
2. Browse out to the folder where the digital documents are to be stored.
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3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a
time into Projectwise as shown below:

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface. Then
you will be able to select the correct Interface.

=< ProjectWise Explorer V8i (SELECTseries 3)

Datasource Folder Document| Tools Window Help

; y | 2| D - = =

il =3 [Hl @ @ 8- searan[ | Bk interface CTDOT_Dac_Code | viw| Document v
| E

‘address [ pw:\\ctdot, projectwiseonline com:CTOOT\Documents\01.0 - Projects - Active\0004-0116 &!4-0118\310_F‘rel v [P Go

Select View> Explorer Datasources & [E st | @ Goosoal
(mjc-admin) Label (User Defined) Description Main Category | Sub Category
01.0 - Projects - Active

Toolbars>Interface
of the Interface box %335 s (1) Select

[ 100_Contract_Plans (PDF)

is not displayed L i) CTDOT_Doc_Code

{7 120_Contractor_Submittals (PDF)
[ 130_s0_archaeoiogical_isc reports 7oF) 3§ the [nterface
[ 210_Construction
[ 220 FHWA
{7 230_Contract_Administration
| 240_Contract_Development
| 241_Contract_Development_Confidential
108 310_Preliminary_Design_Documents(FDF)
{7 320 Permit_Applications
| 330_Design_Data
| 340_Administration
[ 341_Administration_Confidential
[ 500_Pre_Design
4 saved Searches
{* 00090094
{*% 0011-0151

- 00140177 (2) Dl'ag and dl’Op

{1 0014-0183

B e file into this area
e in Projectwise

Figure 143 - Uploading Documents into Projectwise
4. Select Advanced Wizard

/" Select a Wizard

Document Creagdh VWizards

& 3 |-

Mo Wizand Advanced
Wizard

[ ] Make this wizard the defaut.

Figure 144 - Advanced Wizard
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5. Click Next until you get to the attributes screen shown below and enter the correct
attributes for the review documents and then click next until the document uploads.
Make sure a good label and description are entered.

Advanced Document Creation Wizard

Define Document Attributes
You should define environment specific document attributes. j:$

B3

[:cipline . (,’ (1) SE‘IE‘Ct

Main Category Main Category
COM W |Currt|E|c:t Flans & Specs |

Sub Category Sub Category [ ]
\JSDH v|j [Approved Shop Jlen (2) Type In

/ these

Project Number(s)

| 0004-0116_0004-0118 ‘ |
(-Label {User Defined) \ =
|hem#t 0605252 v |
Description
Structural Steel Shop Drawing Review
. J/

CT Code (Auto Fill In)
|CT_CON_SDR_0004-0116_0004-0118_ttems 0605252 |

——— |
: DOT Asset T
(3) Click sset Tags |
Signal Intersections | |
| | [ >
£ il ] =
| <Back Ned> | ) Cancel |

Figure 145 - Uploading Documents
6. Notify the Organizer that you have uploaded all your documents into Projectwise.
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7.5 Phase 2 - Set Up Digital Review

The Organizer shall set up the review session in accordance with the following: The example
below is for initiating a Semi-Final review but can also be followed for other types of reviews.

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.

2. Browse out to your project’s 310 Review_Documents folder. (For other reviews browse

out to the folder in Projectwise where the documents are located.)
B8 ProjectWise Explorer VBi (SELECTseries 4)

Datasource Folder View Tools Window Help
i MR- @ : @ - search IO
- - L’J Address | pw:\\ctdeot.projectwiseonline.com: CTDOT\Documents\01.0 - Praojects - £

List | @) Geo:

Label (User Defir

# B 30% - Hig

Document

Op &p

=) ProjectWise Explorer Datasources -

2l CTDOT (mjc-admin) I

E|1._. Documents

: @_] ~ 010 - Projects - Active )
+]- = 0004-0116 & 0004-0118
= L_’_': 0004-0133
_ 100_Contract_Plans (P
110_Centract_Specifications (PDF)
120 Contractor_Submittals (PDF)
130_Engineering_Reports
210_Construction
220_FHWA,
230_Contract_Administration
240_Contract_Development

m

241 Contract_Development_®nfidential

310_Review_Documents
_Permit_Applications
330_Design_Data
340_Administration
341_Administration_Confidential
- 500_Pre_Design

-4 Saved Searches

F-L% 0005-0001

[-L " 0006-0122

[#-L" 0007-0182 & 0170-3155
L% 0009-0094
[
£
£

LRl o Lttt

4|

Project Properties

Real kfl
b7 0011-0151 @

[ 0012-0095
-1 0012-0096

Name

Cbmr Eilbrr bamen

Figure 146 - Preliminary Design Documents Folder

3. Select all the documents to be included in the Bluebeam review session.

- SearchL;Q v‘ [.';'- Interface|5ub Category 1 V| View‘Da(ument v
seonline.com: CTDOT\Documents\06.0 - ProjectWise Administration\01 - Administratorsih | D Gao
e List | @ Geospatial

Label Description Main_Cat Sub_Cat Cat_Description

/ a 30% - 01-General 01-General Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
,/ a 30% - 03Highways 03-Highway Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
,/ a 30% - 04-Traffic 04-Traffic Preliminary Design Plans CON PRE Plans & Specs_01 - Preliminary
7 a 30% - 05-Structures 05-5tructures Preliminary Design Plans con FRE Flans & Specs_01 - Preliminary

30% - PD Statement Project 120-086 PD Statement DoC MDO Misc Documentation

# |2 60% - 01-General 01-General Semi Final Plans CON FRE Flans & Specs_01 - Preliminary
V4 a 60% - 03-Highways 03-Highway Semi Final Plans CON FRE Flans & Specs_01 - Preliminary
V4 a 60% - 04-Traffic 04-Traffic Semi Final Flans CON FRE Flans & Specs_01 - Preliminary
V4 a 60% - 05-Structures 05-Structures Semi Final Plans CON FRE Plans & Specs_01 - Preliminary
# B60% - Cost t Estimate -

/a 60% - HWY-Specs Highway Semi Fin Select a" docu ments 5pecs_01 - Preliminary

Figure 147 - Select Documents to be Included in Bluebeam Review Session
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4. Change the state of the documents to “Review” as shown below:
IMILILAU IO CUMENTSWUB.U - FIOJECTWISE AQMINISTTAUIONWL - AQMINISTIATOTS\N ¥ | [ @y

| Lst | @ Geospatial |

Label Description

# [B) 30% - 01-General 01-General Preliminary Design Plans
/ 30% - 03-Highways 03-Highway Preliminary Design Plans
# B 30% - 04-Traffic 04-Traffic Preliminary Design Plans

/ 05-5tructures Preliminary Design Plans
7 6 PD Statement

e

e

I

MNew »
Open
(1) Right click on the
Check Out
: documents and select
g ee ] 1]
1 Copy cut Change State>Next
rts (PDF) Export...
-Slzjr-t Studio Session...
lential
+(PDF) Up
Refresh Local Copy
Purge Lacal Copy
jstties | Photo Preew | Dependency Service | Acces:
ation Project)
rts (PDF)
GEl Delete
GEN  Modify...
GE! Modify Linear Attributes. ..
ential GE Modify Spatial Attributes...
lential
) aE Add Comment
ASS|  set
ASS|  SendTo
ASS Copy List To
ASS
De:
Desi
Desit——
Desit SetFinal Status
Desit  Change filename to CT_Code Re Final Status
Desi
DEEI Edit attributes for multiple documents
esii
Desit  Old Audit Trail Report

Design - Dighally Signed

[p— AW a1 ITH

Figure 148 - Changing the State to Review

Then click OK next on the box that pops up. The documents will now be in the Review
state.

# Bl 30% - 05-Structures

05-5tructures Preliminary Design Flans Plans & Specs_01 - Preliminary Acrobat PDF REVIEW COMPLETE
/ 30% - PD Statement Project 120-086 PD Statement Misc Documentation Acrobat PDF REVIEW COMPLN

-01-General
- 03-Hi

- Preliminary Acrobat PDF REVIEW
- Preliminary Acrobat PDF REVIEW
- Preliminary Acrobat PDF REVIEW
- Preliminary Acrobat PDF

PDF

Notice State Column, T
the state is Review

Figure 149 - State of Documents
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5. Next right Click on the documents and select Start Studio Session:
s o

e e LT -

line.com: CTOOT\Documents\06.0 - ProjectWise Administration\01 - Administratorsih V| ’ Go

Label

NRNNNS
e]ie]ie]ic)

/

Right Click on the
documents and select
"Start Studio Session”

“0r)
._Reports (PDF)

Confidential
Jments{POF)

itial

<

£ List | @ Geospatial |

# B 30% - 01-General
# B 30% - 03-Highways
# B 30% - 04-Traffic

# [B) 30% - 05-Structures
# B 30% - PD Statement

Select View

Description

01-General Preliminary Design Plans
03-Highway Preliminary Design Plans
04-Traffic Preliminary Desian Plans
05-5Structures Preliminary Design Plans
Project 120-086 PD Statement

Mew

Copy Cut

*port. .

Refresh Local Copy
Purge Local Copy

Cut

Copy
Paste...

Figure 150 - Start Studio Session
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6. In the figure below type in a review session name shown in the table below:

Review Review Name
Preliminary Design (30%) Project XXXX-XXXX PD Review
Structure Type Study Project XXXX-XXXX Structure Type Study Review

Semi-Final (60%)

Project XXXX-XXXX SF Review

Final Plans for Review
(90%)

Project XXXX-XXXX FPFR Review

Other

Include Project number if necessary and give a good description of
the review

Also in the figure below make sure all the options are checked as shown:

Start Studio Session

S

( Session Name: |Project 0120-0085 SF Review )4—

(1) Type in the

File name Path =
CT_CON_PRE_D120-0086_60% - 01-General pdf PWctd: s es s IO n N a m e
"% | CT_CON_PRE_0120-0086_60% - 03-Highways pdf PW ctd:
CT_CON_PRE_0120-0086_607% - 04-Traffic pdf PWctd: )
& | CT CON_PRE_0120-0086_60% - 05-Structures pdf PW ctdot projectwiseanlin. .
CT_DAT_EST_0120-0086_&0% - Cost pdf PW ctdot projectwiseanlin...
¥ | CT_CON_PRE_0120-0086_807% - HWY-Specs pdf PW ctdot projectwiseanlin. ..
X

Add Open Files

(2) Make sure

ll

Ciptions

~ i« these options are °

Version: | Studio v2

v| selected

Permission

Save As

Print

Markup

] Add Documerts

[] Restrict Attendees by E-mail Address

(3) Click

\ E-mail Motffications _/‘
[ ok |) cancel
Figure 151 — Initiating a Review Session
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7. The next dialog box is where you specify where the review session invitation is sent. The
invitation will be an email from Bluebeam that includes a link to the review session.
Since we want to invite reviewers using a memo, the invitation will only be sent to the
Organizer so they can copy the review session link and include it in the memo.

In the dialog box below enter your email address so the link to the review session is
emailed to you so you can include it in the review memo. (See Section 7.6- Phase 3
Invitation to Review Session for information on how to include this link in the review
memorandum)

E5510N INYITaOon

Session Information

Session Name:  Session

Session ID:  731-180-223

Invitees

E-mail Address

Select E-mail Address

B ()

g . CE—rnaiI: athew calkins@ct gov |

) =3
|
Type your email [
address and click |
OK
|
Mote: A Session is limited to 500 Attendees. Cancel

Figure 152 - Adding Email Address to Studio Session
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8. Below is an example of the review session email sent from Bluebeam to the organizer.
The link to the session is circled below and can be copied and pasted into a review memo
which is then forwarded to all necessary staff. If the review was set up for a less formal
review, the email from Bluebeam containing the link can be forwarded to reviewers or
the link copied and pasted into an email.

= | d & v |5 You're Invited - Message (HTML) o @8 =2
Message )
x n 0 3 (- L3 Mark Unread a‘l n
SO e o D N B rize ~ & \
g . Deiete Reply Reply Forward B Mov ¥ Transiate Zoom Edit
S Al . ¥ Follow Up ~ v <~ Message
From: Bluebeam Sent: Tue 6/12/20128:55 AM
To
Ce
Subject You're Invited

You're Invited Link to Review
Session

You have been Invited by M. Calkins AEC Applications
( ) ag am Studio™
session. Please click the session lick below to join

Session Name: Project #120- 6 30% Review
Session ID: 308-420-961

Session URL: S .l. UG ,. o

If you are new to Studio, you must Install either Bluebeam Vu or Bluebeam Revu (8.5 or higher)
to access and add markups to Studio sessions. Choose a 1load link below to get started.

A beautifully designed, free PDF viewer that allows you to add markups to PDF
files only in Studio sessions.

. A powerful PDF creation, markup, editing and collaboration solution. Download
[ »

Click on a photo to see social network updates and email messages from this person. > v

Figure 153 - Studio Session Email
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7.6 Phase 3 - Invitation to Review Session

The Organizer shall invite Reviewers to the review session in accordance with the following:
Preliminary Contract Document Reviews — PD, SF, FPFR, etc.
The invitation to the digital review will be a PDF of a review memorandum that includes:

1. Atable of all documents in the review session along with those documents authors.

2. Links to relevant documents that are not included in the review session but still need to
be referenced. These documents shall be located in Projectwise and Projectwise links
shall be included. (Not shown in the example below)

3. Alink to this manual (Digital Project Development Manual)

4. Alink to the Review session.

The PDF of the review memorandum shall be emailed to all Reviewers. Paper plans must be sent
to District Construction for their review. Any comments they make must be transferred to the
digital plans in accordance with this manual. The memorandum for a preliminary design review
of contract document can be some variation of the following but must the things shown below:

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modem Roundabout
Route 188 at Route 334 and Holbrook
Road
Town of Seymour

ﬂ_{_{_’_m:{_f_l__l‘dﬂm date: December 11, 2012
10: THOSE LISTED BELOW from: William W. Britnell List all documents

Transportation Principal Engineer
Bureau of Engineering and Cunslrur.liun/ in the review and

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment fayour

et the oraimnary Ses roviow ot s prfect. pese reven and snm vou sgone and who authored them

recommendations to the following Preliminary Design Documents included in the digital gaffew referenced

below, by Tuesdav, January 8, 2013

(| | )
Document Document Author -
[o1General [ Righway Design ) Include a link

Comments and recommendations shall be applied to the documents in M to the Digital Project
d
peument Cj_i ital Project Development ManuD Development Manual

The following is a link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session

t Invitation to live Review of the Preliminary Design of this prmeaﬁ—
Units that receive paper plans can review the documents on paper, but must transfer their comments to the Include the link

digital pdf documents in the above review session. - .
to the review session

A Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 at 1:30pm in Room 3130 of
the Department’s Administration Building, 2800 Berlin Turnpike, Newington.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594-
3342 should you have any questions or require additional information

DISTRIBUTION:

Thomas ). O'Hala Leo L. Fontaine - Michael F. McDonnell

John DeCastro Gregory M. Dorosh

Charles 5. Harlow - Mark F. Makuch Sohrab Afrazi

Delois L. Barnes Donald Ward - Mary Bajer - Hard Copy to Follow
WMark W. Alexander - Kimberly Lesay Colleen A. Kissane

Leo L. Fontaine - Edgardo D. Block
Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Copy to Follow

Attachments
Stephen Hall/sh

Figure 154 - Sample Review Memo

Other Reviews
Invitations for less formal reviews may not require a memo. We recommend an email be sent
that includes the links to this manual and the review session.
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7.7 Phase 4 - Digital Review

7.7.1 Joining a Review Session

To join a review session, click on the link provided in the review memorandum for preliminary
design reviews, or the email for less formal reviews. Below is an example of a preliminary
design review (semi-final), the link to the review session is included in the memo that was

emailed to all the reviewers.

1. Open the email from the Organizer and open the review memorandum.

<

! O | @ From

Ssubject

4 Date: Today
.4 0 Bourgain, Bruce R

C

Project 120-08& Semi Final Review

Received Size
) Mon 10/1/2012 7:36 AM 51 KB
Mon 10/1/2012 1:40 AM 95 KB

R
4 Date: Last Week

(-4 DOTWebmaster

(4 DOTWebmaster

[=4 Savader Asset Advisors LLC

1es DPD Manual

(1) Open the email
from the Review
Organizer

Bentley Technical Support
‘I, DOT Molly Watts@bentley.com
Pratt, William S

Richard, Elaine H

Rinaldi, John §

Robert Brickley

Rinaldi. John §

DRDDLD

(2) Open the Review

Memorandum

PilePro
Chhabra, Greg M

Molly Watts@bentley.com
,_‘¢ i Hanley, Richard C

<1IDBADT@RENTI EV N

DEDEDRE

Issued 9-2014

RESHQ3 Conf Room 3130, DOT  Accep’

HETBE COTTErenee eetimy

ConnDOT eAlert: News from the Con|
ConnDOT eAlert: Construction News
Eloomberg Public Finance Conferen
RE: AEC Applications Database
ConnDOT eAlert: Construction News
ConnDOT eAlert: Construction News
Before it's too late

RE: proj 25-138: Pilot projectwise Ch,
RE: Code Changer

FW: Bluebeam PDF problem

How did we do?

RE: ST Mumber: {ticketno:[800146157¢
P 10:30

RE: [GWGA] CT DOT DDE question
RE: [GWGA] CT DOT DDE question

RE: Projectwise
JFM

VAC 09/28/2012

sinar: Mext Gen Imag

10T DDE question

- —.e.. Board
: Smart Board
Webinar Oct 2: Designing Combined
Using the 8'X4' interactive board in
RE: ST Mumber: {ticketno:[300146157¢

=~ | * ¥ |+ Project 120-086 Semi Final Review - Message
File Message Bluebeam ProjectWise
) il to: A, - & M :
) x Y 3 $ ﬁr\leetmg (=8 Mew e-mail to: j [ Rules (-3 Mark Unrez
- =8 Reply All -] N| OneMote B Categorize
—E e L. EE
~ Delete Reply Reply Forward f - Move
& Junk A 3 More (23 test - [ Adions~ ¥ Follow Up-
Delete Respond Quick Steps Move Tags
From: Bourgoin, Bruce R
To: Calkins, Mathew 1
Cc
Subject: Project 120-086 Semi Final Review

Please read the attached Digital Review Memorandum for State Project 120-086
O]

FOF

Project 120-086
Semi Final Rev...

Bruce R Bourgoin, P.E.

Transportation Supervising Engineer

Division of Design Services

Architecture, Engineering & Construction Applications
Connecticut Department of Transportation

860-594-2760

Bruce.bourgoin@ct.gov

Bluebeam PDF problem

ST Mumhar fickatnn RONTAR GTATL

Figure 155 - Review Memorandum
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2. Click on the link to the Review Session.

STATE OF CONNECTICUT ubject:PRELIMINARY DESIGN REVIEW
DEPARTMENT OF TRANSPORTATION Project No. 0124-0162
Rotary Upgrade to Modem Roundabout
Route 188 at Route 334 and Holbrook
Road
Town of Seymour

memorandum date: December 11, 2012

10 THOSE LISTED BELOW from: William W. Britnell
Transportation Principal Engineer
Bureau of Engineering and Construction

Attached are the Preliminary Design Statement and the Bicycle and Pedestrian Needs Assessment for your
use in the preliminary design review for this project. FPlease review and apply your comments and
recommendations to the following Preliminary Design Documents included in the digital review referenced
below, by Tuesday, January 8, 2013:

[ Document | Document Author |
[01-General | Highway Design

Comments and recommendstions shall be spplied to the documents in accardance with the following
document
Digital Project Development Manual

The following is @ link to a live review of the 30% Preliminary Design of this project. Click on the following
link to join the review session.

t Invitation to live Review of the Preliminary Design of this W.EDA_

Units that receive paper plans can review the documents on paper, but must transfer their comments to the Click on the link
digital pdf documents in the above review session
& Preliminary Design Meeting is scheduled for Wednesday, December 19, 2012 at 1:30pm in Room 3130 of to the review session

the Department's Administration Building, 2800 Berlin Turnpike, Newingten.

Review comments must be applied to the electronic documents and comment memos must be sent to
Highway Design prior to January 8, 2013. Please contact Matthew R. Vail, Project Engineer, at (860) 594-
3342 should you have any questions or require additional information

DISTRIBUTION:
Thomas J. O'Hala Leo L. Fontaine - Michael F. McDonnell
John DeCastro Gregory M. Dorash
Charles 5_Harlow - Mark F. Makuch Sohrab Afrazi
Delois L Barnes Donald Ward - Mary Baier - Hard Copy to Follow
Mark W. Alexander - Kimberly Lesay Colleen A. Kissane

Leo L. Fontaine - Edgardo D. Block
Lewis 5. Cannon - District 4 {Acting District Engineer) - Hard Capy to Follow

Attachments
Stephen Hall/sh

Figure 156 - Link to the Review Session
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3. Click Allow on the box that pops up in Internet Explorer.

Internet Explorer

Do you want to allow this website to open a program on
your computer?

From: studio_bluebeam com

Program: Bluebeam Revu

Address: bluebeam:/fioin/380-450-187

Always ask before opening this type of address

click —» &) =

l--" Allowing web content to open a program can be useful, but it can
@ paotentialty ham your computer. Do not allow it unless you tust
= the source of the content. What's the risk?

&

Figure 157 - Accessing the Review Session

4. Bluebeam will launch. If this is your first time into a review session, create a Studio
account. Enter in your state email address and a password. In the name type in your First

Initial then Last name and unit. See below for an example.

— - . Type in email address
Create Studio Account @
E-mail: mathew calkins@ct gov / T e in Password
Password: "— yp
Confirm: -
) Parv— /Type in User Name
se I ect Name: M. Calkins AEC Applications
\ @NlowmheruserstoseewEmall c“ ck OK
Login with Existing Accourt
Figure 158 - Studio Session Account
Issued 9-2014 153
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If this is not your first time in a review session, enter you studio log in information as shown
below:

Please review and apply your and recom d ta the Semi Final documents in
the review session referenced below by September 28, 2012, Comments and recommendations
shall be applied fo the documents in accordance with the following document. This document
contains Instructions for steps that need to be completed before joining the review sesslon above.

Digital Deslon Review hanua)

The following is a link to a live review of the 30% Praliminary Design of this project. Click on the
fallowing link to join the review session.

Invitation to live Review of the Prelimin: sign of this projec

The Semi Final Design M

Depart e Ad
E-mail: . calkins @ct
Please contact Project B mathew calkins @ct aov
assword:
DISTRIBUTION:

Highway Design Remember password Lost Password

Hydraulics
Construction

Create Account QK Cancel
Mschmerts Lok ] ))cance |

Malhew Calkins/co
cc: James H. Norman

Enter your studio
session email and

password and click
OK

Figure 159 - Review Session

5. If this is your first time into a review session you must import the CTDOT Bluebeam
Profile, See Appendix A
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7.7.2 Review Session Layout

When you enter a Bluebeam review session you will see the tab below located on the right hand
side of the screen. This tab displays the attendees of the session, a list of documents in the
session, and a record of all actions that take place in the session. On the bottom of the screen
you will see the list of all comments placed on a document. If this bottom tab is not open, click
on the blue half circle with the white dot in the middle. On the left of the screen you will find the
commenting tools. The commenting tools in the list must be used because they have been set up
or CTDOT use. Bluebeam’s default commenting tools will not be set up for CTDOT use.

M L 13 LR B TND A~ |

@ CT_CON_PRE-SF_0120-0086_01-Gene... = # CT_COM_PFE s

. . " DEPARTMENT OF TRANSPORTATION ({ Status in the
B e | “Comment tools INDABOUT AT SALEM_FOUR CORNERS review session
» oy %

e

ars

Documents in the
review session

i ';} c% og ug |

§

-
R

==

)| 01200086 [

Click here to open
up comment tab

List of Comments

Figure 160 - Review Session Layout

All comments that are made get saved instantly to the Bluebeam review session; you do not need
to manually save any comments. You can only delete comments you have made.

You can leave and rejoin sessions as many times as you want as long as the review session has
not been closed. The review session will be closed by the organizer in accordance with the date
on the review memo.
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7.7.3 Reviewing

This section shows the procedures for reviewing and commenting on documents in a digital
review. Reviewers may print digital review documents to paper and mark them up; however,
they must transfer these comments onto the digital review documents in accordance with this
section.

In the case of preliminary contract plan reviews, the original digital documents, with comments,
will become the final record.

Comments associated with a design submission should be applied to the digital documents. Any
email or phone call comments must be applied, by the staff member who received them, to the
correct digital document. Use engineering judgment to determine the most appropriate location
for all comments.

All comments must be placed on the digital documents during the review session.

Reviewer
1. First set your review status to Reviewing by clicking on the drop down shown below:
Note: If you leave the session and return your status will stay as Reviewing.

Settings

Set Status

Figure 161 - Set Status to Reviewing
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2. Next select a document to review from the studio session tab.

REPD_D120-0086_D3Highways @ CT_CON_PRE-PD_0120-D086_05-Stri...

- Mtendees
& M Corms TE 2 4EC Agpbcstio... C

"SUBSET 05" - "STRUCTURES"
INDEX OF DRAWINGS

Select a docume
to comment on

Figure 162 - Selecting a Document to Comment On

3. Select a commenting tool from the tool chest and mark up the plans. Below are the

commenting tools a CTDOT user will have available to them.in Bluebeam.

Tools

T Review Tools

r

T |insetted Tex
é Text Box
& Callout
: Flag

{ Line

rﬁ—ﬁ Rectangle
Q Hlipse
% Palygon
@ Cloud

{ Pen
Highlight

.
a Length Measurement  |2in
a

Area Measurement

orking Drawing Revie
v CTDOT As Built Tools

Figure 163 - Bluebeam Commenting Tools
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MUST READ BEFORE PLACING COMMENTS

Comment tools: Text Box, Callout, and Flag are considered text tools but a text note can be
added to any of the other comment tools by double clicking on the markup after you place it. The
following figures show the correct way and incorrect way to add text to a non-text comment tool.
The text note box must be closed after the comment is made by clicking on the X in the top
right corner of the note.  The example below shows a note being attached to the rectangle tool
the correct way:

Correct Way

/ 5.L.5 (PHASE 11)
/ TURF ESTABLISHMENT
ON 6" (MIN.) TOPSOIL

(Hm) (1) Place rectangle

S.C.S (PHASE 1II)
S.C.S (PHASE I)

I05, Wrong Areal
— 0
| |

1
30 1+00
TURF ESTABLISHMENT
ON 6" (MIN.) TOPSOIL (2) DOUb'E CliCk

on the rectangle
\ ... toplace note

~ ~.

Figure 164 — Correct Way to Add Text to a Non Text Commenting Tool

Incorrect Way

The example below shows the incorrect way to add text to a non-text commenting tool. This was
incorrect because instead of double clicking on the rectangle and adding a note like the previous
figure, they used the callout tool to add text. This results in two comments showing up in the
comment list instead of one. Later in the digital review process, comments are reviewed and
comment reports are created and these extra comments will make those two processes harder to

S.C.5 (PHASE 1)

TURF ESTABLISHMENT
ON 6" (MIN.) TOPSOIL
Callout Tool

S.C.S (PHASE 1)

S.C.S (PMASE 1)
—7_\\
4 /

¥ 0
4 T e
b 400

TURF ESTABLISHMENT
ON 6" (MIN,) TOPSOIL

These two markups
show up as two
comments instead of

Rectangle Tool

Figure 165 - Wrong Way to Add Text to a Non Text Commenting Tool
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4. After your review of the documents is completed set your status to Finished.

Note: You can still enter the session if your status is set to Finished. This status is for the
Organizer so they know which Reviewers have completed their reviews.

Set Status

FIQIECT HU | LU-IUGD ) = SEL-£DD
+ Atendees =
& M. Calkins AEC Appiic. CT_CON_PRE030_0120-. /7 [

Figure 166 - Set Review Status

5. (Optional) Notify and send your supervisor (Approver) the review memo or link to the
review session so they can review your comments. If supervisor approval is not needed,
skip to step 13.

Comment Reviewer — Supervisor Approvals

If a supervisor makes comments themselves while they are approving their subordinate’s
comments, they shall also approve their own comments in accordance with this section. The
supervisor shall follow steps 1 through 5 of this section for commenting.

6. Join the review session by clicking on the link in the memo.
7. First set your status to Reviewing by clicking on the drop down shown below:

Note: If you leave the session and return your status will stay as Reviewing.

Set Status

Figure 167 - Set Status to Reviewing
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8. Filter the markups so you only see your subordinates comments by clicking on the name
of your subordinate and click filter markups as shown below:

M Calline TE 2 AEFC fAn ~T NN BOEDN 01300086 / °
M. Cetans TEQARC An CT_COM_PRERD M200025_

(1 ) Ri g ht % B Bourgoin Highway Desi . CT_CON_PRE-PD_0120-0086_ s :
Click -

Il Filter Markups

Select Markups

(2) Select

- .
2 . P _
3\ g CT_ : | ost Estimate pdf K -
J-TE‘.‘_ C Pl ent pdf * i
™I

L}
M. Calkins TE 2 AEC Applications: - .

fl i) B Bourgoin Highway Design: Add Image
M. Calkins TE 2 AEC Applications

| J.5_ Rinaldi- Add Rectangle

J.5. Rinaldi
J.5. Rinaldi
| J.5_ Rinaldi- Edit Rectangle

il | __j J.5. Rinaldi: Edit Comments (Trout Mask Replica by
— Cantain Besfheart)

JOANERS

Figure 168 - Filtering Markups

Now on the document and in the list of comments it only shows the comments made by your

subordinate.

Issued 9-2014

Y Fl
Only shows comments -
that you need to review = =
e 8. T || 01200086 [+

Figure 169 - Filtered Comment List
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9. For every comment you must type in a reply. This is done by right clicking on the
comment and selecting Reply as shown below:

Mathew Calkins/co

(1) Right Click cc: James H. Norman
on a comment Scott A. Hill - William W. Britne

Summary -

Ctrl+Shift+L

e (2) Select
ekte Reply

It Properties

Drag control peints to resize, or drag doud to move

Figure 170 - Replying to a Comment

10. Then, at a minimum, type in Agree or Delete when replying. You can also reply with
more detail using Agreed As Noted. See below for an example:

Mathew Calkins/co
cc: James H. Norman
Scott A. Hill - William W. Britnell-f

Eoa 8B=

| |Y At G E-Fv- R B sy -

s Agree, the date will be | =
change

+ Mone
- L !  Supervisor reply
; | to subordinate's

comment

TE 2 AEC Applic

Double didk n Pop-Up Note

Figure 171 — Supervisor Reply
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11. After you have finished replying to all of your subordinate’s comments, set your status to
Finished as shown below:

Set Status

-

~ Attendees /
4 W Cakins AEC Appiic. CT_CON_PRE-030_0120- 7

Figure 172 - Set Review Status

12. Notify your subordinate that you have reviewed all their comments and that all comments
that you have marked with Delete will need to be deleted from the review documents.

7.7.3.1 Reviewer — Review Comment Memo

Each reviewer shall create a review comment memo with their comments attached. To do this a
comment report from Bluebeam shall be created and copied into the comment memo.

13. Delete all comments from the review documents that your supervisor has instructed you
to.

14. Create a review comment report of your comments. First filter out the comments so only
your comments are displayed as shown below:

EE e
-

| ¥ Flter U? | il Columns ~ e | : v-|E B sumay -
" e S - (2) Click
[A]
(s

d for use in the -1 Page 03.02

emis RI75HVA  Constnicion D1 - M. Cakkins TE2

Constniction N1 - M Calkins TE2 P=ye 03.02 (3 ) S e I ect yO U l'
name

Construction D1 - M. Calkins TE2 Page 03.03

s Construction D1 - M. Calkins TE2

relocation prior to Construction D1 - M. Calkins TE2

Figure 173 - Filtering Comments
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15. Now that the comments are filtered by your name create a comment report as shown
below:

nnnnnnnn

B0 B
| |V rirr | N | i colres - B-%v- BL

Author * Page 4

( 1 ) C | | C k on P ag e Construction D1 - M. Calkins TE2 Page 03.02
to Sort by Page N 0' Construction D1 - M. Calkins TE2

(2) Select Summary
o s and select PDF
PDF Summary S um mary

Fage 03.02 : Print Summary

Construction D1 - M. Calkins TE2

struction D1 - M. Calkins TE2

jon D1 - M. Calkins TE2

Figure 174 - Creating a Comment Report

Next type in a title for the comment report that includes Project No, What review it is plus the

word “Comments”, and what document this comment report is for. See below for an example:
Project ####-###H Semi Final Review Comments 03-Highways

Make sure all the settings are set as shown below and click OK:

PDF Summary E|
(_Page Range N
Pages Al Pages (1-5) v|of5
Summny Optins _ (1) Make sure all
Exclude Filtered Markups *

these settings
are selected

Bxclude Hidden Columns

PDF Options
Include Totals Include Page Content

Title: |Project 0121-0980 Semi Final Review Comments 03- |

Style: |F|Dw v|
Preview: | [, - |
Page Size: |Le‘rter V|
© o e y (2) Click
f
) Cancel |

Figure 175 - Comment Report Settings

16. The comment report will now be created and opened in Bluebeam, leave the comment
report opened in Bluebeam. We will be copying this report into the comment report
memo.

17. Save the following comment report memo to your computer or to the project on the X:
drive: Review Comment Memo

18. Open the Review Comment memo and fill in all the correct information.
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19. Copy the comment report pages into the comment report memo as shown below:

@ @ Fe Edt  View Document Fom  Makup  Measue  Window

j (2) Select the
B thumbnail view

ol L 1 & 3.8 SV

Review Comment Mermo CT_CON_PRE-SF_0120-0086_03Hig... *

(1) Click on the
comment report . commens gy
document

pshot  Ctri+AIt+C

(3) Select all
pages and then
right click on them
and select Copy Pages

Ctrl+5hift+N

-
=

o Fa Cirl+shift+M

e

|V A S | i columns - B-%v- BB suwmay -
Author Page o

Figure 176 - Copying the Comment Report into the Comment Report Memo
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20. Paste the comment report into the Review Comment Memo as shown below:

: ) : e I 1S A0 BV,
(2) SeIeCt_ th_e 03-Highways Review Comment Memo® = (T_CON_PRE-SF_0120-0086_03-Highway...*
thumbnail view

ubject: Review Comments
Project Mo, 120086
FAP Project No. FAP 0125R

(1) Select the comment

memaorandim

Rp— report memo document

1 Preliminary Studies. ¥ Semifinal (80% - 70%)

(3) Right click below
the thumbnail of
the memo and select

iiniibdled paste pages

Crl-+5hift+M

VxR < <

B-3% - |!-v s Summary -
Page <

Figure 177 - Pasting the Comment Report into the Comment Report Memo

21. Save the memo and process this memo as your unit requires and forward to the review

organizer.
22. Your role in the review session is now complete.
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7.8 Phase 5 - Closing the Digital Review

The Organizer will be responsible for closing the review. The review session will be closed per
the date on the review memorandum.

1. Click Finish to close a Bluebeam Review Session as shown below:

EDR*

& X reave W Finish /B =
o Home |
Pr_ect 0120-0086 PD Review - 197-367-177

S

v Altendees .
% M. Calkins TE2AEC Ap.. CT_CON_PRE-PD_0120-0086_ .. y4

Click Finish

"SUBSE
I

_PRE-PD_0120-008

PRE-PD_0120-0086_Cost Estimate pdf
FRE-FD_0120-0086_PD Statement pdf

EEisrOon

DRAWING TI

Figure 178 - Terminating a Session
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2. Make sure all the reviewers in the list below are selected (they will be by default) and the
Save (Overwrite Existing) button is checked and click OK.

Finish Session X

Project 0120-0086 PD Review - 197-367-177

Include Markups

 Mame E-mail
M. Calkinz T... mathew.calking@ct.gov

B Bourgoin ... bruce bourgoin@ct gov
JS. Rinald johnrinaldi@ct gov j:’ Make sure a" names

are selected and this

C—— / button is selected, then
C@ Save [Overwrte E:dstingD click OK

) Save In Folder

) Do not save files

[1 Close files after finishing
Fepot_

Figure 179 - Terminating a Session

3. Click Yes in the figure below.

Overwrite local PDFs

a The PDFs and Markups for this Session will overwrte the local

POF files. Are you sure you want to ovenwrite all local PDFs?

Click

Figure 180 - Overwriting Existing Documents

4. Close Bluebeam Revu and check in each document to Projectwise. Note a check in box
will pop up for each document in the review session.

Check In X
General
Documents
Name Label (User Defined) Description Main
'( CT_DOC... PD Statement Project 120-086 PD Statement DoC
= i | b
Folder: 06.0 - ProjectWise Administration\01 - Administrators{Mathew
Calkins\0123-0145310_Preliminar
[[] Create new version during Check In e Se I ect C h ec k I n
Version: [ e
(l Check In ) Update Server Copy | | Free [ Cancel
e —

Figure 181 - Checking a Document Into Projectwise
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5. Change the state of all documents in Projectwise to “REVIEW RESOLUTIONS” so the
author of the documents can respond to all the reviewers’ comments. To do this select all
documents, right click, select Change state, and click next.

7.9 Phase 6 - Resolve Comments

This section shows how the comments from the review session will be resolved by the Document
Authors. After the comments are resolved in the PDF document a Response to the Review
Comments memo will be sent out by the document author to all the reviewers.

7.9.1 Notify Authors

The Organizer shall notify the Authors by email that the digital review session has ended and the
comments on the review documents can be resolved. This email shall include a link to the
documents.

7.9.2 Resolving Comments

All comments on the review documents shall be resolved by the Author directly on the digital
PDF review documents using Bluebeam. The following shows the steps for resolving comments
and creating the resolution memo.

1. Open your document(s) from Projectwise.
2. Next select a comment in the comment list and right click. The select Reply.

| coms - 7
Subject Comments R
+ Link doesnt work (1)
* Cloud Link doesn't work M. Calkins TE 2 AEC Applications
+ Wrong Date (1)
~ 4 Cloud Wro 15 TE 2 AEC Applications

(1) Right click —
on a comment . (2) Select
Reply

Figure 182 - Comment Resolutions
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3. Inthe box that pops up, type in a final resolution in the following format:

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.

Resolution — Type in resolution..No Change to Plans
Below is an example of a resolution being typed:

| as-builtstamps 3 pdf
m as-buitstamp EXISTING MEMORIAL F
g as-builtstamps 1.pdf SIG N TO B E RE LOCAT

Type in resolution
i in the box

|
I

| |-7 Filter :l' | ;-'FI Columns ~ & . Summat * *
Subject Comme nts Resolution - Oppose if we Author
~ B. Bourgoin Highway Design (1) do not move the sign it will
~ 3§ Cloud SERIEREEECE be directly affecting site line B. Bourgoin Highway Desig
distance for memorial rd, No _ §
Lol eE Change to Plans 1 B8

M. Calking TEZ2 AEC Applications
John 5. Rinaldi TE IIl AEC
eiving but it is comect no :hange to plans B Supervisor Traffic
ins T|
John 5. Rinaldi TE Il

e 10 of book bla bla says to post 55 mph on type a roadway no ] oin Supervisor Traffic

- *li]n:nud
= U Re:C
p Re:R solution - Concur Plans shall be updated
hd *li]u:.ud Should we re oth pattem, this will confuse motorist?

Figure 183 - Typing in a Resolution

The resolutions applied to the plans shall be the final resolution decided by the Authors unit. If a
TE2 writes a resolution on the plans and then the TE 3 reviews that resolution and it needs to be
changed, the TE2 shall revise the resolution. There shall only be one resolution for each
comment.

Below is an example of how the resolutions will look in the comment list.

‘ | ¥ Filter ]:' ‘ i.i.i‘l Columns ~ 4" I G H- v |:" ‘ Summary ~
Subject Comments Author Date
v B. Bourgoin Highway Design (1)
v . Cloud Sign Shaudd not ha relacted B. Bourgoin Highway Design 9/27/2012 10:56:40 AM
L) Re:Cloud Resolution - Oppose if we do not move the sign it will be directly affecting site line distance for B. i3ourgoin Highway Design

I rd, No Ch: to Pl
A TE A a5 memorial rd, No Change to Plans (1 ) SOl’t by

v - Rectangle Town should read East Haddam M. Lal-ins TE2 AEC Applications com m e nt
v 4 Re: Rectangle Disaaree John S. Rit.=ldi TE Ill AEC
L) Re: Re: Rectangle Resolution - Concur with JR town line is deceiving but it is comect, No Change to Plans B Bourgoin Supevisor Traffic
v . Cloud Speed Limit is 55 M. L t"ins TE2 AEC \nplications

v % Re:Cloud Agree John S. Rinaldi TC 11l AEC o e e
) Re: Re: Cloud Resolution - Oppose code 10 of book bla bla says to post 55 mph on type a roadway, No Davwennin Sinenvisor Traffic H
Change to Plans ReSOIUtlonS
v . Cloud Need to add a school sign Application:

here
v &) Re:Cloud Agmee - ner code #5 John S. Rinaldi Tc Il AEC 9/27/2012 10:17:39 AM
) Re: Re: Cloud Resolution - Concur, Change Plans B Bourgoir supervisor Traffic

v . Cloud Should we remove Saw tooth pattem, this will confuse motorist? M. F=ikins TE2 AEC Applications
v ) Re:Cloud Disaaree - Pattem should stay John S. Rinaldi TE IIl AEC
) Re: Re: Cloud Resolution - Concur with JR and MC will remove 10 feet out of 50 ft, Change Plans B Bourgoin Supervisor Traffic
v - Rectangle Move Sign 100 Feet closer to roundabout M. Calkins TE2 AEC Applications 12 10:07:50 AM

Figure 184 — Resolutions
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4. Next create a comment report of all comments for the response to review comments
memo. In the comment list, click on the “Author” header to sort the comments by Author
as shown below: If the comment list is not sorted by Author before creating a comment
report, the comments in the comment report will be difficult to follow.

yre

Summary -

Author i Date
B. Bourgein Highway Design (1)
- *Elnud : B. Bourgoin Higl esig /27/2012 10:56:40 AM

L’ Re: Cloud Resolution - O i do not move the sign it will be directly affecting steline 4 B. Bourgein Higl
memorial rd no
~ M. Calkins TE2 AEC Applications (5)

M. Calkins TE2 AEC Applic 127/2012 9:21:46 AM

Click on Author John S. Finaldi TE Ill AEC /2012 10:20:58 AM
to so |’t by Author B Bour Supervisor Traffic 7

M. Calkins TE2 AEC Applic
. Rinaldi TE Il Al

post 55 mph on typ:

e T

Figure 185 - Sorting Comments by Author
5. Next select the following:

o pf
ERAL pdf
|Y A @ SN
Comments
~ B. Bourgoin Highway Design (1)

~ 3} Coud

S e rlecto ) n
(1S Cloud H C I | Ck an d the sign it will be directly aff PDF Summary

+ M. Calkins TE2 AEC Applications (5) 'E' Print Summary
select PDF M. Calkins TE2 AEC Appiications

John 5. Rinaldi TE Il AEC

ing but it is comect no change to plans
55mph on type

John 5. Rinaldi TE IIl AEC

r Plans shall be updated isor Traffic

Figure 186 - Creating a Comment Report
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6. Next type in a title for the resolution comment report that includes Project No, What
review it is plus , “Comment Responses”, and what document this comment report is for.
See below for an example:

Project ###H-####H Semi Final Comment Responses 03-Highways

Fage Fange

Pages |.£'-.II Pages [1 -] v | of &

(Summar}'DDtinns ﬂ\ { Mak_e sure these
Exclude Filtered Markups SEttlngs are SEIECtEd

Exclude Hidden Columns and type in the
correct title

FDOF Ophionz
[ #ppend to Current PDF
Include Tatals Ihclude Page Content

Title: |F'miec:t 01:21-0980 Semi Final Comment Responses |

Shyle: |F|.:.w v|
Presview: ||_a[ge v|
Page Size: |Letter v|
\ (%) Portrait () Landscape J .
_— Click OK
Jces |

Figure 187 - Creating Comment Report

7. The comment report will now be created and opened in Bluebeam, leave the comment
report opened in Bluebeam. We will be copying the pages of this report into the memo.

8. Save the following comment report memo to your computer or the project on the X:
drive: Response to Review Comment Memo

9. Open the memo and fill in all the correct information.
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10. Copy the response to review comment report pages into the memo as shown below:

@ @ Fe Edt  View Document Fom  Makup  Measue  Window

j (2) Select the
B thumbnail view

ol L 1 & 3.8 SV

Review Comment Mermo CT_CON_PRE-SF_0120-0086_03Hig... *

(1) Click on the
comment report . commens gy
document

pshot  Ctri+AIt+C

(3) Select all
pages and then
right click on them
and select Copy Pages

Ctrl+5hift+N

-
=

o Fa Cirl+shift+M

e

|V A S | i columns - B-%v- BB suwmay -
Author Page o

Figure 188 - Copying the Comment Report into the Comment Report Memo
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11. Paste the comment report into the Memo as shown below:

Form Markup

g

: ) e I 1S A0 BV,
(2) SeIeCt_ th_e 03-Highways Review Comment Memo® = (T_CON_PRE-SF_0120-0086_03-Highway...*
thumbnail view

ubject: Review Comments
Project Mo, 120086
FAP Project No. FAP 0125R

(1) Select the comment

memaorandim

Rp— report memo document

1 Preliminary Studies. ¥ Semifinal (80% - 70%)

(3) Right click below
the thumbnail of
the memo and select

iiniibdled paste pages

Crl-+5hift+M

VxR < <

B-3% - |:'-v s Summary =
Page <

Figure 189 - Pasting the Comment Report into the Comment Report Memo
12. Save the memo and process this memo as your unit requires and forward to all reviewers.
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7.10 Locking the Review Documents after the Review

The Organizer shall make all the review documents read only after the review process is over.
This shall be done after the response to comment memos have been received. To lock the review
documents, change the state of the documents in Projectwise to “Review Completed” as shown
below:

1. Select all documents and change the state of the documents to “Review Completed” as
shown below:

CCWIS € ONIINE. COM:L1LU 1O CUMENTSWUD U - FIOJECTVVISE AGMINISTTATIONWL - AGTIMISTFATONS I ¥ | = Qv

List | @ Geospatial

Desaription Mzin Categary

Select view

New

Creseoue (1) Right click on the
documents and select
"Change State>Next"

Copy Out

Export...

Start Studio Session...

Refresh Local Copy
Purge Local Copy

cut
Copy

Delete

Modify...

Mocify Linear Attributes..
Mocify Spatial Attributes. ..

Add Comment
set 4
A Send To » I
Documert Propeties | Copy List To * Previe®| Dependency Service || Access Contrc

- Batch Print. 13 Prope
1 cT.cc

I I 310_Pr
Set Final Status oot

POF Change filename to CT_Code cr_cc
Digital

U Edit attributes for multiple documents MICA
MIC-A

Old Aucit Trail Report MG

Status Checke

Version
File Qanicinn

Figure 190 - Changing the State to Review
The documents will now be read only to everyone, including the Projects lead design unit.

Wine.com:LIDU NJocuments\e U - ProjectWise Administration'ul - Administratofs\ ¥ | > Lo

List | @ Geospatial

bel (User Defined) Description Main Category Sub Category Sub Category Description Application State

' a 01-General CON PRE-PD DOC_01 - Preliminary Docs Acrobat PDF REVIEW COMPLETE
' a 03-Highways CON PRE-PD DOC_01 - Preliminary Docs Acrobat PDF REVIEW COMPLETE
' a 04-Traffic CON PRE-PD DOC_01 - Preliminary Docs Acrobat PDF REVIEW COMPLETE

' a 05-5tructures CON PRE-FD DOC_01 - Preliminary Docs. Acrobat PDF REVIEW COMPLETE
a 30% Specs JOC_01 - Preliminary Docs REVIEW COMPLETE
' a Cost Estimate H 20C_01 Acrobat PDF REVIEW COMPLETE
' a PD Statement Project 120-086 PD Statement N Otl ce S tate COI u m n ’ 30C_01 - Preliminary Docs Acrobat PDF REVIEW COMPLETE

the documents are

now in the Review
Complete state.

Figure 191 - Review Complete State
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Section 8 CTDOT Project Location

This section details the required information/documents that need to be submitted to CTDOT to
locate all of our projects on a GIS (Geographic Information System).

The lead designer shall be responsible for providing the information/documents detailed in the
following tables when filling out or updating the Project Asset Form located on the Projectwise

Project Information Webpage at the following link:

Projectwise Composite Data

This information/document needs to be submitted or updated at the following project milestones:

e RPM
e Design Approval
e Final Design

The following tables detail what needs to be provided on the Project Asset Form for various

project types. If your project type is not listed, contact AEC applications for guidance:

Mathew.calkins@ct.gov or John.Rinaldi@ct.gov

Project Milestone - RPM

Project Type Required Instructions
Information/Document
Highway Paving Routes and Mileage Section 8.1.1
Guide Rail, Barrier, Safety Routes and Mileage Section 8.1.1
Improvements
All other highway projects Google Earth KML
Bridge Bridge Preservation projects List of bridges in the Section 8.1.2
project
Bridge Maintenance projects List of bridges in the Section 8.1.2
project
Bridge Replacement or Superstructure Google Earth KML Section 8.1.3
Replacement
Retaining Wall Projects Google Earth KML Section 8.1.3
Sign Support Projects List of sign supports in the | Section 8.1.2
project
Traffic Traffic Signals List of traffic signals in the | Section 8.1.2
project
Signing Route and Mileage Section 8.1.1
Pavement Markings Route and Mileage Section 8.1.1
Rumble Strip Route and Mileage Section 8.1.1
Facilities New Facility or Rehab of Existing Google Earth KML Section 8.1.3
Facility
Rail Project Google Earth KML Section 8.1.3
Rails | Rail Project | Google Earth KML Section 8.1.3
District Wide
Projects
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Project Milestone — Design Approval

Project Type Required Instructions
Information/Document
Highway Paving Updated Routes and Mileage if | Section 8.1.1
necessary
Guide Rail, Barrier, Safety Updated Routes and Mileage if | Section 8.1.1
Improvements necessary
All other highway projects Microstation Project Polygon Section 8.2.1
File
Bridge Bridge Preservation projects Updated list of bridges in the Section 8.1.2
project if necessary
Bridge Maintenance projects Updated list of bridges in the Section 8.1.2
project if necessary
Bridge Replacement or Microstation Project Polygon Section 8.2.1
Superstructure Replacement File
Retaining Wall Projects Microstation Project Polygon Section 8.2.1
File
Sign Support Projects Updated list of sign supports in | Section 8.1.2
the project if necessary
Traffic Traffic Signals Updated list of traffic signals in | Section 8.1.2
the project if necessary
Signing Updated Routes and Mileage if | Section 8.1.1
necessary
Pavement Markings Updated Routes and Mileage if | Section 8.1.1
necessary
Rumble Strip Updated Routes and Mileage if | Section 8.1.1
necessary
Facilities New Facility or Rehab of Existing Microstation Project Polygon Section 8.2.1
Facility File
Rail Project Microstation Project Polygon Section 8.2.1
File
Rails Rail Project Microstation Project Polygon Section 8.2.1
File
District Wide
Projects
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Project Milestone — Final Design and Construction

Project Type Required Instructions
Information/Document
Highway Paving Updated Routes and Section 8.1.1
Mileage if necessary
Guide Rail, Barrier, Safety Improvements | Updated Routes and Section 8.1.1
Mileage if necessary
All other highway projects Updated Microstation Section 8.2.1
Project Polygon File
Bridge Bridge Preservation projects Updated list of bridges in Section 8.1.2
the project if necessary
Bridge Maintenance projects Updated list of bridges in Section 8.1.2
the project if necessary
Bridge Replacement or Superstructure Updated Microstation Section 8.2.1
Replacement Project Polygon File
Retaining Wall Projects Updated Microstation Section 8.2.1
Project Polygon File
Sign Support Projects Updated list of sign supports | Section 8.1.2
in the project if necessary
Traffic Traffic Signals Updated list of traffic Section 8.1.2
signals in the project if
necessary
Signing Updated Routes and Section 8.1.1
Mileage if necessary
Pavement Markings Updated Routes and Section 8.1.1
Mileage if necessary
Rumble Strip Updated Routes and Section 8.1.1
Mileage if necessary
Facilities New Facility or Rehab of Existing Updated Microstation Section 8.2.1
Facility Project Polygon File
Rail Project Updated Microstation Section 8.2.1
Project Polygon File
Rails Rail Project Updated Microstation Section 8.2.1
Project Polygon File
District Wide
Projects
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8.1 Project Location - RPM

8.1.1 Route and Mileage

The lead designer shall provide all routes and mileages for project in accordance with the
following:

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

Slice Gallery =

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

| Project Asset Form |

| Data View Form ‘

| Data Import Log ‘

| ExpottoXMLorCSV

| Manage My Projects Lists ‘

| Edit Users ‘

Figure 192 - Project Asset Form

3. Select the project from the drop down or if it is a new project click “Add Project”.

Project Asset Form

||| Number of projects: | 1555 GotDPmJE o
Select Project or if it

Add Project | | l Delete Project | ‘ Save Proj

is a new project click
Add Project

Figure 193 - Selecting Project

4. To get the route and mileage for a project you will need to go to the ALIM system
found here:  ALIM System
5. Next add the route and mileages to the Project Asset Form.
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8.1.2 List of Assets for the Project

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data
2. Click on the Project Asset Form.

Slice Gallery »

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

Project Asset Form

Data View Form

Export to XML or CSV

Manage My Projects Lists

| |
| |
|  Dataimpotiog |
| |
| |
| |

Edit Users

Figure 194 - Project Asset Form

3. Select the project from the drop down or if it is a new project click “Add Project”.

Project Asset Form

] | Number of projects: | 1555 GoumJe L Add to My Projecf [ Add Project_| [ ) Delete Project || Save Pro
Select Project or if it

is a new project click
Add Project

Figure 195 - Selecting Project
4. On the form add all of the assets in this project.

Project Asset Form

Add to My Projects | Add Project | ‘ Delete Project U Save Project Data J
N —
Select records: Number of projects: | 1555 | Go to Project | |0003-0109
Project No: 0003-0109 Inherited Projects:

Contract Number:

Location
Towns: Routes:
Milepoint Start:
Milepoint End
Biovee™ | Add Asset Information

Assets 4/ and then click Save

ridge Nos: vement Treatment: [ P roj ect Data
etaining Wall Nos: ign Structures: Edit...
ignal System Nos:

Diesign Information

S

Project Manager: | v| Project Manager's Email: |

Consultant Engincer: | ~| [ Add__ | Project Engincer | v
ProjectEndDate: || End Date Reason:

User ID Of Creator: ISystem— Creation Date: ’m
User ID Of Modifier: [System Last Modification Date: [10/1/2014 91252 PM

Figure 196 - Adding Assets
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8.1.3 Project Polygon Creation and Submission

The following shows how to create and submit a project polygon KML file for project location.
The project polygon is created in Google Earth and attached to the Project Asset Form located on
the Projectwise Project Information webpage.

1. Open Google Earth.
2. Zoom into the location of the project or use the search tool to locate the area of the
project.

& Google Earth

¥ Search

‘ 2800 Berlin Turnpike, Newington, CT ’ Search
W Museums in New York. NY

Get Directions History

Type in an address
for your project

2800 Berlin Turnpike, Newington, CT 06111,
USA

[+l X
v Places

4 E@ My Places
s VI Sightseeing Tour
Make sure 3D Buildings
layer is checked
(V|8 Start tour here
[¥] The Eiffel Tower

m

Located in Paris, France
[¥] Christ the Redeemer

Located in Rio, Brazil

[¥] The Grand Canyon

Figure 197 - Searching in Google Earth

3. Next select the polygon tool to place a polygon around your project.
&S Google Earth

File Edit View Tools Add Help

¥ Search

A
2800 Berlin Turnpike, Newington, CT| Search !
ex: Museums in New York, NY

Get Directions History

2800 Berlin Turnpike, Newington, CT 06111,
USA

B X

Figure 198 - Polygon Tool
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4. Next Type the project number in the name field and a description in the description
field as shown below:

Google Earth - New Polygon =]

E=="+— Type in Project #
Description | Style, Color | View | Altitude |/and Project
[ addink... | [addimage... | Description

CTDOT Main Building Facility Upgrade

[ OK ] l Cancel

Figure 199 - Polygon Settings

5. Next adjust the style and color of the polygon to the settings shown below, do not click
OK after you update the settings:

Google Earth - New Polygon E]

Mame: Project #0123-1234

Style, Color | view | Altitude

Line:

Color: [ width: 3.0 [] Opacty: 100% : ,

Area ‘
Color: pacity: 100% =

™~

Set Color to orange
and width to 3.0 and
area to Outlined

7] Random

[ QK _m Cancel
Do NOT click ok ——— &=

until after the
polygon(s) are
drawn

Figure 200 - Polygon Style
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6. Next draw the polygon for the project. This polygon should encompasses the whole
project and include all the roads that this project will affect. Then click OK.
- i — ’\ ¥ f

Google Earth - New Polygon

Name: Project #0123-1234

Desaription | Style, Color | View | Alttude.

Lines.
color: [ width: 3.0 [+] Opacty: 100%

Area
cor: [ vty 100%

Draw polygon and
then click OK

Figure 201 - Drawing the Polygon

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located
in the places area, which is in the left hand side of the screen, of Google Earth. Then redraw the
polygon by going back to step 3.
[ + JF X
Places
- W] 5t Peters Basilica -

Located in Vatican City

- [¥] The London Eye

Located in London, England Rig ht CIiCk
- [¥] The Titanic and select

Located in the North Atlantic Ocean
- [¥] The Forbidden City Delete

Located in China

- Mount Fuji

Located near Tokyo, Japan

- |¥] Google Headquarters

V1) Project 20123-1234
CTDOT Main Building Facility

- O Temporary Places
QM@

It

( Delete
¥ Layers -
< @ Primary Database Rename
> [ Borders and Labels
- Places Save Place As...
- Photos Share with Google Earth Community
- (e Roads Email...
» O 30 Buildings
b DQ COcean Snapshot View

> O ﬁ Weather

I D\'ﬁ' Gallery
[ 7

Properties

Figure 202 - Deleting a Polygon
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7. If the project has multiple sites, go back to step 3 and create another polygon(s). After
you create all your polygons they will be listed in the places area in Google Earth.

[+ P X

; The London Eye -

Located in London, England
[¥] The Titanic

Located in the North Atlantic Ocean

The Forbidden City

Located in China

[V Mount Fuji

Located near Tokyo, Japan

[¥] Google Headquarters All sites for
i it hisaieanning |1 fOrN 12 =
Project

V1) Project 20123-1234

Site 1
V1) Project 20123-1234 | 3
Site 2 #‘
(S Temporary Places = Aert
Q| e
v Layers Earth Gallery ) |

4 5,"5 Primary Database
> @] F Borders and Labels
[V @ placse

Figure 203 - All Sites for Project

8. After all the sites are made they need to be added to the temporary places area in
Google Earth so a combined KML file can be saved. To add them to the temporary
places simply drag and drop all the sites into that area as shown below:

[ + P X

! he London Eye -

Located in London, England
[¥] The Titanic

Located in the North Atlantic Ocean
[¥] The Forbidden City

Located in China
[¥] Mount Fuji

Located near Tokyo, Japan Drag and drop the
[¥] Google Headquarters sites into the

Located in Mountain View, California

/temporary places

[V] ) Project #0123-1234 g >

Site 2 E
Q[m + ¥
¥ Layers Earth Gallery »'

« W= Primary Database
'q ‘F Borders and Labels
@ Places

Figure 204 - Drag all the Sites into the Temporary Places
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9. Next to save a KML file with all the polygons in it right click on Temporary Places and
select Save Place As:

[+ NP X
¥ Places
- [¥] The Londen Eve -
Located in Londen, England
- [¥] The Titanic
Located in the Morth Atlantic Ocean Rig ht cI ick on

- [¥] The Forbidden City

Located in China

- Mount Fuji

- Google Headquarters

ke tai

Located near Tokye, Japan

Temporary Places and
select Save Place As

w, Califarnia

Add 3

Copy
Delete Contents

Save to My Places

Save Place As...

¥ Layers
W= Primary Database

Email...

Snapshot View

s EP Borders and Labels
Places
e = Photos
i [VIE= Roads

Figure 205 - Saving the KML File

10. Next type in the project number for the file name and select KML for the file format.
Then select the folder on your computer where you want to save the file too and click

Save.
@Saveﬁle... @
=,
)= |Hl Desktop » - | Search Desktop Fel [
) P T
Organize * New folder g= - @
S Favorites * MName Size Item type  *
Bl Desktop & | Temporary Places.kml 6 KB  KML File
4 Downloads [#] New Internet Shortcut 1KB Internet Shy
5l Recent Places @ MNew Projectwise User 1KB Internet Shi
| #ECTCore 1KB Intemet Shi
= Libraries i . 92-522 File folder |
@ Documents . New folder File folder
J’ Music . DPD Revision History File folder
[&5] Pictures ! prj File folder
E Videos m . Contractor Submittal Cove File folder =
- - - - B
 axcosimworipace e T yp@ in Project # for File folder
% Computer J Survey CGS File folder
&, 0sDisk (<)  Leap e the name and select Fle folder
—a Data (Dt) Working File folder
g GIS Data (L) fi KM L for the format File folder

@ traops (\\dot-sdceng0lv) (P:)

FIEG T ERlP roject #0123-1234.kml

@ve as type: Il(ml ("krml)

* Hide Folders
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11. Go to the Projectwise Project Information Webpage: Projectwise Project Information
12. Click on the Project Asset Form.

Slice Gallery «

ProjectWise Composite Data: Main Menu

Your Windows Username: CalkinsMJ

Project Asset Form

Data View Form

Export to XML or CSV

Manage My Projects Lists

I |
| |
| Data Import Log ‘
| |
| |
| |

Edit Users

Figure 207 - Project Asset Form

13. Select the project from the drop down or if it is a new project click “Add Project”.

Project Asset Form

] Number of projects: | 1555 Gotaije ‘\ Add to My Projec | Add Project || l Delete Project H Save Pro
Select Project or if it

is a new project click
Add Project

Figure 208 - Selecting Project
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14. Next attach the KML file to the Project Asset Form by clicking on Browse and then
select the file:

Project As
Select records: ‘ |AH V‘ ‘ Number of projects: | 1555 | Go to Project: ‘ ‘
Project No- IO 160-0145 Tnherited Projects: I
Click on Browse and

Location then select the file to

Towns: I il D
Milepoint Start [
Milepoint End: [

( Browse._ ) Download Attachment: | | Delete Attachment

Assets
Bridge Nos: I Pavement Treatment: I
Retaining Wall Nos: | Sign Structures: [
Signal System Nos: I

Design Information
Primary Designer: .
Project Manager: I Project Managet's Email I
Consultant Engineer: I Project Engineer: I
Project End Date: I End Date Reason: I .
User ID Of Creator: [System Creation Date: [8/11/2014 9:41:02 AM
User ID Of Modifier: [System Last Modfication Date:  [10/1/2014 9:12:01 PM

Figure 209 - Attaching the KML File
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15. After you have selected the file click on attach file:

Project Assc

1555 ‘GotoProject:‘ 0160-0145 ‘

Project No: IO 160-0145 Inherited Projects: I
—

When combined with other project(s)

‘ Select records: ‘ |A|| V| ‘ Number of projects:

Location . .
Toums. l—CIlck attach file I |
Milepoint Start: [
Milepoint End: [
';\Ugerg\cmkingmj\negmc Browse... ‘ Download Attachment: | | Delete Attachment
R
Assets

Bridge Nos: I Pavement Treatment- I
Retaining Wall Nos: | Sign Structures: [
Signal System Nos: I

Design Information
Primary Designer:
Project Manager: I Project Manager's Email: I
Consultant Engineer: I Project Engineer: I
Project EndDate: | End Date Reason:
User ID Of Creator- |System Creation Date: [8/11/2014 9-41:02 AM
User ID Of Modifier- [System Last Modification Date:  [10/1/2014 9:12.01 PM

Deleted selected attachment.

Figure 210 - Attaching the KML File
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8.2 Project Location - Design Approval through
Construction

The following shows how to create and upload a refined project polygon file at and after the
Design Approval milestone of a project. The file shall be created by the lead designer in
accordance with this section and uploaded into the 140_GIS folder of the applicable project in
ProjectWise. For projects that were previously located using the assets or route and mileage this
section does not apply. If changes are made to projects found using assets or route and mileage
update that project information in accordance with Section 8.1.

8.2.1 Project Polygon

The lead designer is responsible for creating the project polygon dgn and kml files using
Microstation. The following section details what needs to be included in the polygon and how to
make the project polygon file for different project types.

If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or
John.Rinaldi@ct.gov for guidance.

If a project has more than one site, all the polygons for that project must be included in one
project polygon file. All the polygons for each intersection shall be in one file.

Highway Projects that Touch Pavement

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or
temporary work area extends beyond that. Below is an example of what to include:

[ e e I

Project Limits Include Temporary

on Local Roads Work Areas

FAT e

—

53]
51400 S200 ,

50+00

Slope limits inside of Slope limits outside of
the ROW, draw to the the ROW, draw to the
ROW line slope limits

Figure 211 — Project Extents
The image below is an example of what a typical project polygon will look like after it is drawn

in Microstation.

Figure 212 — Project Polygon example
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Highway Projects that DO NOT Touch Pavement

This type of project could involve, but not limited to the following:
Guard rail replacement

Barrier replacement

Noise barriers

Retaining walls

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, temporary work areas, portions of local affected roads, all affected assets, etc. The polygon
should be drawn up to the right of way line unless the slope limits or temporary work area
extends beyond that. If there is only a ROW line on one side of the project, draw the polygon
relatively close to the edge of the work area. Below is an example of a noise barrier project and
shows what to include:

Draw relatively
close to work area.

Include any
temporary
work areas

BEGINNING OF PROJECT
42-311

Figure 213 - Highway Project without Full Depth Reconstruction
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Full Bridge Replacement or Superstructure Replacement

The Project Polygon file shall encompass the entire project extents per site and include all slope
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or
temporary work area extends beyond that. Below is an example of what to include:

_ g Project Limits on
\ Local Roads

— Connect Slope lelts
—Across Waterway

In.,.grl'l |

-
I

] | e | AVM l\ 5 L Y lelts of Temporary
r'l b a \ TYPE v, el ‘5 ?5_. £} Sl '_.I:-‘.« = \E o 1\

“CCATOH BASIN,, [ [P | st s » AV

Q:n.y {Mos- 01 NN LTI A : 1e !l \ work Area

Figure 214 - Bridge Polygon Example
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Facilities Project
The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel
the facility is located on. Any slope limits or work being done outside of this ROW line shall be
included in the polygon. Below is an Jexample of what to include:

i5-010 FOR SALT SHED CORMER ELEVATIONS AND SEE Y/ AoV - g = L
W SALY SHED COORDINATES. L 4 ot - 4,,‘@.6 ¥
I0US LOT GEOMETRY AND RADIL SEE DWG NO. C-007. i o R L o i ad®"
apht ' .

F ESTASLISHMENT 1S FOR TOPSOR AND TEMPORARY SEEDING ,-1".: o <% N
MD DIRECTED My THE ENGINEER. REFER 10 LDA-002 OB @ - a0

o W' ¢«

Lo -
IRY AND FINAL SETDING 15 SUBIECT TO THE DISTCTION OF Py - \ 'I‘.“ b

BASED ON SOIL, SLOPE AND SEASOMAL CONDITIONS. y - Y L

UK LEIAIL LITR. L
8 ™ TOTAL

INTALL &' HIGH 3 WIDE | > s
OOUBLE SWING GATE »

s s — LELL L

e — -

Figure 215 - Facilities Project Example
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8.2.2 Project Polygon File(s) Creation

The following steps explain how to create and submit the Project Polygon file. One polygon file
shall be created for each project. If the project consists of multiple “sites,” the file shall include
multiple polygons.

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be
referenced. This can usually be found within the ground survey file title block. If there
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.

2. InHouse CTDOT Users: Create a new MicroStation design file using the
2D_Poly_83FT seed file located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

Note: If your project is NAD 27 FT still use the 83FT seed.

@ Select Seed File - \sh3dgs18\CTDOT V8 Workspaces\Workspace\Standards\seedGeospatialt, )

Look in Geospatial Q= m
T MName Date modified Type Size
';}" /% 2D_Poly_27FT.dgn 7/17/201412:59 PM  Bentley MicroStati... 31KB
RecentPlaces 3 poiy 27M.dan JA7/2014110 P Bentley MicroStati... 3L KB
- 8/26/20141251 PM  Bentley MicroStati.. 87K
720 Poty 83M.dgn 7772014 1:03PM  Bentley MicraStati.. 31K

Desktop

%)
°

W=l

Libraries

Computer
Y
“w

Metwaork

File name: CT_Design_3D_V8i dgn M

Files of type [ MicroStation DGN Files (" dgn) - | Concel |

Figure 216 — CTDOT CAD resource folders

Consultant Users: Download the seed files using this link: 2D_Poly 83FT Seed File

3. Reference the Highway Design file into the newly created file using true scale off and

11 )

1) References (1 of 1 unique, 1 displayed) EI = @
Tools  Settings

B || ’ b i ] NENN B Bery Wia ] Wi —

-] ] gd o | gl e ] 20]30] mal 22 B 28] @ e e (Bownmies =)

St ¥ 3 File Name Madel Description Logical Criertation Presentatior

1 HW_HWY_012... Design Diesign Design Coincident Wirsframe

4 [ [ = 3
Scale | 1.000000 - | 1.00000D Botation §00°00°00" Offset X | 0.000 Y | DL

achments: Display Owvemides: | Allow

-

S R T g e
Figure 217 — MicroStation reference file settings
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4. Verify that the tentative coordinates of this file match the referenced design (using
stationing, grids, etc.). If your project is in NAD 83FT the coordinates should match, if
they do not check that the scale of the reference is 1:1. If your project is NAD 27 FT we
will move the reference file so the coordinates are correct. To move the reference file
do the following:

a. Select Reference File.
b. Select Move Reference:

1| References (1 of 1 unique, 1 displayed) E\ =l @

Tools  Settings
- ade] fe] Il 0| sl 2] B[y

@j‘ }Q|ﬂ|ﬂe Mode: | Boundares

St ¥ (% File Name Model Mescripﬁnn Logical Crientation Presentatior
1 HW_HWY_012... Design Design Design Coincident Wireframe
- m 2
Scale | 1.000000 ;| 1.000000 Botation | 00°00°00" Offset X | 0.000 Y| 0L

’_|_|_'- 1|1|_JJ|_J|_J’_JJ Mested Attachments: (No Mesting = MNesting Display Ovemides: | Allov
MNew Level Display: Corrflg Varable ¥ | Georeferenced: |MNo

Figure 218 - Move Reference

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box
key in XY=0, 0 and click Enter.

% HIgnway Uperatons

Highway ) Key-i @ -
X Ey-in — Ref s (1 of 1 uni 1 display
Key-In XY=0,0 and EE—
por=0.0f Izl Tools  Settings
ndscal| = hit enter E | 1] gd e | g«
Property '5 = St ¥ [y File Name Mad
structurd i ‘ 1 HW_HWY_012.. Desi
Location| |accldaw
accfznap &7 Al hd
Traffic
“! Drawing
% Drawing
& Terrain ¢l
Scale | 1.000000 1| 1.00
BRIy @l nf < [ &
New Level Display: |Config Viariable ~
—I—'ITasks “ % Projgct Explorer I
3 - © ~| ' ~[& naD83FT views ~] 1|2]3]|slsl7]el i X[ 215722 Y|[1582427
@e Reference > Enter point to move from j Reference attached

Figure 219 - Key In
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Lavinies wivn
'\E Highway Operations -

Highway

Landscap

d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the
Key-In Box key in DL=400124.9,500038.9.

2P Kev-in 2 O] References (1 of 1 unique, 1 dit

Hluminat] :
0= D) -400124.9,500032.9 [+ Tools  Settings
= =R

Property IS * : I I = 4 File Name
e 4 i Key-ln HW_HWY_012...
cocsion| frecon [ DL=400124.9,500038.9
Traffi
— Then Hit Enter
“¢ Drawing :
4 Drawing
Ay Terrain 1
Scale | 1.000000 :
@l ek
MNew Lewvel Display: (Corfig Variable g Variable
—l_"nTasks Il % Project Expforer J F]
2 - © |~ [ naD 83T views ~ y 1|2]3]4]5[sl7]e| i X[ 215789 Y[ 1582233
@\re Reference > Enter point to move to ) Reference attached

Figure 220 - Move to Key In

Now the tentative coordinates of this file should match the referenced design (using stationing,

grids, etc.).

5. Set the MicroStation active level to “TOOL_Prelim_Proj Polygon” for the Project
Polygon (Note: if this level is not yet available, use “SV_PARCEL DATA”)

6. Then place a closed polygon(s) using the shape tool or the smart line tool.

7. After the polygon has been placed, turn off all reference displays and fit the polygon to
the view.

8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml
file to Google Earth.
Do this by choosing: File> Export> Google Earth.

9. Google Earth should then automatically open and zoom to the Project Polygon(s)

vicinity.
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8.2.3 Project Polygon File(s) Submission

The Project Polygon files shall then be uploaded into ProjectWise in accordance with the
following:

1. Log into ProjectWise

2. Browse to your project’s 140_GIS folder in ProjectWise Explorer

3. Select the Interface, “CTDOT _Doc_Code.” If the interface box is not shown, select:

View>Toolbars and select interface
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard

£ 0% HE| @ 84 - serch @ soundgary » D> i interface| IOOT Doc Code
L'-!, Address M DGO
% 0170-2876 - Lst | @ Geospatial |

Al 100_Cantract_Plans (PDF)

i v Label (User Defined] Description
w4 110_Contract_Specifications (PDF) — . o
1..r 120_Contractor_Submittals (PDF) _/"@ Boundary Prc-J.ect L!m!ts - Southbury, Weston
1..r 130_Engineering_Reports # & | Boundary Project Limits - Southbury, Weston

- 140615
+ -7 210_Construction

Figure 221 — ProjectWise project polygon folder example

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and
assign the attributes shown in Table 5 of Appendix E

6. Click Next until the file uploads.

7. When upload is complete, the Lead Designer shall send an email to the following people
including links to the documents in Projectwise. To do this, click on the document and
then highlight and copy the address located in the Address Bar. Then paste it in the
email:

John.Rinaldi@ct.gov (AEC),
Mathew.calkins@ct.gov (AEC)
Henok.Abdisssa@ct.gov (AEC)

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to
the label attribute.
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Section 9 Rights of Way (ROW) Files

This section details the submission of the following Rights of Way (ROW) Files:

e Property Maps Files (.dgn and PDF)
e Parcel Polygon Files (.dgn and KML)

These files shall be submitted at the Project Milestone — Design Approval and updated as
necessary as the project moves through design and construction.

9.1 Submission of the Property Maps Files
The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in

accordance with the following:
1. Log into Projectwise.

2. Browse out to your project and upload the Property Map DGN and PDF into the
05_Property Maps folder and 310_Review folder respectively as shown below:

Y W& | Oy 2y - ::::. @ © #h - search [ sassets Y V\EWIFu\der vl InterfacelC[DOT_Du:_Cude 'DEC'@'
(::u - - LZ AddressL_ pw:t\ctdot.projectwiseonline.com: CTDOT\Documents\01.0 - Projects - Active\0170-2876" - bGO

2% 0170-2864_New London - Lst | @ Geospatial

% 0170-2875 -

= Name Description

Mred 0170-2876 E

/100_Contract_Plans (PDF)

/|7 110_Contract_Specifications (PDF)
2/ 120_Contractor_Submittals (PDF)
|2 130_Engineering_Reports
A0

-4 100_Contract_Plans (PDF}

-4 110_Contract_Specifications (PDF) I
-4 120_Contractor_Submittals (PDF) I
-4 130_Engineering_Reports

1T 140 cls

1 210_Construction

{T 220 FHWA

- 241 Contract Developrent Cofii i Al hel’e

[ 310_Review_Documents Ao a10

/L— 320_Fermit_apphcations
A2 330_Design_Data

jh 340_Administration

- 320_Permit_Applications

17 330_Design_Data

-4 340_Administration

1 341_Administration_Confidential

=i 500_Pre_Design

A

1" 01_Planning

-4 02_Concepts

[ 03_Central_Survey
-4 04 District Surve
d aved >earches
i 0170 3009

here

/- % Property Map PDF

- 230_Contract_Administration 230

: 240_Centract_Development K /I_ 240 Shall be uploadEd
ntial

FDP,DCD,FP, Addenda, and Construction Order Plans
Contract Specifications

Contractor Submittals Working Drawings, Shop Drawings, etc,
Soils, Ar:haeologica\ and otherReports

ruction's Documents

FHWA's Review

ting and Award

ssing - PS&E Documents
apment Confidential

Review

Fermit Applications

Design documents; CAD,Comps, Estimates, et
Project Lead - Administration Documents

" Tistrators Confidential Information

/)0 Property Map DGN <& s
shall be uploaded

Figure 222 - Uploading Property Maps

3. Select the Interface,
View>Toolbars and select interface.

“CTDOT _Doc Code.” If the interface box is not shown, select:

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder
5. For each file, continue to click Next in the Advance Wizard until you get to the
Attributes screen and assign the attributes shown in Table 5 of Appendix E

o

Click Next until the file uploads.

8. When the files are uploaded, the creator of the Property Map shall send an email to the
following people including links to the documents in Projectwise. To do this, click on
the document and then highlight and copy the address located in the Address Bar. Then

paste it in the email:

e ROW Administration/Assistant Director — Thomas.Ohala@ct.gov
o ROW Supervising Coordinator - Robert.Ike@ct.gov

o ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov,

Shandi.Wong@ct.gov

Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov

e Appropriate Project Coordinator - Steven.Degen@ct.gov,
Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.lreland@ct.gov

To submit a revision to the property maps, use the same steps above but add “Revised” to the

label attribute.
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9.2 Parcel Polygon File(s)

The Parcel Polygon files shall be created by the creator of the property map and represents the
area to be acquired by the State. It should be accurately based on existing property lines and
proposed Rights of Way lines. These files shall be submitted at the Project Milestone — Design
Approval and updated as necessary as the project moves through design and construction.

9.2

.1 Parcel Polygon File(s) Creation

The following steps explain how to create and submit the Parcel Polygon CAD file(s). One file
shall be created for each parcel - only permanent land and easement acquisition areas.

When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of
the Property Map shall also be submitted into ProjectWise in accordance with this manual,

see section 9.

TEMP. EARTH

SYSTEM C ‘ / TEMPORARY
SYSTEM /

PROPOSED COFFERDAM
WINGWALL

(TYP.) LIMIT OF D.R.O.W.
PROPOSED PROPOSED RIPRAP
15" DIA. SPLASH PAD

R.C. PIPE

Figure 223 — Property Map parcel area example

Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map

is in. This is usually found within the referenced ground survey file title block

IN House CTDOT Staff — Then create a new MicroStation design file using the correct

seed for the datum in the project located in the W: Drive. See folder address below:

W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\

=

Recent Places}

Select Seed File -

Look in:

CTDOT_V8_Workspa

Geospatial

Date modified Type Size
7/17/201412:59 PM  Bentley MicroStati...
TAT/20141:10 M Bentley MicroStati...

31KB
31 KB

J#2D_Poly 27FT.dgn
82D _Poly_2TM.dgn
92D _Poly 83FT.dgn
52D _Poly_83M.dgn

87 KB
31 KB

Stati...
Stati...

8/26/201412:51 PM  Bentley Micro!
7/17/2014 1:03 PM Bentley Micro

File name: CT_Design_30_V8idan

: g

o

Files of type: MicroStation DGN Files ("dan) hd |

[ Cancel |
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Consultant Staff: Download the seed files using this link: Geospatial Seeds
3. Reference the Property Map file into the newly created file using true scale off and 1:1

) References (1 of 1 unique, 1 displayed) IEI =] @
Tools  Settings

i il s bl N s :
-] ] e | g ] 20[ 28] s 2] 53] 28] @ o i Mose (Boundates <)
Slot ¥ (4 File Name Model Description Logical Crientation Presentatior

1 HW_HWY_012... Design Design Design Coincident Wireframe

4 | 1 | r

Scale | 1.000000 - | 1.000000 Rotation §00°00'00" Offset X | 0.000 Y 0L

achments: Display Ovemides: | Allov

-

EIT Y L e[ o7 2 o] e

Figure 225 - Reference File

4. Verify that the tentative coordinates of the new file match the Property Map (using
stationing, grids, etc.)

5. Set the MicroStation active level to “SV_PARCEL DATA” for Parcel Polygon(s).

Then place a closed polygon using the shape tool or the smart line tool.

7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the
creation of property maps. The task contains “Shape for GIS” tools which can be used
for polygon creation:

o

Tasks v I X J Tasks > |
| CT Property Maps
¥ Tasks v l
P .9 9 [F oo
j Srt e _}J ﬁ f .2 [’l% 2oy _k ﬂ"‘vﬁ’t;’%»j?ﬂ‘ fi-rgp} Sk
J‘"bJ [ B DJ:‘D‘ > ﬂut 2 . :J E A \\) '-—.l
j\-’» e :JD( » \)r »"\'L't
CT Architectural wd
: < ROW Lines v
CT Highways d
— # Map Info v
CT Illumination v
@ Notes v
CT Landscape ~
A Dimensions v
CT Site Design adl
&~ Internal Use Map Preparation v
CT Structure Bridge -0 1=
i.i Utilities v
CT Traffic ol
CT Sheet Composition ad
CT Publishing v ~ & € Shape for GIS (no arcs)
CT Location Survey ~d § V] Shape for GIS (with arcs)
CT Property Maps wd

Figure 226 — Custom MicroStation tasks
8. After the polygon has been placed, turn off all reference displays and fit the polygon to
the view.
9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml
file to Google Earth by choosing: File> Export> Google Earth.
10. Google Earth should then automatically open and zoom to the Project Polygon vicinity.
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9.2.2 Parcel Polygon File Submission

The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following.
[Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, it
is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted]
1. Log into ProjectWise
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project.

B DOp g - E, @ : @ - Search [0 Boundany® ~ [» :Interface| CTDOT_Dac_Code
L!'_ Address - |:>G°
L% o170-2876 - Lst | @ Geospatial |

1-" 100-(:0””3“—'3'3”5_;'3[13 Label (User Defined) Description

4 110_Contract_Specifications (PDF) 2 Bound Proiect Limits - Southbury. W,

[ 120_Contractor_Submittals (PDF) o/ #Boundary roject Limits - Southbury, Weston

; # & | Boundary Project Limits - Southbury, Weston

1_‘_ 130_Engineering_Reports
LJ_ 140_GIS
+-4" 210_Construction

Figure 227 — ProjectWise parcel polygon folders example

3. Select the Interface, “CTDOT_Doc_Code.” If the interface box is not shown, select:
View>Toolbars and select interface.

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder

5. For each file, continue to click Next in the Advance Wizard until you get to the
Attributes screen and assign the attributes shown in Table 5 of Appendix E

6. Click Next until the file uploads.

9. When the files are uploaded, the creator of the Property Map shall send an email to the
following people including links to the documents in Projectwise. To do this, click on
the document and then highlight and copy the address located in the Address Bar. Then
paste it in the email:

e ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov,
Shandi.Wong@ct.gov

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to
the label attribute.
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Appendix A - Initial Bluebeam Settings

Initial Log into Bluebeam

These steps only need to be completed the first time using Bluebeam or when the user logs into a
new computer.

R

Bluebeam
Fevu

1. Open Bluebeam by selecting the desktop icon:

If you do not have a desktop icon, select Start>Bluebeam Software. Right click on Bluebeam
Revu, select Send To>Desktop (create shortcut). This will place the Bluebeam icon on your
desktop:

PW_Delet.., EED Estimator... Rename

> |(E) ScriptLogic Corporation
H@ section wizard

) AutoTrack we_'g SiteManager

) BASINS D\cﬁ SiteManager Training
) BCAP40 » ) sMs 100

) Bentley * ) sMs 101

) Bentley Cvil Engineering » i) snagns

> |7 Snagh Studio

» |7 Spectra Precision
D) Help »
» |5] sluebeam Administrator
o
I Restort POF Printer e

WW

o) sy Endpoin

2 TDS Survey Works_ S22 for Viruses...
) TextPad ) Compress to ZIP + Options...
) Trimble Data Tran ¥ Compress to "Revu.zip"

» =
" "

StormCAD  StormCAD
V8i for Mi... v8i

F Y Y Y Y YT Y Y w vy w

) EPA SWMM 5.0
) Estimator

) Filezilla FTP Client

) Gadwin Systems

™) Google Sketchup 7

) Google SketchUp 8

) GPs Pathfinder Office 2.90
) GPSurvey

2 v Select Send To
) HysEnergy

) Hy-8

) Hydraflow Hydrographs 2004
) Hydraflow Storm Sewers 2003
) Hydraulic Toolbox

) Intervideo WinDVD

) K-Lite Codec Pack

J sluebeam POF Printer
& sluebeam Stapler
L] Compressed (z'pped) Folder

Yy v Y v v vy wvoww

Y Bing Maps 30
8 checkras

) LightScribe Direct Disc Labeling FishXing V3 beta
,,,,,, z - {7 McTrans & HOS 5 Chart Calculator 1.5.8
» ) Microsoft Office € Internet Explorer
, (T Microsoft Siiverlight &) Outiook Express
) MicroStation PaINt.NET

€ Pathfinder Office Connection Manager
@' pathfinder Office Project Changer
3 powerarchiver

¢~ Remote Assistance

5 samwin

* ) NVIDIA Corporation

, ) Oracle - OraClient10g_home
) Pathfinder Office 2.51
) PENNDOT Programs
) PowerArchiver 2001

Windows XP Professional

) PrimoPDF (2) Windows Media Player

) QSE Software Suite ) Windows Movie Maker

) RAM Concept 2.1 ) Google Earth »
) RAM Connection 4 B TextPad

g/Start ) O Inbox - Tellier, ... | % P ) RaM Structural System
IJFU@S( | Rodo

Y Y Y Y YYT YT YTYTYTYTYTYYTYYTYYTY YY YO

Figure 228 - Creating Desktop Shortcut
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2. When the “Welcome to Revu” dialog box opens, select Design profile and Dark look:

Choose your profile

 Office

" Estimation € Tahlet
™ Construction © Simple

Choose your look

Welcome to Revu

Pleaze zelect a user Profile and a desktop look that best suits pour needs. [n the future, vou can change vour
Prafile by going ta Yiew/Profiles and your deskiop backaraund by gaing ta Edit/Preferences/General.

X

3

DCesign

Thiz profile includes advanced
markup features geared towards
thioze who will uge Bevu az a design
review and collaboration ool and
need precize control over markups,
measurementz and properties.

STTRY
LT
¥, 3]
PO I
(¢ Dtk [default) " Light

" Classic (05 colors]

(Firisn_D

Figure 229 - Welcome to Revu

3. A dialog box may appear asking if you would like to add a ProjectWise Client Interface.

Select Yes:

Detected ProjectWise Installed x|

A

Interface’?

Bluebeam Rewu haz detected that the Projecttize Client is
inztalled. ‘would pou like to add a Projectise Client

es ) [ [a] |

Figure 230 - Bluebeam/Projectwise Link
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4. Enter ProjectWise Login Name and Password. Check “Checkout on Open” and
“Checkout on Open from Hyperlinks”. Select OK:

Add Document Management System

Should read this

Type: | ProjectWise V& w

DataSource™: |ctdut.projectwiseonline.com:CTDOT

(

D

«—

Login Name: |n'|jc-admin
Password: |'"" |
|| Checkout on Open

iCheckout 'on Open from Hyperinics;

* required

Enter your Projectwise
username and password

— Make sure these
L= Click

"

Co DT

Figure 231 - Projectwise Login

5. Click on the settings icon in the top right hand corner and click Preferences as shown

below. If you cannot find the settings icon in
Preferences.

the top right, go to the Edit menu and select

Figure 232 - Bluebeam Preferences
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6. Click on File Access and make sure the box is checked as shown below: If ProjectWise is
not listed click on Add

Preferences

Document
File Access
General

Grd & Snap
Import/Export
Markup
Markups Tab
Mavigation
FDF/A
Presentation
Rendering
Rendering 30
Signature
Snapshot
Speling
Startup
Studio
Tablet
WebTab

[ Import H Expart ]

Document Management Systems

Enable Recent Files
Show preview of PL

ems in Recent Files:

Recent history limit: |90 Days  +| [ Clear |
Check these boxes

[ ShareFPoint Options... l

(1) Click

[ ] Toolbar integration only

Ready

ctdot projectwiseonline. com:CTDOT

(2) Click

| add || Edt || Delete |

| ok || cancel |

Figure 233 - Projectwise Integration

After you click Log in the status should read Logged In as shown below:

Preferences

Documert
File Access
General

Grid & Snap
Import/Export
Markup
Markups Tab
Mawigation
FDF/A
Presentation
Rendering
Rendering 3D
Signature
Snapshot
Spelling
Startup
Studio

Tablet
WebTab

oo

X
Recents

Enable Recent Files
Show preview of PDF

ttems in Recent Files:

Recent history limit: |5'DDa‘_.'S vH Clear ]

Document Management Systems
] Toolbar irtegration oty
Always show selection dialog

Location Status
ctdot projectwiseonline.com CTDOT Logged In

[ SharePoint Options... ]

Type
ProjectWise Vi
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7. Inthe General section in the User area type in your name (First Initial and Last Name),
title, and your office name. An example for me would be M. Calkins TE 2 AEC
Applications. An example for a district construction user would be J. Smith TE 3 D2

Construction.

Preferences

Document

Import/Export
Markup
Markups Tab
MNavigation
FDF/A
Presentation
Rendering
Rendering 3D
Signature
Sniapshaot
Spelling
Startup
Studio

Tablet
WebTab

Import Export

|| Enable Document Recovery

Allow Multiple Instances

Enable Auto-Complete

Enable Single Key Shortcuts with Farm Fields
Enable JavaScript

Show Splash Screen

Find Hyperdinks in PDF Content

Diark Light

- .-
Brightness: ‘,)

CD Classic Mode

[ Classic Menu )

(1) Click

v

— (2) Type in
User Name

(3) Make sure
e
these are
unchecked

Figure 235 - General Preferences

8. Update the markups options to match the following:

Preferences

Document
File Access
General

Navigation
PDF/A
Presentation
Rendering
Rendering 3D
Signature
Snapshot
Spelling
Startup
Studio
Tablet
WebTab

Mariup
[] Reuse Markup Tools

Chynamically Set as Default properties
Autosize Test Box and Callout Markups
Embed Fonts
Show Author and Date in Pop-Ups
Print Pop-Ups Opacity:
[] Copy selected text into Text Marups
(Highlight, Underline, Squigaly, Strikethrough)
Retain Layer Info. when copying Markup.
[] Use Relative Paths for Hyperlinks and Actions
Set 'Open in New Window” option for Hyperinks and Actions

Defautt Image Encoding:

Import Export

k Drag Behavior for Shapes:

J/

Make sure these
options are selected
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9. Update the markups tab options to match the following:

Preferences
Document Markups Tab
gfngcmcless Zoom Fit Marcups when selected )
ﬁ:oﬁfsél::%rt [] Use Rich Text for Comments

Wrap Comment Text

Fittered Annotation Dim Percent:

[] Exclude Fitered Marsups on Export

Markups Tab

FOF/A
Presentation
Rendering
Rendering 30
Signature
Snapshat
Speliing
Startup
Studio
Tablet
WebTab

oot

£3

Check

Figure 237 - Markup Preferences

10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web
Tabs is unchecked. This will open any hyperlink that is in a PDF document using
Internet Explorer instead of Bluebeam. This is the last preference you will need to update

so you can click Ok at the bottom right now.

Preferences

WebTab

Always switc
["] Open POF Hyperinks in WebTabs
Open web PDFs in split-view

Document
File Access
General

Grid & Snap
Import/Export
Markup

W AV eD | 305

er they are created

Markups Tab
Mavigation

D

[ Use standardized favorites: |

FDF/A Ty

Presentation
Rendering
Rendering 30
Signature
Snapshot
Spelling
Startup

Studio . C I ic k

e &

[ Import ][ Export l

Show script emors

[ Edit Web Favortes... ]

Click

Uncheck

Ok rcel

Figure 238 - Webtab Preferences
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Downloading

the CTDOT Bluebeam Profile

1. Download this file and save it to your desktop: CTDOT Bluebeam Profile
2. Double click on the profile in the zipped folder on your desktop.

= P =2 il -
&30 # & 4 3
New Open Favorites Add Extiact  Delete Wiew CheckOut
Nane | Modiied | Size | Ratio | Packed | Path
T/B/20129:18 &M BE7.863  E6% 280,627

e CTDOT As-Builts Profile. bps

D)

Double click on
this file

Total 1 file, 555 kB [245 kE] @D

Selected 1 file, 656 kB

Figure 239 - Importing the Bluebeam Tools

Bluebeam Stamps
To be able to select your stamps follow the figure below:

1. Select

2. Browse to \SH3DGS18\CTDOT Projects\V8 Admin\Bluebeam Resources

the Markup tab and select Stamps>Change Stamp Folder.

'
Jon R. Hagert.brx

Order Stamp.brx

Document1*

Figure 240 - Selecting a Stamp Folder
and select

correct discipline.
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Browse For Folder

2] %]

@ Deskrop
{f] My Docurnents
= My Computer
i UniCADD_2012_08_09 (C:)
-aee User Data (D)
[ DVD-RAM Drive (G:)
3% GIS Data (L:)
x Groups on 'Sdedbsa0’ (S0
3% TRU Maps (T:)
x CalkinsM3$ on 'Sdedbsan’ {U:)

P

-5 DS CTDOT_Projects (SHADGS18) (X:)
BHED) ve_admin
B&) Eluebeam Resources
B0 As-Built
E) Bridges
#-{C3) CTDOT Starps
&) Facilities
#-) Highway Operations
&) Highweays
-5 Other Watermarks
E) Setkings

\ B0 Traffic

i g
J‘ﬂ My Metwork Places
@ Recycle Bin

~{2) AdoheCs

13 dynamic stamp
~13) Mew Folder

~12) Mew Folder (2)
|27 POF forms

£ System

Make Mew Folder

<« Browse to folder
and select
discipline

Select OK

) =

|

Figure 241 - Selecting Stamp Folder
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Appendix B - Usability of PDF Documents

Usability of PDF Documents

This section contains information about viewing digital contract documents.

Structure of Digital Plans

Final Design Plans, Addendums, and Design Initiated Change Orders

The contract plans are split up into discipline subsets, which are multiple sheet PDF documents
digitally signed by the Designer. Addendums and Change Orders are also submitted as discipline
subset, with only the changed sheets. For example, an Addendum that affects the 03-Bridge
Subset will require the submission of a 03-Bridge_A1 subset.

Digital Plans are located in the 100_Contract_Plans folder in Projectwise. Below is an example
of a project’s discipline subsets in Projectwise:

~ List | @ Geospatial

Label (User Defined) Description Main Category | Sub Category 5ub Category Description Application

/' B o1_cereral 01 _General_revision.pdf COM FPL Plans_04 - Final Plans {adv) Acrobat PDF
ra @ 0Z_Revisions 0z _revisions _ce.pdf CON FPL Plans_04 - Final Plans {adv) Acrobat PDF
' B 0z_Revisions_a01 0Z_Revisions_A01 CON ADP Flans_05 - Addenda Acrobat PDF
r @ 03_Highway COon FPL Plans_04 - Final Plans {adv) Acrobat PDF
ra @ 03_Highway_a01 03 _Highway _A01 rev CON ADF Plans_05 - Addenda Acrobat FDF
7 @ 04_Traffic 04 _Traffic.pdf COM FPL Plans_04 - Final Plans (Adv) Acrobat PDF
ra @ 05-Landscape 05_Landscape revl.pdf CON FFL Plans_04 - Final Plans {adv) Acrobat FDF
# B ve-structures Bridge 02695 Structure Plans COM FPL Plans_04 - Final Plans {adv) Acrobat PDF
ra @ CTDOT_HIGHwWAY_STD ctdat_highway_std.pdf COoN STD Plans_10 - Standard Drawings Acrobat PDF
# B CTDOT_TRAFFIC_STD cbdot_traffic_std.pdf COom STD Plans_10 - Standard Drawings Acrobat FOF

Figure 242 - Discipline Subsets in Projectwise

As-Built’s
As-built’s will be placed directly on the PDF Subsets using Bluebeam.

Functionality of PDF Digital Plans

The PDF digital plans have the following functions when the digital contract plans are created in
accordance with this manual:

Turn levels on and off

Search for all text on the documents.

PDF plans are measurable
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Digital Plan Levels

The plans have the ability to have their levels turned off and on. This can allow for easier
viewing of the contract sheets. See below for turning levels on and off:

R R Fle  Edt Dsmma e

8 -
vhw @ o=
=
Mew  Open : Frint E-mail

R wmEEoE-BE ey

B

Markup

Turn levels on
and off by clicking
here

TNEPECTION OF FIELD Vells
[ w1

fou]
= ———
[ v |

STATE OF CO
DEFARTMENT OF T
OFFIGE OF ENGIREERING

YR
Figure 243 - Turning Levels On and Off
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Searching Digital Plans

The plans can be searched for any text located on them. This can be useful if searching for a
certain pay item.

See below for searching the PDF Plans for text.

GNP A |H |5

Ve JEl
|« 0 v-9|§
« Ciiteria
@ Text |Concrete

O Mizual Get Rectangle

Type in what
you want to
search for or select

an object to search for

Select Current -

v o P@0€ O Whole
: - document

Search Pages

[] Search File Properties
Search Form Fields
[] Search Markups
[] Case Sensitive

[ *whale 'wards Only

e e sy R Soarch options

K MEMBARKE WATERFRODFIMG (WOVEN GLASS FAERICY

g DESCRIPTION OF WORK

5 = 1 INSTALL HANDLING WATER SYSTEM, _FPL_| RUCTURES. pdf*

3 2. INSTALL COFFERDAM, CONSTRUCT CUTOFF WALLS, RETURN WALLS AND WINGWALLS,

g g 3 CLOGE AOUTE 148 AND DETOUR TRAFFIC. SFF WAINTENSNE AMD BRATECTIN [p.1) MM COMCRETE BOX CULVERT I..

o OF TRAFFIC* SPECTAL PROVISION,

H LRENNE EXISTOG STRCTISE /80 VB! [p.1] M COMCRETE BOX CULYERT E...
. INSTALL PRECAST COMCRETE BON CULVE [p.1] MM COMCRETE BOM CULVERT O...
il Search Results {p.1) MM CONCRETE BOX CULVERT4..
B CONSTRUCT ROMDWAY STRUCTURE A0 R [p. 1] PRECAST COMCRETE BOXCUL.

[p.1] BOX COMCRETE CULYERT 3600..

CENERUL MOTES ¢ {p.1] BOX COMCRETE CULVERT 2600..
R IEATINS SATED RAY 2010 T SPECIAL ROV | o o SLFTLENETEL {n.1) CONCRETE DEFORMED STEEL ..
e TR D T PR B VLR RL T (T CONEAEE HEU,
BAIDGE OESHoH HARRL 29651 g 1) PRECAST CONCRETE BOX CLILY..

P 3 ALLOWABLE DESIGH STRESSES ¢ [p.1] COMCRETE CURBING. SEE HIGH...
COMCAETE FOR FRELAST CONPOKENTS BASED N F'C ¢ 35 MR

- 48 LA HOMCRETE o ot 420 g*,pag‘ug sz {p.1) PRECAST CONCRETE BOX CULY...

; VELDED WRE FABRIC o UCTN aigm S (TBSLELLSE 164 {p.1) PRECAST CONCRETE BOX CULY..

! o LIVE LD KL {p.1] FOR CONCRETE FORMLINER P4, .

5, FOUMDATION PRESSURES @ SEE WINGWALL DETAILS SHEET . [p. 1] COMCRETE." IMSTALLING PRE...
6. DIMENSDINS ¢ ALL DIMENSION m ] :;E PL# ﬁ"mﬂ_ré%lﬁlsm ucEPT JF rmm [p.1] COMCRETE COVER : ALL REINF...
T e, P e oD Db S oE cEiegD 10 ot TEMIe, {p.1] OF CONCRETE SHALL BE BEVEL..
INIT | AMOUNT | 7.cuess ¥ CINCRETES CLASS "W COMCRETE. WAL BE USED FIR CAST-BHPLACE COMRETE [p.1] 01-CONCRETE FOR STRUCTURE. .
L& LS AOUGHAT. . o
W e B, SILICONE JOMT SEAL ; SEE SPECIAL PROVISIN "SECTION S.81-CONCRETE FOR STRLCTURES® [p-1) COMCRETE: CLASS "A™ CONCRE. .
W *DPOSD EIGES (EXPOSED EDGES OF CONCRETE SHALL B BEVELED 26 MM X 25 MM IMLESS [p-1)CONCRETE SHALL BE USED FO...
= = DIMERSIORED OTHERWISE. (p.1) CAST-IM-PLACE COMCRETE TH...
[p.1) COMCRETE

o T T A

~

Figure 244 - Searching for Text in PDF Plans
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Measuring on the Digital Plans

The plans have the ability to be measured in PDF. This is helpful because a paper set does not
need to be created for on desk measuring.

HBORSON /

CT_CON_FPL_0026-0118_06-STRUC

See below for measuring in PDF.

2. Select specific
measuring tool

1. Set Scale

BT

CONCRI

'5 MM_HMA S8.5
42,600 by g fm Example of a W15z MM FvA ST HIGHWAY TTEM).
measurement

55 2600 15808] 00__ 3160 550
TYP) Hlﬁ WESTBOUND EASTBOUND [ 3HLOR |~ SIDEWALK
TPy B ROUTE 148
>< B.LLLC.

_M £ 2.0 207, 6.0% L

——————————— 3 L= —— 3-—

+

SECTION

SCALE 1:100
- WALL
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©

+153.321

450 MM NATURAL STREAM BED MATERIAL]

SUBBASE MATERIAL STATICALLY ROLLED (NOT VIBRATCRY)
ON MEMBRANE WATERPROOFING (WOVEN GLASS FABRIC)

=

211

1. INSTALL HANDL

Figure 245 - Measuring Tool

Recaloulate
Measurements
Subject: | |
Labek | |
Depth | |
Seale: 1 mm =100 mm
Current Total
Length: 2,600 rm 37,458 mm
Area 0 0
Perimeter: i i
Diameter: 0 0
Angle: 0 0
< Radius: 0 0
Volume: 0 0
Count: i i
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Digital Specification Package
The FDP specification package will be one PDF document and located in the
110_Contract_Specifications folder. This package includes all specifications, Notice to
Contractors, Wage information, etc.

The Addendum specifications prepared in the same way as the FDP specification package and
will also be located in the 110 _Contract Specifications folder.

The Design Initiated Change Order specifications will be contained in one PDF document located
in the 110_Contract Specifications folder when they are released to the Contractor.

Some useful features on the digital specification package are:
e Search for any text in the document, see Searching Digital Plans
o Bookmarks for each section in the specification package

Document Foim Iarkup

Print E-mail Studio el e £ Image pperlink  Attachmer Stamp

n

ol

TABLE OF CONTI

] Note: This Table of Co
contract with the sole

herein; and no claims st
of Contents shall not be

sumrmary -

Figure 246 - Bookmarks in the Spec. Package
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Document Compare Tools
Bluebeam has the two tools for comparing documents: (1) Compare Documents and (2) Overlay
Pages. Compare Documents will compare two documents and create a third document that
clouds all the changes. Overlay pages will create a third document where the pages of document
A will become one color and the pages of document be will become another color. When the
pages are overlaid you will be able to see the changes from the difference in these two colors.
Both of these tools can be used for single and multipage PDF documents. The following shows
how to perform a document compare and how to use the overlay page tool.

Document Compare

1. Open the Revised document first and then open the original document that you want to
compare from Projectwise or your computer.

2. Next go to Document>Comparison>Compare Documents as shown below:

f? (o File Edit Wiew Document Form Markup Measure "window Help

em-@ O i % RN
$ ages o F)

Frint E-mail Studio

" Compare Documents. ..

U.l.I.l.|1.|.I.|.E|.I.|.B.|.I.|

+ Recents

@ _COMN_FDP__01-General pdf Completion

@ _CON_DCD__01-General pdf

FINAL_10-3 UE... i
By submitting thes farm it sgnifies 1

contract plans.

Figure 247 - Compare Documents

3. Inthe window that pops up you will notice the two documents that were just opened.
Click OK to run the document compare as shown below:

Compare Documents Pz|
Documentd,
Document: |d:\pw_working'\pwonline\mic-admin\dmsES £ | E]
|&ll Pages [1 - 36) w |of 36 Documents
File[1af1]: ET_COM_FPL_0170-3065_0I0D 04-.. that we re
Page: Range [1-36 Qpened
Dacurent B
Document: |I:I:\pw_wolking\pwnnline\mic-admin'\dmsBS vl D
|4l Pages (1 - 36) v |of 38
b anual Alignment:
Select Windaw ] [ Pick. Paints ]
Summary Beport:
Other Options:
Split-zcreen view [zpnchronize] [ Tum an Dimmer
Comparizon type: | Frinted Documents [zame printer]” W | ..___.-l C I ic k 0 K
| dvanced. || AddFies | aF, Cancel

Figure 248 - document Compare
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Overlay Pages

1. Open the Revised document first and then open the original document that you want to
compare from Projectwise or your computer.

2. Next go to Document>Comparison>Overlay pages as shown below:

File  Edit Measure  Window

Form

i

Document

A
=

v Markup

® v B

Help

* T |§
L S .8
| Comnare Nocuments

’ " Overlay Pages...
[

Select Document>
Comparison> Overlay
Pages

Figure 249 - Overlay Pages

3. Inthe window that pops up you will need to select which pages of each document you
want to overlay. To do this double click on a file, then in the window that pops up type
the pages you want to overlay. The example below shows pages 1-28. Once you select
the pages you want to overlay click OK.

NIALE FEULIFL .1 NUL Y2-8LZ

@ES 1-28

.d@‘._

Overlay Pages... ’Eﬂ
e To set which pages
Document Color Layer Pages
a (Addendum No. 3pdf B Addendum No. 3 njﬂ‘/ to Overlay double
- Addendum No. 4.pdf (] Addendum No. 4 1of 28 CI iCk on a fi Ie
Figure 250 - Overlay Pages
Add Layer |E|
Layer
Source:  Addendum Mo. 3.pdf - D [

Layer: @ Create New:

(7 Use Source Layers

Appearance [Base Layer]
Caolor: @
Background:
Opacity:
Blend:

100 %
Momal {none)

ol
(IRL L=

1.001
AL

|-
(LRE He

Absolute

Inches

ol
UL =

Addendum No. 3

i__ Type in which
pages to overlay
i then click OK

T o/ [

Issued 9-2014

igure 251 - Overlay Pages

214

Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

Appendix C - Using the Set File

Opening the Set File
Double click on the set file from Projectwise and open as shown below: This may take a while
please be patient. Note: The first time opening a set file will take longer than any subsequent
times.

115 L~ PSS < ALV U U LUU_ LU L PSS 1P

>

List \. Geospatial

Description Main Cateqory | Sub Category | Sub Categary Description Application File Updated
(/) on-Consoldates 5ot Mew Set con < Flans_08 - Consolidated 5/23(2013 11:02:12 AM 5f2°
Te-Structur Structural Shests conl FRL Flans_04 - Final Plans (Adv) Acrobat FOF 5/22(2013 5:24:27 PM 520

Z Bloi-ceneral Title Shest con FPL Plans_04 - Final Plans (Adv) Atrobat PDF 5/22/2013 S:10:41 PM 520

7 B CTDOT_TRAFFIC_STD con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/22/2003 2:38:09PM 5[0

/ B cToot_HicHwaY_STD con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/22/2003 2:37:03FM 5[0

# Bl 03-supporting Docs CON FPL Plans_04 - Final Plans (Adv) Acrobat PDF Sf21f2013 112001 AM - 5/2(

o/ Bl 0z-Revsions won FRL Plans_04 - Final Plans (Adv) Atrobat PDF 5/20/2013 LOLI4PM Sf

/7 Blos-architectural con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2003 1:00:16PM {20

# Bl 1n-Environmental Environmental con FRL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2013 1:58:47 PM 5J21

# B oo-lectrical Electrical Sheets o FPL Plans_04 - Final Plans (Adv) Acrobat PDF 5/20/2013 12:58:46 PM 5/2(
— | / Blos-mechanical | shect e £o Slanc na_. Finalolane (a2 hatEnE 158146 P 5[2(

A B 11-Treaffic Tr pen do i 58:40PM 520

# B o7-plumbing Pl ISTHATPM 520

7 Bloscw Civf | Select \ Double click on \STIOLPM  S[20

Program \ -
the set file and
hame Description B Ere
(%% Bluebeam Revu Set heam Revt CI ICk 0 K varelBluebeam RevulRevuiRevu exe" ", No
<

Document Properties \ Project Properties

Property name
L i
Falder Name
Enwironment
File Mame:
workflow

>
Updated By rouise
File Updated By
Status [Jopen dacument as read-only
Yersion Click here For a lst of suagested document viswers
File Revision

Local File Revision|
Local File Directar: ) Concel |
Shareable

[~

Figure 252 - Opening a Set File

Viewing the Plans Sheets within a Set File

All the plans sheets will be combined and shown on the left hand side of the screen in a
thumbnail view. To view a sheet, simply click on that sheet and it will open up.

Q @ File Edit Wigw Drocument Farm Markup Measure Window

=9 O

Open Frint E-mail

REwEESE-9E o

_____ . T — ¥ CONNECTICUT [

45 5 ACHUSETTS
o 1 DISTRICT 2

Click on a thumbnail
_and the sheet will
-open on the right

G, " Fagi" DISTRICT 3
i
q - " STATE OF CONNECTICUT
vy

GENERAL NOTES:
R

Figure 253 - Viewing a Plan Sheet from a Set File
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Marking Up a Set File
1. Open up the set file by following Section 1.4.1. You will notice on the left hand side of
the screen will be thumbnails of all the sheets in the set file.

Toolbars  Profies

@ CT_CON_ADP_0102-0278 01-04_TYP_A02 =

All the sheets in the project
will be shown in the thumbnail
view

LEQEND
i - 202 ireaces o0 e G ri
A R ConesETe
ot 50.5 ¢Borm KT LIFT
150 - bk 51 (PLACE TN TWD GOM LIFTS) S - A 50,5 (S0 NARIUAM
om WHAEEATE sk Shom - i 20,8
WOTE: DEFTH OF PROCESILO ACGRECATE SUBBASE AL EXTSTING P.C.B.C. (A14em & 1145wm) VARTES = What 50. 575 (S0 MAX TeUM LT
ERCASED 7O asom 47 HE o I SARDER TREATMNT i SHDE O Sa VS~ . 50,5 (Dorm WAKTM LT
e S DETATL O BT TUPT 00, PROCESIED ABOREGATE BASE 1 omen
T WINIM CROSS SLOPE +% OF AS SHOWN OM (R0SS SECTIONS bwm
24402 10 30 METAL SEim AAIL (SEE FLARS FOR LINITS esom PROCES3ED MGOREGATE } o emecm
34508 15 3e400 150mn DTTUMEMOUS COMCRETE L] TG WINTMM CEDSS SLOPE 1.3 OR A5 SHOWH OH Al POINT ©
a1 S CONGRETE CUmR N e o e
2t 10 20 o GONGETE S0 o 20315 z .
- FIRE MILL Wk 1 2-t0te

STATE OF CONNECTICUT
DEFARTMENT OF TRANSPORTATION

Figure 254 - Sheets in the Set File
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.
You will notice that sheet opens up on the right:

Scroll down to the
sheet that is to be
marked up and click
on it. You will notice it

opens up on the right.

Figure 255 - Marking Up a Sheet
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3. Next to markup the document we must unlock it (Check Out of Projectwise). To do this,
right click on the lock and select Check Out.

» 2 - ot -
= 5,
% A L P P B M M 9 1
CT_CON_FPL_0102-0278_01-01_GEM pdf
i
r
@ DEPAR~
,-|Locxn0N OF
T
ENDING OF STATE
PROJECT W0, 1278
185 STA 4:200

01.01.001

Right click on the lock _
‘and select Check QOut —————

Figure 256 - Checking Out a Document
4. Notice the lock changes to a Check and you will be able to markup the document.

er?em
vik-w@-om 4

New Open Save Print E-ma= Studio

I REwEEomE-SEau R

r s Ew

SEE DETAIL B
o ST TrR-1z

W
STh. 24520 TO 2+660

Figure 257 - Checking Out a Document for Editing
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5. To mark up the plans use the tools located in the tool chest shown below:

BOLNE:/ QNS A |EiB|g

Click on the : TREATMENT UNLESS -8

3. TYP-T.
tOOI CheSt SWALE DETAILS) he
1-95 NORTHBOUND : E o
NORMAL SECTION Markup the plans _usmg \ - ::o«puedn::‘m“ deorrpHe%%t::‘
STA. 2+420 TO 2+653 the CTDOT As Built Tools — |As ik Stamps =
| As-Buitt Stamps This sheet comected
As Built \b o |As-Buit Stamps Szl
e These quantities not
Example PROPOSED 1-91 SB WIDENING - e
PREPESED g B B 5 {> Text Box
EXISTING I-95 NB ) & 2 e
‘ : { Line Use to Cross Out
EXISTING GROUND A
3g6m . 386m . 366m . 360m . 3.60m 7 [Amow
LATNE LA;E M;E LA;E SHLDR \ /
e o
e X, (Growp Cross Out
vartes|  vartes| vamies | 2.o00% .o0% | _- (;;3 Cloud

®/®_/SEE DETAIL A

ON SHT TYP-12

SWALE TREATMENT UNLESS OTHERWISE SPEC
TYP-6.TYP-7. (SEE MISCELLANEOUS DETAI

o]
i

Figure 258 - Marking up the Plan Sheets

Issued 9-2014 219 Version 3.07



Connecticut Department of Transportation Digital Project Development Manual

6. When finished, click Save and then right click on the Check and select “Check In”.

Am

Save Print E-mia

Then right click on

the check and select
Check In
& I-95
TING T-95 58 EXTSTING 1-95 NB
@2 n
: . 3B6m ,  366m MED. 386m . 366m ., 356
LANE LANE 520 520 LANE LANE LANI
m LT

| ! ] 1 1

&1

Figure 259 - Saving Markups and Checking Into Projectwise
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Searching a Set File

The Set feature in Bluebeam allows you to search across the entire set file. The following shows
how to search a set file:
1. Click on the Search Set file icon and then type in what you want to search for as shown

below:

Click on the
search set file
icon

Type in what you
want to search for
Select "Current Set"

Search Pages

[[] Search File Properties
Search Form Fields
[1 Search Markups

[] Casa Sensitive

[ whole \words Only

01.01.02

Figure 260 - Searching the Set File
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Printing the Entire Set File

Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.
Printing the entire set will print all the sheets in the set file. Printing the latest revisions will print
the most up to date sheets and not print the previous revisions. Printing the previous revisions
will only print the sheets that were changed by a revision.
The following shows how print a set file:

1. Select the print set file icon and select the desired option:

r() fvu  File Edit Wiew Crocument Farm Markup Measure Window

vik-wEl- om-a4 O < §

Open Sawe Frint E-mail Studio Security Signatures Pages
. - = : 1
REwEESE- -SE = -of Il Ik

- ® g

Select the arrow on the
print icon and select the
desired option

01.01.01

_—
01.01.02

Figure 261 - Printing a Set File
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Appendix D - Consultant Submittal Review
Stamps

Consultant Designers can import the Bluebeam User Profile using the following link. This
profile imports all the commenting tools in the correct format.
Download the profile from this link: CTDOT Bluebeam User Profile. Just double click on the
file located in the zip file and the profile will be imported.
After the profile is imported the following must be done.

1. Delete the Submittal Review stamp that is in the tool chest as shown below:

.
&

CTDOT Rew

In the tool chest
select the Submittal

LI

* LTDOS h ing Drawing Review Tools

stamp and click - subice Comment
H = . Contractor Submittal
the delete icon [~ |subriva Foion St
- Highlight
= Highlight
é Text Box |Jze to Add et
& Callout IJze to Add a Callout
IJze to Cloud
@ s Corections
/ Line IJze to Crozs Out

CTDO

4k
4r CTDO

Figure 262 - Deleting the Stamp

2. Next Consultant Designers will need to save the following stamp to their computer and
edit it to add their company name and address. The following will show how to do that:

3. Save this stamp file to your computer in a folder somewhere called Blubeam Stamps.
Note: The stamp file will be a PDF. Consultant Submittal Review Stamp

4. Open the stamp file using Bluebeam.

5. Update the Company Name and Address as shown below:
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Consultant_Submittal_Review &

W 285%284 Inches a

SUBMITTAL REVIEW

DESIGNER'S REVIEW

Conforms [ regectes [}
Conforms o5 Neted  []  No Action Requires ]

DETAILS _ AND  ACCURACY,
RELATING ALL QUANTIT
NG FABRICATION P

and address

Date:

Figure 263 - Updating Stamp for Company Name and Address
After the company name and address is updated it should look like this:

m 286% 284 Inches

et st ] Click on this and edit so
/ it reads the company name

DESIGNER'S REVIEW 1S FOR GENERAL CONFORMANCE WIT,

SUBMITTAL REVIEW

DESIGNER'S REVIEW

Conforms I:l Rejected I:I
Conforms as Noted I:l No Action Required D

Revise and Resubmit |:|

DESIGNER'S REVIEW IS FOR GENERAL CONFORMANCE WITH
THE DESIGN CONCEPT AND CONTRACT DOCUMENTS,
MARKINGS OR COMMENTS SHALL NOT BE CONSTRUED AS
RELIEVING THE CONTRACTOR FROM COMPLIANCE WITH THE
PROJECT PLANS AND SPECIFICATIONS, NOR DEPARTURES
THEREFROM., THE CONTRACTOR REMAINS RESPONSIBLE FOR
DETAILS  AND ACCURACY, FOR  CONFIRMING  AND
CORRELATING ALL QUANTITIES AND DIMENSIONS, FOR
SELECTING FABRICATION PROCESSES, FOR TECHNIQUES OF
ASSEMBLY AND FOR PERFORMING THEIR WORK IN A SAFE
MANNER.
BL Companies 150 Trumbull St, Hartford, CT 06103

&[User
. BlUser]

B Date:

Figure 264 - Updated Stamp

6. After the stamp is updated click save.
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7. Next go to Markup>Stamp> and Select Change Stamp Folder.

Docurnent Form Markup Measure

E._. 'x‘ . q . . 7 _‘:: t..\‘ . ,/7

Frint E-mail Studio e en ines Image Hyperlink  Attachment _ o
Consulbant_Subrittal_F

1_11 - Environmel e m=i
= 2
T

Click on Markup
ol then Stamp
then change stamp folder

159-0181_11 - E...

ittal_Review_pdf

I
Figure 265 - Changing the Stamp Folder

T =-ENVIRUNMENTAL

8. Browse out to where the submittal review stamp has been saved and click OK:

Browse out to the
folder where the
[a Desktop -
@mwoanns  Stamp is located
o G and click OK
2 Recycle Bin
AdobeCd
1) old watermarks

IC3) POF Farms
IC0) Revisions Forms

1) schoal
1) STC FORMS

H
&

TRETeT
BURAHER

[ IMake Mew Folder ] [ Ok ] [} Cancel ]

|

Figure 266 - Browsing to the Stamp
9. Now when you click on Markup>Stamp it will be in the list.
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10. Next go into the tool chest and open the “Recent tools” as shown below:

Settings

X Bluebeam Studia Projects - I

v *

CTDOT Shop) ing Drawing Review Tools
CTDOT As Builk Tools
Sequence Tools

CTDOT Miscellaneous Stamps
‘ » { I I L I I
4 CTDOT

Figure 267 - Bluebeam Recent Tools

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown
below:

Markup Measure indow Help

-

Shapes Image Hyperlink Attachment |ﬂ
N

consultant_subrmitkal

|“I consultant_subrmitkal_re

Document1* & Markup Stamp
and then select
the stamp

Figure 268 - Placing a Stamp in Bluebeam
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12. Select Conforms when the javascript window pops up and click OK:

Submittal Review x|

JawvaScnph window

— Actian

S:' Ennfurma " Conforms as Moted  © Flevize and Fesubmit © Fejected ¢ Mo Action Fequired

— Reviewer's Information

Date: [10/8/2013

Figure 269 - Bluebeam Stamp

13. After the stamp has been placed you will see the stamp in the recent tools. Drag it from
the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below:

In the tool
chest drag the
recently placed

stamp and drop > croor

it into this tool =R
bar ~ | | Subrmittal )

Highlight

Highlight
Text Bowx IJze to Add text

Callout ze to Add a Callout

|Jze to Cloud

Claud Comections

IJze to Crose Out

4 CTDOT 2
L
Ar CTDOTH

Figure 270 - Adding the Custom Stamp to the Tool Chest

14. Then Save Profile so the stamp will always be in the Tool Chest.
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Q fve  File Edit Yig Dacurnent Matkup Measure

v = o - q

Open Save Frint E-mzil Studio

-

GO tO View, Financial In
Bl OI|E then click on the

~ Hecents

Supplementary Progr a rrow a n d t h e n

G 'ndS i

8 save profile

E E B

E E E

B E

Figure 271 - Saving Bluebeam Profile
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Appendix E - Projectwise Attributes Table

Table 3 - Projectwise Attribute Assignments — Contract Plans and Specs.

Attributes
Document Discipline | Main Sub Label Description Asset Tags
Category | Category

Contract Plans — Upload to the 100_Contract_Plans Folder
Contract CT CON FDP . Name of the subset, 01-General Typeina . Asset Tags shall only
Plans CT CON DCD for the General subset. The useful be assigned to the

CT CON DCD2 label should match what is listed | description contract plan

CT CON FPL on the title sheet. subset(s) that detail

e  FDP and DCD submittals shall an asset in a high
always have the same label. level detail. For

e  CTDOT standard drawing shall example, the subset
be “CTDOT_HIGHWAY_STD” that contains bridge
and “CTDOT_TRAFFIC STD”. plans shall be tagged

e For Information Only subsets, with that asset. If
FIO must be included in the there are multiple
Label, 11_AT&T FIO. bridges detailed in a

B B subset, the subset
CT CON ADP e ADP and ACD submittals shall shall be tagged with
CT CON ACD have the same label as the FDP both bridge nos.
CT CON DCO plans with the addition of A##
on the end. For example, 01- e DO NOT tag the 01-
General_A## General, 02-

e DCO Submittals shall have the Revisions, CTDOT
same label as the FDP plans Highway Standards,
with the addition of C## on the and CTDOT Traffic
end. For example, 01- Standards with Asset
General C## Tags since they do

- not detail the asset in
a high level of detail.
e  Toassign the asset

tag select the
applicable bridge
no(s), sign
structure(s), or signal
intersection(s) that
is/are associated with
the document. Hold
CTRL to select
multiple asset
numbers.

Contract Specifications — Upload to the 240_Contract_Development Folder except for CSP specs, upload these to the

110_Contract_Specifications folder

Contract CT CON FSP FDP Specs. Typeina Do not assign asset tags to

Specificatio | CT CON FSR Revised FDP Specs. useful specifications

ns CT CON ASP Addendum # Specs. description

CT CON ASR Revised Addendum Specs.
CT CON CSP C# Specs.
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Table 4 - Projectwise Attribute Assignments - Supplemental Contract Documents

Attributes
Document Discipline | Main Sub Label Description Asset Tags
Category Category
Supplemental Contract Documents — Upload to the 240_Contract_Development Folder
Proposal Estimate CT CALCS Estimates Proposal
Proposal Estimate CcT MISC Misc Proposal Est. Checklist
Checklist
Federal Estimate CT CALCS Estimates Federal
Calendar Day Estimate | CT CALCS Estimates Calendar Day
Final Design Report CcT REPORT Reports Final Design
Categorical Exclusion CcT MISC Misc Categorical Exclusion
Design Approval Letter | CT APPROVAL Approvals Design Approval
Environmental Permits | CT PERMITS Permits . Inland Wetland
. SHPO
. Flood Management
. Environment Review
. Natural-Water
Resources
. Tribal
. Endangered Species Type a useful N/A
. Fisheries description
DBE/SBE Approval with | CT APPROVAL Approvals DBE/SBE Approval
percentages
Commitment List CT MISC Misc Commitment List
Agreements CcT AGREEMENT | Agreements Name of the Agreement
Proprietary Item CcT APPROVAL Approvals Proprietary Item
Approval
Standalone CcT MISC Misc Trans. Man. Plan
Transportation
Management Plan
Document,
taken from the final
design
report
Item List for CcT MISC Misc CNS Item List
Contractor Submittals
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Table 5 - Projectwise Attribute Assignments — Engineering Reports, GIS Documents, and
ROW Documents

Attributes
Document Discipline | Main Sub Label Document Description Asset Tags
Category Category Date
Engineering Reports — Upload to 130_Engineering Reports Folder
Hydraulic Report CcT REPORT Reports Hydraulic
Hydraulic Report Data CT REPORT Reports Hydraulic Data
Scour Report CT REPORT Reports Scour Assign
Scour Report Data CcT REPORT Reports Scour Data Date of Type a. us.eful Applicable
Report description

Floodway Report CcT REPORT Reports Floodway asset tags
Floodway Report Data CT REPORT Reports Floodway Data
Geotechnical Report CT REPORT Reports Geotechnical
GIS Documents — Upload to the 140_GIS folder
E(rjogjj;:t Polygon File CcT CAD Misc Boundary P.ro!'ect
Project Polygon File cT CAD Misc Boundary _II:I(:]Nl;s(S_)
(.KM2)
ROW Parcel CcT CAD Misc Parcel Serial (Town#) i.e. A useful
Microstation File (.dgn) Parcel 004 (157) N/A description N/A
ROW Parcel CcT CAD Misc Parcel Serial (Town#) i.e. such as
Microstation File (.KMZ) Parcel 004 (157) property

owner’s

name (e.g

CL&P)

ROW Documents —Property Map (.dgn

) to 500_Pre-Design>05_Property_Maps Folder , Property

Map (.pdf) to the 310_Review_Documents

folder
Property Map (.dgn) CcT CAD MAP Parcel Serial (Town#) i.e. A useful
Parcel 004 (157) description
Property Map (.pdf) CcT CAD MAP Parcel Serial (Town#) i.e. such as
Parcel 004 (157) N/A property N/A
owner’s
name (e.g.
CL&P)
Table 6 - Projectwise Attribute Assignments — Contractor Submittals
Attributes
Document Discipline | Main Category Sub Label Document Description Asset Tags
Category Date
Contractor Submittals — 120_Contractor_Submittals
Working Drawings | CT CONTRACTOR Working Item Number Assign
for Permanent Drawings Applicable
Structures asset tags
Working Drawings | CT CONTRACTOR Working Item Number Assign
for Temporary Drawings Applicable
Date of Type a useful
Structures . o asset tags
Shop Drawings CcT CONTRACTOR Shop Item Number Submittal description Assign
Drawings Applicable
asset tags
RFI CT CONTRACTOR RFI RFI # N/A
RFC CT CONTRACTOR RFC RFC # N/A
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